Definiens

Tissue Studio® 4.2

User Guide
Dear User,

Thank you for using Definiens software. We appreciate being of service to you with image intelligence solutions. At Definiens we constantly strive to improve our products. We therefore appreciate all comments and suggestions for improvements concerning our software, training, and documentation. Feel free to contact us via web form on the Definiens support website www.definiens.com/support

Thank you.

Legal Notes

© 2015 Definiens AG. All rights reserved. Definiens®, Definiens Cognition Network Technology®, Tissue Studio®, Image Miner®, TissueExplorer® and Tissue Phenomics® are registered trademarks of Definiens AG. All trademarks are property of their respective owners. The information in this document is subject to change without notice and should not be construed as a commitment by Definiens AG. Definiens AG assumes no responsibility for any errors that may appear in this document.

For research use only. Not for use in diagnostic procedures.

Tissue Studio is protected by one or more of the following US patents: 8319793, 7801361, 7146380, 7437004, 6832002, 6738513, 7117131.

Typeset by Wikipublisher

All rights reserved.
© 2015 Definiens Documentation, München, Germany

Day of print: 05 November 2015
## Contents

1 Overview ................................. 1
  1.1 Key Features and Benefits ......................... 1
  1.2 Image Data Structure ......................... 1
      1.2.1 Digital Image and Image Layer .......... 2
      1.2.2 Tile .................................. 2
      1.2.3 Scene ................................ 2
      1.2.4 Map .................................. 2
      1.2.5 Project ................................ 2
      1.2.6 Workspace ............................. 2
  1.3 Definiens Terminology ......................... 3
      1.3.1 Image Object .......................... 3
      1.3.2 Image Object Level .................... 3
      1.3.3 Image Object Hierarchy ................. 4
      1.3.4 Class ................................ 4
      1.3.5 Feature ............................... 4
  1.4 Image Analysis Templates ...................... 5
      1.4.1 Solution ............................... 5
      1.4.2 Action ................................ 5
  1.5 Backwards Compatibility ....................... 5

2 Workflow and User Interface ................. 7
  2.1 Start Definiens Tissue Studio ................. 7
  2.2 Workflow Window ........................... 8
      2.2.1 Load .................................. 8
      2.2.2 Configure .............................. 8
      2.2.3 Run ................................... 8
      2.2.4 Review ................................ 9
  2.3 Workspace Window ............................ 10
  2.4 Display Toolbar .............................. 10
  2.5 Main Menu .................................. 12
      2.5.1 Requirements ........................... 12
      2.5.2 Save Workspace .......................... 12
      2.5.3 Customized Import ...................... 13
      2.5.4 Image Layer Mixing ..................... 16
      2.5.5 Image Object Information ............... 17
      2.5.6 Image Object Table ..................... 17
      2.5.7 Requirements ........................... 18
      2.5.8 Legend ................................ 19
  2.6 The Results Panel ........................... 19
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1.1 Overview</td>
<td>79</td>
</tr>
<tr>
<td>9.1.2 Introduction</td>
<td>79</td>
</tr>
<tr>
<td>9.1.3 Settings</td>
<td>79</td>
</tr>
<tr>
<td>9.2 Nucleus Detection (BF)</td>
<td>83</td>
</tr>
<tr>
<td>9.2.1 Overview</td>
<td>83</td>
</tr>
<tr>
<td>9.2.2 Introduction</td>
<td>83</td>
</tr>
<tr>
<td>9.2.3 Settings</td>
<td>83</td>
</tr>
<tr>
<td>9.3 Nucleus Detection (IF)</td>
<td>84</td>
</tr>
<tr>
<td>9.3.1 Overview</td>
<td>84</td>
</tr>
<tr>
<td>9.3.2 Introduction</td>
<td>84</td>
</tr>
<tr>
<td>9.3.3 Settings</td>
<td>86</td>
</tr>
<tr>
<td>9.4 Nucleus Morphology and Filter</td>
<td>87</td>
</tr>
<tr>
<td>9.4.1 Overview</td>
<td>87</td>
</tr>
<tr>
<td>9.4.2 Introduction</td>
<td>87</td>
</tr>
<tr>
<td>9.4.3 Settings</td>
<td>88</td>
</tr>
<tr>
<td>9.5 Marker Area Detection (BF)</td>
<td>89</td>
</tr>
<tr>
<td>9.5.1 Overview</td>
<td>89</td>
</tr>
<tr>
<td>9.5.2 Introduction</td>
<td>90</td>
</tr>
<tr>
<td>9.5.3 Settings</td>
<td>90</td>
</tr>
<tr>
<td>9.5.4 Preview</td>
<td>91</td>
</tr>
<tr>
<td>9.6 Marker Area Detection (IF)</td>
<td>91</td>
</tr>
<tr>
<td>9.6.1 Overview</td>
<td>91</td>
</tr>
<tr>
<td>9.6.2 Introduction</td>
<td>91</td>
</tr>
<tr>
<td>9.6.3 Settings</td>
<td>91</td>
</tr>
<tr>
<td>9.7 Vessel Detection</td>
<td>93</td>
</tr>
<tr>
<td>9.7.1 Overview</td>
<td>93</td>
</tr>
<tr>
<td>9.7.2 Introduction</td>
<td>93</td>
</tr>
<tr>
<td>9.7.3 Settings</td>
<td>94</td>
</tr>
<tr>
<td>9.8 Cell Simulation</td>
<td>95</td>
</tr>
<tr>
<td>9.8.1 Overview</td>
<td>95</td>
</tr>
<tr>
<td>9.8.2 Introduction</td>
<td>95</td>
</tr>
<tr>
<td>9.8.3 Settings</td>
<td>96</td>
</tr>
<tr>
<td>9.9 Membranes and Cells (BF)</td>
<td>97</td>
</tr>
<tr>
<td>9.9.1 Overview</td>
<td>97</td>
</tr>
<tr>
<td>9.9.2 Introduction</td>
<td>97</td>
</tr>
<tr>
<td>9.9.3 Settings</td>
<td>98</td>
</tr>
<tr>
<td>9.10 Membranes and Cells (IF)</td>
<td>99</td>
</tr>
<tr>
<td>9.10.1 Overview</td>
<td>99</td>
</tr>
<tr>
<td>9.10.2 Introduction</td>
<td>99</td>
</tr>
<tr>
<td>9.10.3 Settings</td>
<td>99</td>
</tr>
<tr>
<td>9.11 Marker Area Classification (BF)</td>
<td>101</td>
</tr>
<tr>
<td>9.11.1 Overview</td>
<td>101</td>
</tr>
<tr>
<td>9.11.2 Introduction</td>
<td>101</td>
</tr>
<tr>
<td>9.11.3 Settings</td>
<td>101</td>
</tr>
<tr>
<td>9.12 Spot Detection (BF)</td>
<td>103</td>
</tr>
<tr>
<td>9.12.1 Overview</td>
<td>103</td>
</tr>
<tr>
<td>9.12.2 Introduction</td>
<td>103</td>
</tr>
<tr>
<td>9.12.3 Settings</td>
<td>104</td>
</tr>
<tr>
<td>9.13 Spot Detection (IF)</td>
<td>105</td>
</tr>
<tr>
<td>9.13.1 Overview</td>
<td>105</td>
</tr>
<tr>
<td>9.13.2 Introduction</td>
<td>105</td>
</tr>
</tbody>
</table>
CONTENTS

9.13.3 Settings ................................................. 106
9.14 Spot Classification ........................................ 108
  9.14.1 Overview ........................................... 108
  9.14.2 Introduction ......................................... 108
  9.14.3 Settings ........................................... 109
9.15 Nucleus Classification (BF) .................................. 110
  9.15.1 Overview ........................................... 110
  9.15.2 Introduction ......................................... 110
  9.15.3 Settings ........................................... 110
9.16 Nucleus Classification (IF) .................................. 112
  9.16.1 Overview ........................................... 112
  9.16.2 Introduction ......................................... 112
  9.16.3 Settings ........................................... 112
9.17 Membrane Classification (BF) .................................. 115
  9.17.1 Overview ........................................... 115
  9.17.2 Introduction ......................................... 115
  9.17.3 Settings ........................................... 115
9.18 Cell Classification (BF) ...................................... 116
  9.18.1 Overview ........................................... 116
  9.18.2 Introduction ......................................... 117
  9.18.3 Settings ........................................... 118
9.19 Cell Classification (IF) ...................................... 121
  9.19.1 Overview ........................................... 121
  9.19.2 Introduction ......................................... 121
  9.19.3 Settings ........................................... 122
9.20 Vessel Classification ........................................ 126
  9.20.1 Overview ........................................... 126
  9.20.2 Introduction ......................................... 126
  9.20.3 Settings ........................................... 126
10 The Export Actions ............................................ 131
  10.1 Heatmap ................................................ 131
    10.1.1 Overview ........................................... 131
    10.1.2 Introduction ......................................... 131
    10.1.3 Settings ........................................... 131
  10.2 Default Export (BF) ...................................... 133
    10.2.1 Overview ........................................... 133
    10.2.2 Introduction ......................................... 134
    10.2.3 Screenshots Folder ................................... 134
    10.2.4 Statistics Folder ................................... 134
  10.3 Default Export (IF) ...................................... 141
    10.3.1 Overview ........................................... 141
    10.3.2 Introduction ......................................... 141
    10.3.3 Screenshots ........................................ 142
    10.3.4 Statistics ........................................ 142
  10.4 Custom Export (Cellular Analysis) ......................... 147
    10.4.1 Overview ........................................... 147
    10.4.2 Introduction ......................................... 147
  10.5 Custom Export (Regions of Interest) ...................... 148
    10.5.1 Overview ........................................... 148
    10.5.2 Introduction ......................................... 150
1 Overview

Definiens Tissue Studio® supports pathologists in analyzing standard histopathology assays. It enables non-technical users to configure, calibrate and execute image analysis workflows. The software supports all major acquisition devices and users can analyze all kinds of tissue slides, tissue micro arrays and microscope images.

A library of analysis solutions is provided that is calibrated for the particular image data set, using sample-based training and simple graphic sliders. These calibrated applications can be saved and submitted for batch execution.

Definiens Tissue Studio allows the user to quantify brightfield immunohistochemistry and immunofluorescence images on a cell-by-cell basis. The software is for research purposes only.

1.1 Key Features and Benefits

- An easy-to-use graphical representation of the analysis workflow
- Configurable to specific image analysis conditions, with simple graphical controls and sample-based training
- Batch processing of large data sets on a personal workstation or a dedicated server grid
- Tailored view settings for managing data, executing applications and viewing results
- Supports a complete range of histological image analysis applications using fully automated and semi-automated workflows
- Rapid tissue biomarker validation in translational research
- Analysis workflows are easy to use and calibrate, even for users with little or no technical expertise.
- A ROI Classification plugin action enables you to extend Tissue Studio functionality by importing your own customized ruleware

1.2 Image Data Structure

Definiens Tissue Studio provides an internal data structure that enables even inexperienced users to process images rapidly and manage analysis results easily. The principal organizational directory for images is called a workspace.
1.2.1 Digital Image and Image Layer

A digital image is a set of raster image data representing a two-dimensional image. It consists of at least one image channel based on an array of pixels. In Definiens software, a channel is called an image layer.

Each image layer can represent a type of information. The most common image layers are the red, green and blue (RGB) image layers, but there are other image layer types, especially in fluorescence imaging.

1.2.2 Tile

To analyze large tissue or TMA slides, the system automatically divides the scene into subsets called tiles. The analysis is then performed on each tile individually.

1.2.3 Scene

Definiens Tissue Studio loads image data as scenes. A scene refers to at least one image layer of one image file. In addition, it can contain metadata, such as details of image creation or patient information.

1.2.4 Map

Each Definiens map represents a scene, which means that each map displays one image. A map also includes the image object hierarchy of this particular scene; a data structure containing analysis results extracted from the image.

Like a geographical map, it displays a picture that expresses information depicted by visual elements, such as colors and lines. When viewing an analyzed map, you can investigate the input scene and the analysis results.

1.2.5 Project

A project is stored within a workspace as a wrapper for one or more maps, plus their respective image object hierarchies (see image object hierarchy on page 4). It can include several images, each of them providing different information on an individual map.

1.2.6 Workspace

A workspace is a container for projects. By loading multiple images directly to a workspace, you can create a set of projects dedicated to an image analysis task.

In addition, a workspace references exported result values and comprises processing information, such as import and export templates, the solution used and processing states.
1.3 Definiens Terminology

Definiens Tissue Studio allows the analysis of image data based on objects rather than just pixels. When working with this user guide, you will come across the terms listed below.

1.3.1 Image Object

During image analysis, a map is split into image objects. An image object is a group of pixels in a map; in other words, each image object represents a definite space in a scene. Image objects can provide information about this space. As every image object is linked to its neighbors, all image objects form a network that enables the user to access the context of each image object.

1.3.2 Image Object Level

Image objects are organized within image object levels. An image object level serves as an internal working area for the image analysis. During image analysis, multiple image object levels can be created and layered within what we call an image object hierarchy.
NOTE: There is an important difference between image object levels and image layers. Image layers represent the data already existing in the image when it is first imported. In contrast, image object levels store image objects, which serve as the building blocks of the analysis.

1.3.3 Image Object Hierarchy

The image object hierarchy (figure 1.3) serves as a storage rack for all image object levels that represent the different shelves storing the image objects. Therefore, the image object hierarchy provides the working environment for the extraction of image information.

1.3.4 Class

A class is a category of image objects describing their semantic meaning (for example, a certain region of interest).

1.3.5 Feature

In Definiens software, a feature is an attribute of an image object of interest, or a given class; examples include measurements, attached data and values.
Features can be related to a single image object – for example spectral, form or hierarchical features – or to other properties of image objects, such as their relation to neighboring objects. There are also features that are unrelated to individual image objects, for example the total number of objects of a certain class.

1.4 Image Analysis Templates

1.4.1 Solution

Definiens Tissue Studio lets you design a solution as a ready-to-use image analysis template, to address a specific image analysis problem.

A solution provides image analysis algorithms configured for a specific type of image data. A solution is assembled from predefined building blocks called actions.

1.4.2 Action

An action represents a predefined building block of an image analysis solution. Configured actions can perform different tasks such as object detection, classification or exporting results to file. Actions are sequenced and together represent a ready-to-use solution accomplishing the image analysis in a fully or semi-automated way.

Behind a configured action stands a set of algorithms with defined parameters. Actions are grouped within an action library specifically designed for a given purpose. By opening Tissue Studio through one of the provided portals, the respective algorithms are loaded automatically.

1.5 Backwards Compatibility

Definiens Tissue Studio solution files (.dax) contain image analysis algorithms specific to each version of Tissue Studio, and are subject to change with each new release. With
every release we improve existing algorithms and add new features, so that two different release versions of Tissue Studio may give you different results for the same solution. If you load a solution created in a previous version into a new release, you will be asked whether you want to upgrade the solution.

If you need to obtain identical results, you can open your solution with the respective older Action Library of the same version – this will ensure that results are comparable between analyses – we also recommend using the same server package. Select “No Upgrade” in this case. The currently open Action Library is displayed in the Analysis Builder (see figure 1.4).

If you want to reuse an older solution, but benefit from algorithm improvements, you can upgrade the solution to the most recent Action Library – in this case your results may then differ from a run in a previous library. Ensure you recalibrate your solution, since the parameter settings may need adjusting.

Please refer to the Release Notes of your installed Tissue Studio version for information about which older versions are still supported.

![Figure 1.4. Analysis Builder displaying version number](image)

05 November 2015  User Guide
2 Workflow and User Interface

Image analysis with Definiens Tissue Studio® typically consists of the four basic steps illustrated in figure 2.1 on the current page. When working with the application, you should generally adhere to this workflow; however, most solutions can be configured according to your needs.

![Figure 2.1. Workflow for image analysis using Definiens Tissue Studio](image)

2.1 Start Definiens Tissue Studio

You can start Definiens Tissue Studio after installing the software. The following portals are available:

<table>
<thead>
<tr>
<th>Portal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tissue Studio</td>
<td>Recommended for the analysis of whole tissue slides or small IHC images (brightfield)</td>
</tr>
<tr>
<td>Tissue Studio (TMA)</td>
<td>Recommended for the analysis of tissue micro array IHC images (brightfield)</td>
</tr>
<tr>
<td>Tissue Studio IF</td>
<td>Recommended for the analysis of whole tissue slides or small IF images (fluorescence)</td>
</tr>
<tr>
<td>Tissue Studio IF (TMA)</td>
<td>Recommended for the analysis of tissue micro array IF images (fluorescence)</td>
</tr>
<tr>
<td>Tissue Studio Registration</td>
<td>For bulk annotation of tissue blocks</td>
</tr>
</tbody>
</table>
2.2 Workflow Window

The Workflow window in the upper left-hand corner provides four main tabs: Load, Configure, Run and Review. Selecting a tab reveals further options. To analyze your images, you must activate the tabs in this order and use the provided functions described in this section.

2.2.1 Load

The buttons in the Load tab let you manage the images you want to analyze.

Before you can view or process images, you must load them to the workspace. You can load multiple images organized in directories, or add single files to an existing workspace.

![Figure 2.2. The Load tab](image)

2.2.2 Configure

The buttons in the Configure tab allow you to create, load or save an analysis solution.

You can either load a predefined solution or build a new one using the set of actions in the Analysis Builder window. Configure them according to your needs, test the configured actions on a few sample images, view the results and improve your settings iteratively.

![Figure 2.3. The Configure tab](image)

2.2.3 Run

If you want to run the analysis solution on your images, use the functions provided in the Run tab.

You can run the solution across the whole workspace or on selected images. All results will be exported to the respective workspace folders.

---

1. You can move the Workflow window by holding Ctrl while dragging to make room for the Analysis Builder window.
2.2.4 Review

After processing, results can be evaluated in the Review tab.

To review the classification results in greater detail, you can navigate visually through the different levels of the image object hierarchy (if there are more than one). Additionally, you can view several maps of a project at the same time.

Various methods enable you to explore and evaluate image analysis results. Results of an image analysis can be displayed numerically and visually; numerical results are statistics and result values, while visual results are represented by the classification of image objects. Furthermore, you have the option to display results in the Heat Map (p 163) window.

The Open Workspace in Image Miner button lets you open your workspace in Definiens Image Miner (p 40).
2.3 Workspace Window

The Workspace window (figure 2.7) displays all imported data. In the left-hand pane you can browse through the available folders, which are by default called Tissue Slides (containing all imported images) and Training Data, which is the default directory for all training data sets you may create – for more information see Define a Training Data Set (p 23).

The upper right-hand pane shows the projects of a selected folder in the workspace. You can choose between several viewing options such as list view, folder view and thumbnails. In addition, you can select projects to display by applying filters. In the Summary pane at the lower right-hand side, information regarding the project status and export data can be accessed.

2.4 Display Toolbar

If a project is open, you may use different zoom functions in the toolbar on top of the viewing panes. It is possible to view up to four images at a time.

If an image is bigger than the viewing area you can hold down the mouse button and drag it – the mouse pointer will turn into a hand.
<table>
<thead>
<tr>
<th><strong>Select the Windows Layout</strong></th>
<th>Click on this button to access viewing options. This way you can display up to four images or several levels of the same image.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show/Hide Outlines, Show/Hide Classification</strong></td>
<td>These two buttons allow you to change the segmentation and classification views of image objects created by segmentation of the image.</td>
</tr>
<tr>
<td><strong>Selection and Magnification Buttons</strong></td>
<td>Use these buttons to select, zoom into a marquee, zoom in and out, or fit the image to the screen. (You can also zoom in and out using the mouse wheel – the .)</td>
</tr>
<tr>
<td><strong>Image Pixel/Project Pixel View</strong></td>
<td>Use this button to overlay a downsampled view with the original image data. It helps, for instance, to manually select the exact ROI on a map with reduced resolution.</td>
</tr>
<tr>
<td><strong>Magnification</strong></td>
<td>Select a predefined magnification view. (You can also zoom in and out using the mouse wheel.)</td>
</tr>
<tr>
<td><strong>Navigate Maps</strong></td>
<td>The left and right arrow buttons only appear if multiple images are opened simultaneously, for instance as training data. You can switch the map to be displayed.</td>
</tr>
<tr>
<td><strong>Navigate Levels</strong></td>
<td>The up and down arrow buttons only appear if more than one level has been created during the analysis, as done by the Cellular Analysis actions for cell detection. You can switch between the levels to view the different classification results.</td>
</tr>
<tr>
<td><strong>Single/Multiple Layer Mixing</strong></td>
<td>These buttons can be used to change between single and multiple layer display, each layer representing one grayscale channel of the image. The gray button represents the single layer display and the button with the blue triangle stands for a multiple layer visualization.</td>
</tr>
</tbody>
</table>
When in Single Layer Display mode, you can use these buttons to browse through the separated image layers, each of them representing one grayscale channel of the image (see also Image Layer Mixing on page 16). You can do this to define thresholds for IHC images or to examine the available fluorescence layers.

2.5 Main Menu

The main menu of Definiens Tissue Studio contains four drop-down lists:

- Under File you can open, close or save a workspace, use a customized import template and manage your server environment (see Managing the Server Environment (p 181) for more information)
- Under View you can change the view settings and open or close several windows, including
  - Image Layer Mixing on page 16
  - Image Object Information on page 17
  - Image Object Table on page 17
  - Legend on page 19
  - Heat Map (p 163)
  - Scene Information on page 19
- Under Export you can export the current view of the active image pane
- Under Help you can get system or help information, open the User Guide PDF or contact Definiens support.

2.5.1 Requirements

To access all the features in the drop-down menus, at least one image has to be open.

2.5.2 Save Workspace

You can save an existing workspace to another location; this is recommended if the images in the workspace have been manually annotated using the Manual ROI Selection or Manual Preselection actions (manual annotations and workspace ID are linked). In other words, by using the Save Workspace as... command to create a copy of the workspace and copying the Manual Classifications folder from the original workspace into the newly created one, you can make use of the existing annotations in multiple workspaces.
2.5.3 Customized Import

If you want to analyze fluorescence images where the individual layers are saved as separate files, you must load these files into the workspace via a customized import template. The idea is that you first define a master file, which functions as a sample file and allows identification of all available files, then the individual data to be combined as one scene via a search string.

A workspace must be in place before scenes can be imported and the file structure of image data to be imported must follow a consistent pattern. To open the Customized Import dialog box (figure 2.9), select File > Customized Import from the main menu.

Using the Customized Import dialog window

1. Click the Clear button before configuring a new import, to remove any existing settings
2. Choose a name in the Import Name field
3. Browse to the root folder, which is the folder where all the image data you want to import are stored; this folder can also contain data in multiple subfolders. To allow a customized import, the structure of image data storage has to follow a pattern, which you will define later
4. Select a master file within the root folder or its subfolders. Depending on the file structure of your image data, defined by your image reader or camera, the master
file may be a typical image file, a metafile describing the contents of other files, or both
5. Edit the Search String field, which displays a textual representation of the sample file path used as a pattern for the searching routine.
6. Use the Scene Name text box to display a representation of the name of the scene that will be used in the workspace window after import
7. Press the Test button to preview the naming result of the master file based on the search string.
8. After successful implementation of your customized import you can save the template with the Save... button. The template is now available in the list of the predefined import templates such as Hamamatsu or Aperio ScanScope-with resolution when you use the Import Folders button.

**Editing Search Strings and Scene Names**

Editing the search string and the scene name – if the automatically generated ones are unsatisfactory – is often a challenge. Please email support@definiens.com if you have difficulties using this import.

There are two types of fields that you can use in search strings: static and variable. A static field is inserted as plain text and refers to filenames or folder names (or parts of them). Variable fields are always enclosed in curly brackets and may refer to variables such as a layer, folder or scene. Variable fields can also be inserted from the Insert Block drop-down box.

For example, the expression \{scene\}001.tif will search for any scene whose filename ends in 001.tif. The expression \{scene\}_x_{scene}.jpg will find any JPEG file with _x_ in the filename.

You must comply with the following search string editing rules:

---

**Figure 2.9. Customized Import dialog box**

---
• The search string has to start with \{root\}\ (this appears by default)
• All static parts of the search string have to be defined by normal text
• Use a backslash between a folder block and its content
• Use \{block name:n\} to specify the number of characters of a searched item
• All variable parts of the search string can be defined using blocks representing the
  search items, which are sequenced in the search string (table 2.0, Tissue Studio
  search strings).

Table 2.0. Tissue Studio search strings

<table>
<thead>
<tr>
<th>Block</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>:reverse</td>
<td>Starts reading from the end instead of the beginning</td>
<td>{part of a file name:reverse} is recommended for reading file names, because file name endings are usually fixed</td>
</tr>
<tr>
<td>any</td>
<td>Represents any order and number of characters</td>
<td>Used as wildcard character for example, {any}.tif for TIFF files with an arbitrary name</td>
</tr>
<tr>
<td>any-folders</td>
<td>Represents one or multiples of nested folders down the hierarchy under which the image files are stored</td>
<td>{root}{any-folders}{any}.tif for all TIFF files in all folders below the root folder</td>
</tr>
<tr>
<td>root</td>
<td>Represents a root folder under which all image data you want to import is stored</td>
<td>Every search string has to start with {root}\</td>
</tr>
<tr>
<td>scene</td>
<td>Represents the name of a scene that will be used for project naming within the workspace after import</td>
<td>{root}{scene}.tif for .tif files whose file names will be used as scene names</td>
</tr>
<tr>
<td>layer</td>
<td>Represents the name of an image layer</td>
<td>{root}{layer}.tif for .tif files whose file names will be used as layer names</td>
</tr>
</tbody>
</table>

Using the Customized Import for TMA core annotations

The Customized Import can be used to import core annotations for tissue microarrays. Use the tab TMA Annotations for this.

The core annotations must be stored in a comma separated value (csv) file as explained in the section Importing Metadata as Annotations (p 31). To import the annotation files via a customized import, they must be placed inside a folder with the same name as the image file. This folder must be in the same folder as the corresponding image file.
2.5.4 Image Layer Mixing

You can define the color composition and equalization for the visualization of image layers in the Edit Image Layer Mixing dialog, which enables you to better visualize the image content. This is especially helpful when working with fluorescence data. You can also choose to hide layers, which can be very helpful when investigating image data and results.

**NOTE**: Changing the image layer mixing only changes the visual display of the image, not the underlying image data – it has no impact on the image analysis results.

There are different modes for image equalization available. The default value is ‘none’. We recommend using one of the following for fluorescence images with low contrast:

- Linear equalization with 1.00% commonly displays images with a higher contrast than without image equalization
- Manual image layer equalization enables you to control equalization in detail. For each image layer, you can set the equalization method (click on the Parameter button to open the histogram). In addition, you can define the input range by setting minimum and maximum values.

![Image Layer Mixing Dialog](image)

**Figure 2.10.** The Edit Image Layer Mixing (left) and Image Layer Equalization (right) dialog box

Additionally, you can split the image into its layers by doing one of the following:

- Choosing ‘one layer gray’ in the Layer Mixing drop-down menu
- Right-clicking into the image pane and selecting Single Layer Display from the context menu
- Clicking on the button in the horizontal toolbar on page 10.
You can navigate image layers independently using the image layer buttons (see Display Toolbar on page 10). Whenever you use an action of the Cellular Analysis group that relies on any marker color, additional image layers will be created for the IHC stain (Stain 2). You can switch, for example, to the blue layer (Stain 1) and move the cursor over the image to get an idea of a potential threshold for hematoxylin staining.

![Image layers view](image.png)

*Figure 2.11. Swipe View of the classification result based on blue layer*

The name of the layer you are looking at is indicated at the very bottom of the user interface, together with additional information about the image, such as the number of pixels or objects, the zoom factor or the cursor position.

### 2.5.5 Image Object Information

The Image Object Information window (figure 2.12) displays specific information about an image object:

1. To add or remove features, right-click into the Image Object Information window and choose Select Features to Display from the context menu. The Select Displayed Features dialog box opens
2. Select features of interest by double-clicking them
3. Confirm with OK
4. To compare single image objects, click on several image objects in the image pane and the displayed feature values are updated every time.

**Requirements**

Before features of an image object can be displayed in the Image Object Information view, a previously segmented image must have been loaded.

### 2.5.6 Image Object Table

The Image Object Table window allows you to sort the image objects according to feature values. You can compare multiple classified image objects that are listed in the table together with various feature values.

1. To configure the Image Object Table window, do one of the following:
Figure 2.12. Feature values of the selected image object (red outlines)

Figure 2.13. The Configure Image Object Table dialog box with selected classes and features

- Double-click in the text area
- Right-click in the text area and choose Configure Image Object Table from the context menu. The Configure Image Object Table dialog box opens.

2. Click Select Classes to display all available classes
3. Select the classes individually by clicking them in the Available Classes field (additionally, you may include Unclassified Image Object by selecting the check-box) and confirming with OK
4. Press Select Features to display the available features
5. Select the features individually by double-clicking them and confirm with OK
6. Click OK to display all image objects and their feature values as configured in the Image Object Table
7. Select an image object in the image or in the table to highlight the corresponding image object in the table or image, respectively.

### 2.5.7 Requirements

Before features of an image object can be displayed in the Image Object Information view, a previously segmented image must have been loaded.
2.5.8 Legend

The Legend window (figure 2.15) displays all available classes in the currently active image of the currently active level.

![Legend dialog box](image)

Figure 2.15. Legend dialog box

2.6 The Results Panel

To display the Results Panel, go to View > Scene Information in the main menu.

![Results Panel pane](image)

Figure 2.16. The Results Panel pane

The Results Panel displays scene-specific results of the action selected in the analysis builder.
2.7 Context Menus

By right-clicking in the upper-left pane of the workspace window you can:

• Define a Training Data Set (see Define a Training Data Set (p 23))
• Start, cancel or view the history of the analysis
• Save or copy the project list
• Expand all columns of the window
• Reset a project to its initial state, deleting the previous data from the results file.

By right-clicking in the image pane you can:

• Select different cursor modes
• Show or hide the Scale Bar and Pan Window
• Activate Single Layer Display (see Image Layer Mixing on page 16)
• Copy the current view to export it.
3 Loading and Managing Data

This section describes the tools available when the Load tab is selected.

3.1 Supported Image Formats

Images acquired with the following devices are supported:

- Aperio ScanScope – with resolution (xml 2.1)
- Ariol – with resolution
- Bacus WebSlide (xml 2.1)
- Definiens Result Containers
- Generic – one file per scene – with annotation (xml 2.1)
- Hamamatsu (xml 2.1)
- Leica SCN – all regions
- Leica SCN – largest region
- Mirax Scan – cropped – with resolution (xml 2.1)
- Mirax Scan 16-bit (xml 2.1)
- Nikon
- Olympus
- Roche Ventana (bif)
- TissueGnostics (all regions per slide)
- TissueGnostics (individual regions)
- TissueGnostics (separate regions)
- Unic
- Zeiss (ZVI)
- Zeiss (CZI).

Note that import templates marked with ‘(xml 2.1)’ are based on a previous version of the Aperio XML driver. Workspaces created via Aperio Spectrum use this template by default.

1. This option is for viewing only. For details on importing a DRC file for analysis, see Importing Scenes from Result Containers on page 24
2. Leica SCN import includes support for immunofluorescence images
3. The TissueGnostics connector is dependent on a third-party driver. Changing the operating system (for example upgrading from Windows Server 2003 to 2008) may result in very small differences in pixel values (± 1%)
4. The TissueGnostics connector is dependent on a third-party driver. Changing the operating system (for example upgrading from Windows Server 2003 to 2008) may result in very small differences in pixel values (± 1%)
5. The TissueGnostics connector is dependent on a third-party driver. Changing the operating system (for example upgrading from Windows Server 2003 to 2008) may result in very small differences in pixel values (± 1%)
6. Although this format supports 3D, only its 2D functions are supported in Tissue Studio.
In addition, generic formats such as TIFF, JPEG and PNG, as well as JPEG2000, can be loaded into a workspace. Definiens Tissue Studio enables you to analyze 8-bit (per channel) color image data in the brightfield portals. In the fluorescence portals, images with 8, 10, 12, 14 and 16-bit (per channel) can be analyzed.

### 3.1.1 Importing Images with Annotations

Tissue Studio can import the following formats with annotations (for more information on Aperio integration, see Aperio Integration (p 183)).

- Aperio ScanScope – with resolution (.svs, .afi)
- Bacus Webslide – Bacus Webslide (.ini)
- Hamamatsu – Hamamatsu (.ndpi)
- Generic – one file per scene – with annotation (.jpg, .tiff).

Annotations will only be imported correctly via the Import Folders function. To make annotations visible, you must use Manual ROI Selection (Draw Polygons) (p 70) and Preselect Regions for ROI Detection (p 56), then press the Link button.

### 3.2 Load Images (Predefined Import Templates)

![Import Folders](image)

**Figure 3.1. Browse to Data Location**

1. To import single files press the Import File button
2. After you have chosen the file you want to import you have to create the workspace in the Load Image dialog and confirm with Finish (see Workspace Window (p 10))
3. Press the Import Folder button to import whole folders into a workspace
4. Browse to the folder(s) you want to import and press Next
5. Choose the Scanner Type (if your scanner is not in the list, use ‘generic – one file per scene’)
6. Create the workspace and finish the import
7. Repeat the import if you want to load any other images to this workspace and choose Add to Current Workspace.
8. Alternatively, you can click on the Open Workspace button if you want to open an already existing workspace and browse to its location.

In both cases a workspace is created.\(^7\) The workspace contains the imported images and appears in the Workspace window. In addition to the imported files and folders, a folder called Training Data is created in the workspace (see Define a Training Data Set below). Due to the unique folder structure and settings of workspaces created in any Tissue Studio portal, workspaces created with a non-Tissue Studio portal cannot be loaded with Tissue Studio.

### 3.3 Load Images (Customized Import Templates)

If you work with fluorescence data that cannot be loaded via any of the predefined import templates (for instance because every channel is available as one single .tif file), you have to use the *Customized Import* (p 13) dialog.

### 3.4 Define a Training Data Set

If you want to work on more than one image simultaneously, for instance to use the Composer ROI detection actions, you can create a Training Data Set.

![Figure 3.2. Workspace with training data sets inside the Training Data folder](image)

\(^7\) By default the Storage Location path points towards a directory that has been implemented during installation of the software.
1. Press the Training Data button and follow the instructions to define a training data set of up to twelve images. The selected images will be copied as a multi-map project into the Training Data folder. You can name the project as you wish
   • You can also select multiple images in the Workspace and create the training data set via the context menu
2. Open a Training Data Set by double-clicking on it in the upper left pane of the workspace
3. Display up to four images simultaneously by using the respective buttons (see Display Toolbar (p 10)).

3.5 Adding Metadata

It is possible to bulk import large amounts of user-defined metadata in the form of a CSV file. This feature is driver-dependent – for instructions, refer to the Metadata (p 191) chapter

3.6 Importing Scenes from Result Containers

The File > Import Scenes from Result Containers feature lets you import a Definiens format called the Definiens Result Container (DRC).

The primary function of the DRC is as the native format of the Whole Slide Review viewer (p 173) – this portal allows fast viewing of slides and results, without the overhead of the full client.

It also allows you to import processed slides from other workspaces. As well as Tissue Studio workspaces, you can import the results of any analysis created in Definiens Developer or Architect by importing the DRC file, assuming you have access to the same source images. In terms of DRCs created by other Tissue Studio users, it has the advantages of a reduced file size, compared to the original workspace, as only the most important data is used to create the container.

DRC folders are created automatically in Tissue Studio and the relevant folders are located within the workspace folder, under results\Registered_slides.

The behavior of the feature is dependent on the status of the client:

• If no workspace is open, you will be prompted to create one
• If a workspace is open, new projects will be created in the open workspace
• If you access the feature via the context (right-click) menu in the Workspace pane, all projects will be created as children of the selected folder

The Import Scenes from Result Containers (figure 3.3) dialog contains two fields:

1. The root file path for the folder containing the result container
2. The root path of the image folder

Press Import to load the scenes.
3.7 Block Import

Tissue Studio contains a feature that lets you import multiple stains from tissue blocks. See *The Tissue Studio Registration Portal* (p 177) for more details.
4 Working with Tissue Micro Arrays

For the analysis of tissue micro arrays you can use the Definiens Tissue Studio (TMA) or Tissue Studio IF (TMA) application. A tissue micro array may contain an arbitrary number of cores that can be automatically detected and matched to a default or user-defined grid. The results of automatic core detection and matching can be manually edited.

All actions described in this chapter are performed in the TMA Grid View window, which is by default available when you open Definiens Tissue Studio through any of the TMA portals. The following instructions are based on an IHC-stained TMA slide scan, but also apply to any IF-labelled TMA images.

4.1 TMA Grid View

The actions described in this section are performed in the TMA Grid View, which opens by default when you select any TMA portal at startup.

4.1.1 Defining the Grid Layout

A default grid layout is supplied. It is automatically displayed when you start the application and can be used to match all available slides. However, depending on the analysis you wish to perform, it might be necessary to edit an existing layout or to create a new one.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Assigns a positive control core</td>
</tr>
<tr>
<td>-</td>
<td>Assigns a negative control core</td>
</tr>
<tr>
<td></td>
<td>Assigns an empty cell</td>
</tr>
<tr>
<td></td>
<td>Removes an assignment</td>
</tr>
</tbody>
</table>

Table 4.1. Core Type Buttons
1. Open a workspace containing the slides of the tissue micro array you want to analyze. In the TMA Grid View, select the Layout tab.
2. To edit an existing layout, select the layout name from the drop-down list under Grid Layout Templates and then click Edit. To create a new layout, click New.
3. Under Grid Parameters, define the following settings:
   - Enter a name for the new or amended grid layout in the Name field
   - If necessary, change the number and order of the grid’s rows and columns
   - To set the new or amended layout as the default layout, check the Default checkbox
4. Under Core Type, define arrays as positive or negative control cores, or mark cells that you want to leave empty (see figure 4.1, Core Type Buttons).
5. To save a layout within a workspace, select Confirm. To revert your changes, click Revert.
6. To save your layout to a file, select Save to File... under Save/Load Layout. Layout files can be imported into other workspaces using the Load from File... button. Following confirmation, newly defined grid layouts are available in the workspace and can be assigned to one or more slides before you proceed with core detection and matching.1 Existing assignments of amended grid layouts to slides remain unchanged, although it may be necessary to repeat the matching of the cores to the grid.
7. If a layout is no longer needed, you can delete it at any time using the Delete button under Grid Layout Templates.

---

1 Existing assignments of amended grid layouts to slides remain unchanged, although it may be necessary to repeat the matching of the cores to the grid.
4.1.2 Matching Cores to the Grid

The cores of a slide can be automatically and manually matched to a grid:

1. Open a workspace containing the slides of the tissue micro array you want to analyze. In the TMA Grid View (figure 4.2), select the Matching tab.
2. Select the slide whose cores you want to match. You can switch between all available slides using Slide Navigation or selecting a slide from the workspace list.
3. If necessary, select another than the default grid layout from the drop-down list and click Assign to assign the selected layout to the current slide.
4. Under Core Detection, define a minimum size for the detected cores – this is the minimum percentage of a complete core that is taken into account for core detection.
5. Using the Brightness slider can improve core detection when cores are relatively faint – for brightfield images, the higher the setting, the more cores will be detected.
6. Click Detect Cores. The application determines all the cores that match your core detection settings and inserts them into the assigned grid. A subset is created for each core. You can display the individual subsets by double-clicking them in the slide. To switch back to the display of the complete slide, select Show Slide.
7. Check whether all relevant cores have been detected. You can manually add or delete cores or change their automatically determined regions of interest on the Editing tab (for more information, see Editing Cores on page 32).
8. Check whether all cores have been correctly inserted into the grid. The application automatically assigns each core to the cell containing its center. An additional row marked with ? is created for all cores that couldn’t be matched (for example, 1. You can change the size of the thumbnail display in the grid by selecting an entry from the Size drop-down list in the TMA Grid View.
2. To check the possible matching results for grids other than the assigned, select the relevant layout from the drop-down list under Grid Layout. A preview is displayed in the TMA Grid View. You can change its size and color range. If you want to display a grid layout without matching results, select Layout in the Show drop-down list. You can return to the display of the assigned grid by clicking the Revert button.
because the centers of two different cores can be found in the same cell). You can correct the results by doing one of the following:

• You can move the cores within the grid. When you select one of the cells in the TMA Grid View, the corresponding core is automatically selected in the map view. If the core has not been inserted at the correct place, you can drag it into the correct position.

• Adjust the grid on the slide by manually changing its size, position or layout.

9. If you have made any changes to the grid or to the cores, select Match Cores. The TMA Grid View is updated with the new grid and core information.

10. To save the matching to a file, select Save Matching under Save and Load Matching. A saved matching can be imported for other slides using the Load Matching button.

11. The Delete Unmatched function deletes all cores that are not matched (signified by a ?). In addition, when creating cores, those that would fall into cells with the label empty are directly moved to a ? row.

### 4.1.3 Changing the Grid After Matching

To improve the results of automatic core detection and matching, you can adjust the grid so that the individual cores can be better assigned to the cells in the grid:

1. Activate the manual adaptation mode by clicking the Matching button. This will open a Help dialog that comprises a short description of the required shortcuts. (You can discard the Help dialog by marking the Do Not Show Again checkbox. Press F1 while you are in the matching mode to retrieve the dialog.)

2. To display the grid in the map view, click Reset. The initial grid comprises all cores that have been determined automatically or manually.

3. To change the grid manually, do one of the following:

   • To rescale or rotate the complete grid, hold down the Ctrl key while double-clicking the intersection of two grid lines. The node is used as a fixed point for rescaling and rotation and is marked with a red rectangle. You can only set one fixed point per grid. Hold down the Ctrl key while clicking a different (unfixed) node and move the mouse to rescale and rotate the grid as you wish.

   • To adjust the position of the complete grid, hold down the Ctrl key while moving the grid into the appropriate position. It is only possible to move the complete grid if no fixed point is set.

   • To adjust the size of a single grid-square, double-click on the core within the square. The square is adapted so that it fits the size of the complete core.

   • To adjust the frame of a single grid-square, click a node of the relevant square and move it into the appropriate position. The node is marked with a green rectangle and kept in a fixed position.

   • To adjust the frames of all grid squares in an intersecting row and column, click a node of the relevant square. Hold down the Shift key while moving it into the appropriate position. The node is marked with a green rectangle and kept in a fixed position.

   • To adjust the frames of all squares within the grid, click a node of any square. Hold down the Ctrl and Shift keys while moving it into the appropriate position. The node is marked with a green rectangle and kept in a fixed position.

---

3. Frame adjustments of multiple cells do not affect fixed points and vertices that have been moved or selected for adjustment (marked with a red or green rectangle). You can remove a fixed point by holding down the Ctrl key while double-clicking the red rectangle. To unfix the position of a vertex, double-click the green rectangle.

---

05 November 2015 User Guide
4. To automatically optimize the layout of the grid, click Optimize. The application works along the columns to adjust the grid to the position of the cores on the current slide. We therefore recommend that you optimize by manually adjusting the grid for the top and bottom rows of cores.

5. To confirm your changes and update the TMA Grid View with the new grid settings, click Confirm Changes. To discard your changes, click Discard Changes.
   - Clicking the Discard button resets the grid to its last confirmed state. You can therefore use this function to reset single or multiple steps, if you confirm frequently in the course of your edits. If you want to display the initial state of the grid, click Reset.

6. Deactivate the manual adaptation mode by clicking the Matching button.

### 4.1.4 Importing Metadata as Annotations

The Annotations pane allows you to add data from a comma-separated values file. By using a .csv file template you can add information to each core that will be displayed below it.

1. Create one or more .csv files containing the data for annotation:
   - Make sure that the .csv layout matches the grid layout of your images
   - Empty rows have to be labeled as they are otherwise ignored by the program
2. Select the Matching tab
3. Under Annotations, click the Load button and browse to the .csv location (you can load several annotations consecutively)
4. To edit the displayed data, click the Edit button and change the settings in the Edit Annotations dialog box
5. To delete annotations, click the Delete button and mark the appropriate checkbox in the Delete Metadata dialog box.

TMA core annotations can also be imported during the slide import. A Customized Import has to be created (see Customized Import (p 13)).
4.1.5 Editing Cores

Editing the cores on a slide allows you to manually correct the results of automatic core detection or manually determine the cores you want to include in the matching process. You can add or delete cores as well as adjust their frames and define their regions of interest (ROIs).

Table 4.2. Core Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add New Cores/ROI" /></td>
<td>Add New Cores/ROI</td>
</tr>
<tr>
<td><img src="image" alt="Resize/Move" /></td>
<td>Resize/Move</td>
</tr>
<tr>
<td><img src="image" alt="Select Cores/ROIs" /></td>
<td>Select Cores/ROIs</td>
</tr>
<tr>
<td><img src="image" alt="Delete Selected Cores/ROIs" /></td>
<td>Delete Selected Cores/ROIs</td>
</tr>
</tbody>
</table>

1. Select the Editing tab (the buttons displayed are shown in Table 4.2, Core Buttons)
2. To edit the number of cores on the slide or to adjust their frames, proceed as follows:
   - Click the Cores button
   - If necessary, activate core addition and deletion mode by clicking the Add New Cores/ROI button
   - To define new cores, mark the cores in the map view by drawing a rectangle (frame) around them
     Each frame represents a subset comprising a core with one or more ROIs. The results of later analyses will be displayed per core

4. Defining and adjusting ROIs is only possible if the complete slide is open in the map view. If necessary, use the zoom buttons to look at one of the cores more closely.
To adjust the size or position of a frame, click Resize/Move. In the map view, move or resize the frame accordingly.

To delete a core, click the Select Cores/ROI button and mark the relevant cores in the Map view. Then click the Delete Selected Cores/ROI button.

To accept your changes, click Confirm. To reverse your changes, click Rollback.

3. To automatically define ROIs in all newly determined cores, select Detect Tissue in all empty cores. You can manually adapt the ROIs after this process is finished.

4. To manually define or change a core’s ROI (marked in green), proceed as follows:

   • Click the ROI button. This will automatically open a Help dialog that addresses all available drawing functions in brief. If the help dialog has been deactivated, it will be reactivated automatically if the function is not used for two weeks. The help dialog can be reactivated manually by removing the following lines from the file UserSettings.cfg:

   ```
   <HTMLHelp>
   <key unsigned="1265033271" name="algo_C:\Program Files\DefiniensVERSION\bin\applications\TissueStudioPORTAL\ActionLibrary\draw_polygon.html"></key>
   </HTMLHelp>
   • If necessary, activate ROI addition and deletion mode by clicking the Add New Cores/ROI button.
   • To define a new ROI, draw a polygon around the appropriate area using your mouse. It is possible to define several ROIs within a core. If, however, you define an ROI within another ROI, the application excludes the former from the analysis.
   • To remove the last node, press the Delete key. Alternatively, right-click to open the context menu and select Delete Last Point.
   • To close the polygon with the shortest distance between the first and the last point, right-click and choose Close Polygon.
   • To discard the current drawing, right-click and select Cancel.
   • To change an existing ROI, click the Resize/Move button and adjust the shape of the polygon by dragging and dropping single nodes.
   • To delete a selected node, right-click on the red circle and choose Delete Node.
   • To delete a respective node and open the polygon again, right-click on the red circle and select Delete Node and Unclose Polygon.
   • To add a node, move the cursor over any line of the polygon until a blue cross appears and click onto the line.
   • To delete manual polygons or ROIs, press Select Cores/ROIs and mark the appropriate polygon or ROI in the map view. Then click Delete Selected Cores/ROIs to remove it.
   • To accept your changes, click Confirm. To reverse your changes, click Rollback.

5. After confirmation of the changed cores click Detect tissue in all empty cores to get the ROI within all cores that have no polygon/ROI yet.

6. Select the Matching tab.

7. Under Core Detection, click Match Cores. The application updates the TMA Grid View with the new core and ROI information.

---

5. The file UserSettings.cfg is located in the application data folder of the user, e.g. for Windows XP in C:\Documents and Settings\[USER]\Application Data\Definiens\[VERSION]\UserSettings.cfg.
4.2 Applying a Solution

After the core detection you can proceed with the solution assembly as described in the following chapters.
5 Selecting and Loading an Analysis Solution

Depending on whether you work with Tissue Studio® or Tissue Studio (TMA), you can load and define different solutions to analyze small images, slides or tissue micro arrays. Each solution consists of several actions that you can select and configure in the Analysis Builder.

![Diagram](image)

**Figure 5.1.** Overview of available actions in Definiens Tissue Studio (to reduce complexity, classification actions are not displayed)

### 5.1 Load a Predefined Solution

1. Change to the Configure Workflow tab
2. To view all available solutions, click on the Load Solution button
3. Choose a predefined solution based on the image analysis task.
5.1.1 Definiens Tissue Studio

The available solutions are sorted according to how the ROI detection has been performed. In every solution all required actions for a particular analysis task are assembled in the correct way. You can adjust the thresholds and settings based on your images and run the analysis after saving the configured solution (see Save Solution (p 43)).

Figure 5.2. Predefined solutions of Definiens Tissue Studio

5.1.2 Definiens Tissue Studio (TMA)

After detecting of the TMA cores using the TMA Grid View window, you can analyze them using predefined solutions. In every solution all required actions for a particular analysis task are assembled in the correct way. You can adjust the thresholds and settings based on your TMA slides and run the analysis after saving the configured solution (see Working with Tissue Micro Arrays (p 27)).
5.1.3 Definiens Tissue Studio IF

The available solutions are sorted according to how the ROI detection has been performed. In every solution, all required actions for a particular analysis task are assembled in the correct way. You can adjust the thresholds and settings based on your images and run the analysis after saving the configured solution (see Save Solution (p 43)).

5.1.4 Definiens Tissue Studio IF (TMA)

After detection of the TMA cores using the TMA Grid View window you can analyze them using predefined solutions. In every solution all required actions for a particular analysis task are assembled in the correct way. You can adjust the thresholds and settings based on your TMA slides and run the analysis after saving the configured solution (see Working with Tissue Micro Arrays (p 27)).

5.2 The Analysis Builder Window

The selected solution includes all actions necessary for the analysis you want to perform. You can easily configure the different actions by selecting them in the upper sequencing pane and defining the necessary settings in the lower properties pane of the Analysis Builder window. The Description area displays help text for the individual settings. You can also adapt the predefined solution by adding new or deleting existing actions in the sequencing pane.
In many actions, visibility of certain user interface elements is dependent on the image type to be analyzed, the specific marker in use, and other configuration parameters.

You may assemble your analysis from scratch instead of loading a predefined solution.

### 5.3 New Solution

If you want to assemble your own solution from scratch do one of the following:

- Click on the New Solution button
- Click on the Load Solution button and choose New Solution from the solutions tree.

Only actions will be loaded that are mandatory for almost every solution (General Settings, Tissue-Background Separation (not in TMA portal), Initialize Cellular Analysis and Default Export). From there you can start adding the actions you need for the respective analysis.
Figure 5.5. Predefined solutions of Definiens Tissue Studio IF (TMA)

Figure 5.6. Analysis Builder window with a sample solution
5.4 Opening a Workspace in Definiens Image Miner

To open an analyzed workspace in Image Miner™, Definiens’ data mining application, go to File > Open Workspace in Image Miner in the main menu.

If Image Miner is not installed on your system, this option will be grayed out.
6 Configuring a Solution

You can configure each action of the solution you selected before analyzing your images. The configuration for each action is explained in detail in this chapter and applies to all kinds of images (IHC and IF, whole tissue and TMA, slide scan and small image) unless stated otherwise.

6.1 Overview

The assembly of the single actions is different for each predefined solution, but each solution has to include the General Settings, at least one of the ROI Detection actions (not for TMA) and, if any cellular analysis is performed, the Initialize Cellular Analysis action. It should also contain at least one Export action.

6.1.1 General Settings Action

The General Settings action is a fixed action and sets the workflow parameters for the analysis. It is automatically loaded and necessary for any analysis.

6.1.2 ROI Detection Actions

These actions allow you to classify tissue regions of interest. Unless you are working in the TMA portals, it is mandatory to use Tissue-Background Separation or one of the Manual ROI Selection actions.

Not all ROI detection actions are available in every portal. The available actions are:

- Tissue-Background Separation (p 51)
- Preselect Regions for ROI Detection (p 56)
- Composer: Initialization (p 59)
- Composer: Training (p 60)
- Composer: Cut at Bottleneck (p 63)
- Composer: Create Region (p 64)
- Composer: Reclassification (p 65)
- Manual ROI Selection (Select Segments) (p 67)
- Manual ROI Selection (Draw Polygons) (p 70)
- ROI Correction (p 72)
6.1.3 Cellular Analysis Actions

Typically, some regions of interest will be analyzed further at a higher magnification. Any cellular analysis will start with the Initialize Cellular Analysis action, which allows you to choose up to 12 subsets on which you can configure the available cellular analysis actions:

- Initialize Cellular Analysis (p 79) – mandatory for any subsequent action
- Nucleus Detection (p 83)
- Nucleus Morphology and Filter (p 87)
- Marker Area Detection (p 89)
- Vessel Detection (p 93)
- Cell Simulation (p 95)
- Membranes and Cells (p 97)
- Spot Detection (p 103)
- Spot Classification (p 108)
- Marker Area Classification (p 101)
- Nucleus Classification (p 110)
- Membrane Classification (p 115)
- Cell Classification (p 116)
- Vessel Classification (p 126)

6.1.4 Export Actions

The export actions summarize given statistical values from the individual tiles and subsets to the complete scene. The possibility to export slide statistics is independent of stitching. Two export actions are available:

- Default Export (p 133)
- Custom Export (Cellular Analysis) (p 147)
- Custom Export (Regions of Interest) (p 148)

6.2 Append and Delete Actions

Once a solution is loaded, you can delete, add and move actions in the Analysis Builder window:

- To delete an action press the - button of the respective action
- To add an action press the + button of the respective action group
- To move an action up and down within the solution, press the arrows on the right side of each action.

When clicking the + button, the Add Actions dialog opens, displaying the available actions in this group. In the Filter drop-down menu you can select the action group you want to display. Choose All to get an overview of all available actions in Definiens Tissue Studio.
6.3 Cancel Preview

Whenever you click a preview button while configuring an action, a Cancel button appears at the bottom of the user interface during processing. You can abort any preview processes by clicking this button and selecting Cancel Processing. Aborting processes may lead to an ill-defined state and you must start the solution configuration from scratch by deleting and loading actions and solutions again. You can restart the application, save a process or continue with the analysis using the respective buttons in the Cancel Processing dialog.

6.4 Save Solution

Before you start to process your images you can save your configured solution as a .dax file. A directory is created during the installation of Definiens Tissue Studio, where we recommend you store your solutions and workspaces.

Press the Save Solution button and browse to the designated file location. We strongly recommend using the default path: C:\ Documents and Settings\All Users\Application Data\Definiens\Tissue Studio\Data\Solutions.

This particular folder is linked to the Load Solutions dialog. All solutions that are stored in this particular directory will appear at the end of the solutions tree of the Load Solution dialog.

---

1. dax files created in older versions of Tissue Studio may not be compatible with newer versions. For more details, see Backwards Compatibility (p 5)
2. Application Data is a hidden folder. If you want to access it via Windows Explorer you must allow hidden folders to be displayed (Tools > Folder Options > View)
3. In Windows 7, the path reads C:\ProgramData\Definiens\TissueStudio\Data\Solutions
Figure 6.2. Correctly stored solutions appear in the Load Solution dialog box
7 The General Settings Action

Because the settings of this action depend on the image type, this chapter is separated into brightfield (BF) and immuno-fluorescence (IF) sections.

7.1 BF images

7.1.1 Overview

- Key functions: Set general workflow parameters and analysis options
- Supported portals: Tissue Studio, Tissue Studio (TMA)
- Image data: All

7.1.2 Introduction

The General Settings action (figure 7.1) enables you to set general parameters referring to your original image data and your experimental setup. Configuring the image and stain information is described in Settings below.

If metadata is available, the magnification and resolution can be read automatically from the files. To display the action fields, select the action in the Analysis Builder window.

7.1.3 Settings

Image Information

The magnification and pixel resolution (µm/pixel) refer to the original scene. If metadata are available, they will be automatically read from the files and cannot be edited manually, unless you uncheck the Use Metadata from File checkbox. If there is no metadata (or you choose not to enable it), numbers need to be entered manually. Please refer to your hardware vendor manual for typical resolution (µm/pixel) values. Please note that your unit calculations and segmentation results will be affected by incorrect settings.

Staining Information

You can choose between the following stain combinations:

- IHC Brown Chromogen (e.g. DAB)
• IHC Red Chromogen (e.g. AEC or Fast Red)
• HE
• IHC Dual Brown-Red Chromogens (hematoxylin and two specific IHC markers)
• Counterstain and Spot Stains (ISH)
• Other Stains (Composer only)
• IHC Single Stain (flexible chromogen)
• IHC Dual Stain (flexible chromogen)

The selection affects not only the analysis, but also what actions can be used.

• All actions except Spot Detection and Spot Classification are available if IHC Brown or Red Chromogen, or IHC Single or Dual Stain are selected
• For Dual Brown-Red staining, subsequent detailed analysis is restricted to the Detect Marker Area action
• For H&E staining, you can perform Nucleus Detection and Classification actions as well as the Nucleus Morphology and Filter action
• If Counterstain and Spot Stains (ISH) is selected, you can perform the Nucleus Detection, Nucleus Morphology and Filter, Cell Simulation, Spot Detection and Spot Classification actions.

The Other Stains setting can be used for ROI detection but does not allow for any cellular analysis.

If you have selected IHC Brown Chromogen or IHC Red Chromogen you also need to indicate what cell compartment is stained by the specific marker in your assay (nuclear, membrane or cytoplasm). Your selection will influence the outcome of the detailed analysis. For example a nuclear IHC marker allows a nucleus classification in blue and brown, but cytoplasmic and membrane markers will yield unstained (blue) nuclei only – this will affect the classification result.
If you have selected Counterstain and Spot Stains (ISH), you need to define the chromogen of one or two spot stains, with a choice of Flexible Chromogen, Red Chromogen, Brown Chromogen or Silver Chromogen.

Processing

If you want to save cellular analysis results in your project, activate the Save for Post-Processing checkbox. Doing so will generate the following maps:

- **Main map**
- **ROIDetection** and **ROIClassification map** (if classifications are present)
- **cellularAnalysis map** – the resolution of this map is based on the value in the Initialize Cellular Analysis action and only contains the region where cellular analysis was performed.

IHC Single and Dual Stain Features

The IHC Single Stain and IHC Dual Stain options let you separate one or two arbitrary stains. Stains can be assigned to nucleus, cytoplasm or membrane. (figure 7.2) shows the functions for the IHC Double Stain – the single version is essentially the same, without the IHC Marker B options.

Staining Information

Choose from Cytoplasm, Membrane or Nucleus, for IHC Single Stain.

For the IHC Dual Stain and IHC Dual Brown/Red stain combinations, an additional Vessel field is available. If you select Vessel as one of your markers, the other marker must be Cytoplasm (additionally, in the case of IHC Dual Stain, Vessel must be Marker B).

Flexible Stain Subset Selection

- Press the button Select and then click in the image to select (up to twelve) subsets. If you want to delete subsets, click on button Deselect and then click on the image subsets you want to delete
- You can switch between a view of the individual subsets (click on View Subsets) or the complete images (click on View Selection).

Stain Sample Selection

Take samples on all available images by activating a classification button (such as Counterstain) and clicking on the respective objects.

If you want to remove individual false samples, click the Erase button and click on the respective objects to delete the classification. Press Erase All to remove all samples

---

1. To select only one chromogen, select None in the Spot B drop-down list
Learn  After sample selection is completed, press the Learn button. The software will now decide upon the best discriminators between the classes. All image objects are then classified accordingly.

NOTE: Starting from very few initial samples and going through several rounds of training, rather than trying to obtain a perfect classification result in one go, has been proven to be the most efficient way of using the Stain Sample Selection functions. Do not get irritated if the result after the first training is far away from the final classification; rather refine your sampling step-by-step during several rounds of learning. Select also samples that are near the cut-off between your ROIs.

View Options  Press the appropriate View button to preview markers and counterstain.
7.2 IF images

7.2.1 Overview

- Key functions: Set general workflow parameters and analysis options
- Supported portals: Tissue Studio IF, Tissue Studio IF (TMA)
- Image data: All

7.2.2 Introduction

The General Settings action (figure 7.3) enables you to set general parameters referring to your original image data and your experimental setup. Configuring image and stain information is described in Settings below.

If metadata is available, the magnification, resolution and bit depth are automatically taken from the files. To display the action fields, select the action in the Analysis Builder window.

![Image Information](image.png)

**Figure 7.3. The General Settings action for a large image with metadata**

7.2.3 Settings

**Image Information**

The magnification, pixel resolution (µm/pixel) and bit depth refer to the original scene. If metadata is available, it will be automatically read in from the files and cannot be edited manually, unless you uncheck the Use Metadata from File checkbox. If no metadata is available (or if you choose not to use it), numbers need to be entered manually. Please
refer to your hardware vendor manual for typical resolution (µm/pixel) values. Please note that your unit calculations and segmentation results will be affected by incorrect settings.

Channel Naming

Click on the Edit Names button to open the Edit Layer Names dialog. By default each grayscale channel gets the name ‘layer’ plus a number which you can change to any arbitrary name (for example, DAPI, CK14, somatostatin or marker XY).

Processing

If you want to save cellular analysis results in your project, activate the Save for Post-Processing checkbox. Doing so will generate the following maps:

- Main map
- ROI Detection and ROI Classification map (if classifications are present)
- Cellular Analysis map – the resolution of this map is based on the value in the Initialize Cellular Analysis action and only contains the region where cellular analysis was performed.
8 The ROI Detection Actions

Because the settings of this action depend on the image type, this chapter is separated into brightfield (BF) and immuno-fluorescence (IF) sections. If neither is specified, assume the description is valid for both BF and IF images.

8.1 Tissue-Background Separation (BF)

8.1.1 Overview

• Key functions: Detect tissue or multiple tissue areas and discriminate from background
• Portals: Tissue Studio
• Prerequisite actions: General Settings
• Image data: Tissue slides, small images
• Supported stains: All
• Use case: All standard tissue images (no TMA), unless you are using a manual selection action.

8.1.2 Introduction

The Tissue-Background Separation function (figure 8.1) separates tissue from the surrounding background. As discussed previously, it is necessary for any workflow or image data source, except when TMA slides or manual selection actions are used.

In general, it is advantageous to either adjust settings on a customized training data set (multiple scene project) or consecutively on a series of representative images.

Display the action fields by selecting the action in the Analysis Builder window.

8.1.3 Settings

Use Auto Thresholds

When the checkbox is active, the system performs the initial ROI detection based on default thresholds. The auto thresholds will be calculated for each image individually during batch analysis and can therefore differ from image to image. Deactivate the checkbox to activate two additional sliders, which will let you to define thresholds manually.
When the tickbox is inactive, manual thresholds for homogeneity and brightness are used for all images submitted to analysis.

**Homogeneity Threshold**

The Homogeneity parameter segments the image into homogeneous and non-homogeneous objects and classifies them as Background and All Tissue, respectively. The threshold should be set in a way that the result gives a clear separation between the two classes and that all parts of the image that are definitely Background are already labeled as such. Parts inside the tissue area that are incorrectly classified as Background are not problematic as long as they are separated from the definite Background objects surrounding the tissue (the same holds true the other way round for small All Tissue objects that clearly belong to the Background class).

**Brightness Threshold**

Brightness is calculated based on the average of all available layers. You can display the layer values by opening the Image Layer Mixing dialog and selecting all colors for all layers. Adjust the value until all areas are classified correctly as All Tissue. (Be too permissive rather than too stringent, as all parts classified as Background will typically also become Background in the final classification.)

Set this threshold to 255 to disable the class Background and classify the entire image as All Tissue (for instance for small images).

Press the Preview (Brightness) button to classify pixels that are darker than the Brightness Threshold value as All Tissue and all pixels that are brighter than the Brightness Threshold value as Background.

**Tissue Min Size**

Define the minimum object size for areas classified as All Tissue. Note that objects with an area smaller than this threshold will be classified as Background and will not
be analyzed further. For small images we recommend setting the value to 0. For large images the performance can improve a lot if smaller areas are excluded from the analysis with this parameter.

**Preview**

The Preview button combines all three thresholds to create the final classification result. Put simply, this is achieved by first segmenting the image according to the Homogeneity Threshold value, then by reclassifying the resulting objects that are inconsistent with the Brightness Threshold value.

**Multiple Tissue Sections**

Tick the checkbox if there is more than one tissue section on the slide you want to analyze. If you leave the box unchecked – even if there are several sections on the slide – only the largest one will be considered for analysis. This parameter is only available for images that exceed 5 Mpx.

Please note, that by pressing the *Image Pixel/Project Pixel View button* (p 10) in the toolbar above the image, you will be able to see the image appear in its original resolution, although the downscaled copy of the image is available for processing.

**8.2 Tissue-Background Separation (IF)**

**8.2.1 Overview**

- Key functions: Detect tissue or multiple tissue areas and discriminate from background
- Portals: Tissue Studio IF
- Prerequisite actions: General Settings
- Image data: Tissue slides, small images
- Supported stains: All
- Use case: All standard tissue images (no TMA), unless you are using a manual selection action

**8.2.2 Introduction**

The Tissue-Background Separation function separates tissue from the surrounding background. It is necessary for any workflow or image data source, with the exceptions of TMA slides or when manual selection actions are used.

In general, it is advantageous to adjust settings on a customized Training Data Set (multiple scene project) or consecutively on a series of representative images.

Display the action fields by selecting the action in the Analysis Builder window.
8.2.3 Settings

Layer Selection

You can choose the layers that are used for Tissue-Background Separation. We advise you to use all available layers, but you may want to exclude layers if they contain a noisy background signal or artifacts.

Use Auto Thresholds

When the checkbox is active, the system performs the initial ROI detection based on default thresholds. The auto thresholds will be calculated for each image individually during batch analysis and can therefore differ from image to image. Deactivate the checkbox to activate two additional sliders, which will let you to define thresholds manually. When the tickbox is inactive, manual thresholds for homogeneity and brightness are used for all images submitted to analysis.

Homogeneity Threshold

The Homogeneity parameter segments the image into homogeneous and non-homogeneous objects and classifies them as Background and All Tissue, respectively. The threshold should be set in a way that the result gives a clear separation between the two classes and that all parts of the image that are definitely Background are already labeled as such. Parts inside the tissue area that are incorrectly classified as Background are not problematic as long as they are separated from the definite Background objects surrounding the tissue (the same holds true the other way round for small All Tissue objects that clearly belong to the Background class).


**Brightness Threshold**

Brightness is calculated based on the average of all available layers. You can display the layer values by opening the Image Layer Mixing dialog (figure 8.3) and selecting all colors for all layers. Adjust the value until all areas are classified correctly as All Tissue. (Be too permissive rather than too stringent, as all parts that are here classified as Background will typically also become Background in the final classification.)

Set this threshold to 0 to disable the class Background and classify the entire image as All Tissue (for instance for small images).

![Image Layer Mixing Dialog](image)

**Figure 8.3. Settings in the Image Layer Mixing dialog to display brightness layer**

Press the Preview (Brightness) button to classify pixels that are brighter than the Brightness Threshold as All Tissue and all pixels that are darker than the Brightness Threshold as Background.

**Tissue Min Size**

Define the minimum object size for areas classified as All Tissue. Note that objects with an area smaller than this threshold will be classified as Background and will not be analyzed further. For small images we recommend setting the value to 0. For large images the performance can improve a lot if smaller areas are excluded from the analysis via this parameter.

**Preview**

The Preview button combines all three thresholds to create the final classification result. In simplified terms, this is achieved by first segmenting the image according to the Homogeneity Threshold value, then by reclassifying the resulting objects that are inconsistent with the Brightness Threshold value.
Multiple Tissue Sections

Tick the checkbox if there is more than one tissue section on the slide you want to analyze. If you leave the box unchecked – even if there are several sections on the slide – only the largest one will be considered for analysis. This parameter is only available for images that exceed 5 Mpx.

Please note, that by pressing the Image Pixel/Project Pixel View button (p 10) in the toolbar above the image, you will be able to see the image appear in its original resolution, although the downscaled copy of the image is available for processing.

8.3 Preselect Regions for ROI Detection

8.3.1 Overview

- Key functions: A manual selection step to allow differentiation of regions (an alternative option to Tissue-Background Separation)
- Portals: Tissue Studio, Tissue Studio IF
- Prerequisite actions: General Settings
- Image data: Tissue slides, small images
- Supported stains: All
- Use case: Annotation of non-ROI regions inside ROI areas

8.3.2 Introduction

The Preselect Regions for ROI Detection action can be used as an alternative action to the Tissue-Background Separation function prior to the Composer actions, if image complexity necessitates manual annotation. It allows you to separate ROI Area objects from No ROI objects in any possible combination. The main function is to define No ROI objects inside ROI Area objects.

Display the action fields by selecting the action in the Analysis Builder window.

8.3.3 Settings

Workspace Navigation

Browse quickly through the images in the workspace – without switching to the Load tab or opening the Workspace window – by clicking the Previous Image or the Next Image button. Go back to the top of the image list with the First Image button.

Drawing Tools

You can define whether magnetic snap should be used when drawing a polygon.

- When the checkbox is active, the drawing line will automatically snap to edges inside the image with a high contrast

05 November 2015 User Guide
• The higher the Magnetic Range value (in pixels), the less accurately you need to draw, as the snapping works over a greater distance.

**Link to Third-Party Annotations**

• If import of third-party annotations is possible (see *Aperio Integration* (p 183)), a link button will appear. Clicking on it will allow you to link external annotation layers to Definiens ROI classes
• If you would like to modify those third-party annotations within Tissue Studio, select the Modify 3rd Party Annotations checkbox.

**Draw Polygons for Classes**

You can draw polygons that will be classified either as ROI Area or No ROI by clicking on the respective buttons. To edit the class name or color, click the Edit Class button to open the Edit Classes dialog box (figure 8.7).

• Make sure you are in the Add New Polygons mode
• Click any of the ROI buttons to activate them. This will open a Help dialog that comprises a short description of the available shortcuts\(^1\)

---

\(^1\) You can discard the Help dialog by marking the Do Not Show Again checkbox. If the help dialog has been deactivated, it will be reactivated automatically if the function is not used for two weeks. To manually reactivate the help dialog, edit the file UserSettings.cfg using the instructions outlined in *Editing Cores* (p 32).
• While drawing:
  – To draw an object with one of the available classes, click on the appropriate button and then mark the area inside the image
  – To remove the last node, press the Delete key on your keyboard. Alternatively, right-click to open the context menu and select Delete Last Point
  – To discard the current drawing, press the Esc key. Alternatively, right-click and select Cancel
  – To close the polygon with the shortest distance between the first and last point, right-click and choose Close Polygon.
• Finished polygons:
  – To change the selected area, click one of the polygon nodes and drag it to another position. (To cancel this process, press the Esc key while dragging a node.)
  – To discard the whole polygon, move the cursor over the lines of a polygon until a blue cross appears and press the Delete key. Alternatively, click on a node (the circle turns red), right-click to open the context menu and select Delete Polygon
  – To delete a selected node, press the Delete key. Alternatively, right-click on the red circle and choose Delete Node
  – To add a node, move the cursor over any line of the polygon until a blue cross appears and click onto the line
  – To delete a respective node and open the polygon again, right-click on the red circle and select Delete Node and Unclose Polygon.
• After confirmation:
  – To delete any of the confirmed polygons, select it and press the Delete key. Alternatively, right-click inside the polygon area and choose Delete from the context menu
  – To change the selected area, click one of the polygon nodes and drag it to another position. (To cancel this process, press the Esc key while dragging a node.)
  – To add a node, move the cursor over any line of the polygon until a blue cross appears and click onto the line
• Change classification:
  – To change the classification of certain polygons select the Reclassify Polygon mode
  – Activate the respective class button
  – Click into a polygon for reclassification.

Confirmation

• Press the Confirm button to save all available polygons
• If you would like to start the manual selection again, press the Reject button. This will delete all unconfirmed polygons
• If you want to delete any of the confirmed polygons, right-click anywhere inside the selected area and choose Delete from the context menu.

05 November 2015  User Guide
8.4 Composer: Initialization

8.4.1 Overview

- Key functions: Selecting the magnification for the Composer and selecting up to twelve subsets for configuring the subsequent Composer actions
- Portals: All
- Prerequisite actions: General Settings, and (in non-TMA portals) one of Tissue-Background Separation and Manual ROI Preselection
- Image data: All
- Supported stains: All
- Use case: Choose magnification for Composer and select subsets that represent overall image variability

8.4.2 Introduction

The Composer: Initialization action allows you to choose a magnification for Composer analysis. If the images are large at this magnification, you must further choose up to twelve subsets on which the Composer will then be configured. Display the action fields by selecting the action in the Analysis Builder window.

![Composer: Initialization action](image)

**Figure 8.5. The Composer: Initialization action**

8.4.3 Settings

Settings for Composer

Select the scale on which the Composer analysis should be done. Analysis on smaller magnifications will be much faster and we recommend choosing the smallest magnification on which the differences between the ROIs can be detected.
Subset Selection

- Depending on the chosen magnification, you may or may not be required to select subsets
  - If images are small enough to configure Composer on the complete image, press button Preview
  - If the images are too large, press button Select and then click in the image to select (up to twelve) subsets. If you want to delete subsets, click on button Deselect and then click on the image subsets you want to delete.

View Subsets or Selection

- You can switch between a view of the individual subsets (click on View Subsets) or the complete images (click on View Selection).

8.5 Composer: Training

8.5.1 Overview

- Key functions: Enter user-defined samples to allow training-based discrimination of up to eight different ROIs
- Portals: All
- Prerequisite actions: General Settings and Composer: Initialization (the latter must be preceded in non-TMA portals by Tissue-Background Separation or Manual ROI Preselection
- Image data: All
- Supported stains: All
- Use case: Distinguish several ROIs that are consistent throughout a batch of images

8.5.2 Introduction

The Composer: Training action allows you to create ROIs based on several images automatically. You can work on up to twelve images at the same time. Display the action fields by selecting the action in the Analysis Builder window.

8.5.3 Settings

Change segmentation for all images

- Images are already presegmented after Composer: Initialization; therefore changing the segmentation is an optional step during configuration, whenever another scale would seem more convenient for sample selection
- To resegment all unclassified objects select a scale and press the Resegment button. If you are not satisfied with the result, change the scale and re-run the segmentation.
NOTE: It is not necessary that all ROIs that you want to separate are segmented. In fact, the chosen scale will have no effect on the Composer result. The only purpose of the segmentation is to facilitate selection of appropriate samples.

Sample Selection Mode

You can choose between several modes

- Classify Object(s) allows you to classify objects (with the class selected below) by clicking on them
- Draw Polygons allows you to draw polygons into the image and classify them with the class selected below
- Resegment object allows you to resegment an individual object at a finer scale by clicking on it.

**Sample Selection**

- You can use up to eight classes for training
- You can edit the name and color of classes by clicking the Edit Classes button. Just type in a Class Name and change the Class Color according to your needs.

![Edit Classes dialog box](image)

**Figure 8.7. The Edit Classes dialog box**

- Take samples on all available images by activating a ROI button and clicking on the respective objects (Classify Objects mode) or drawing a polygon region (draw polygon mode)
- In case you want to remove individual false samples, click the Erase button and click on the respective objects to delete the classification
- If after any training step, you would like to revert to the samples of (up to five) previous steps, click Undo Step
- Use the Undo All button to delete all training results and samples in the project.

**Training**

- In the IF portals, you can choose the layers that will be taken into consideration by the Composer’s machine-learning algorithm

**Learn** After sample selection is completed, press the Learn button. The software will now decide upon the best discriminators between the classes. All image objects are then classified accordingly.
NOTE: Starting from very few initial samples and going through several rounds of training, rather than trying to obtain a perfect classification result in one go, has been proven to be the most efficient way of using the Composer functions. Do not get irritated if the result after the first training is far away from the final classification; rather refine your sampling step-by-step during several rounds of learning. Select also samples that are near the cut-off between your ROIs, for example the brightest samples of dark tissue and the darkest samples of bright whitespace.

Apply If you load an preconfigured solution on a new image, you can apply the previously configured training to the new image by clicking Apply.

Slide Preview Press Slide Preview to apply the training to the complete images. Note that this is an optional step that can take a very long time, depending on the size of the images.

Samples/Classification Click on Samples or Classification to switch between a view of the selected samples or the result of the current training.

View Results
- Use the Configuration and Slide buttons to switch between views of the subsets and the complete image.

8.6 Composer: Cut at Bottleneck

8.6.1 Overview
- Key functions: Cut ROIs at small bridges to treat them as separate objects for Composer: Reclassification
- Portals: All
- Prerequisite actions: General Settings, Composer: Initialization and Composer: Training; for non-TMA portals also Tissue-Background Separation or Manual ROI Preselection
- Image data: All
- Supported stains: All
- Use case: Cut ROI objects that are embedded within another class and connected to the surrounding area through a small bridge, to make the embedded part accessible as a single object for Composer: Reclassification.

8.6.2 Introduction

If you want to separate objects that are connected via an indentation, use the Cut at Bottleneck action.
Display the action fields by selecting the action in the Analysis Builder window.

![Figure 8.8. The Composer: Cut at Bottleneck action on small images](image)

### 8.6.3 Settings

#### Cut Settings

- Select a ROI class, set the Width (µm) to cut accordingly and press Cut to separate objects that are connected through a small bridge
- Press Slide Preview to apply this action to the complete slide. Note that this is only possible if Slide Preview has been executed on all previous Composer actions.

#### Undo

- Use the Undo button to revert the last Cut at Bottleneck preview

#### View Results

- Use the Configuration and Slide buttons to switch between views of the subsets and the complete image.

### 8.7 Composer: Create Region

#### 8.7.1 Overview

- Key functions: Connect objects of a given ROI class by filling gaps, or by growing the objects into the surrounding ROI
- Portals: All
- Prerequisite actions: General Settings, Composer: Initialization and Composer: Training; for non-TMA portals also Tissue-Background Separation or Manual ROI Preselection
- Image data: All
- Supported stains: All
- Use case: Allow multiple separated ROI objects to grow until they touch each other, to use as one larger ROI object for further analysis.
8.7.2 Introduction

If you would like to connect individual objects of a given class, you can do so with the Create Region action.

Display the action fields by selecting the action in the Analysis Builder window.

![Create Region Action](image)

Figure 8.9. The Composer: Create Region action on small images

8.7.3 Settings

Create Region Settings

- Select a ROI Class and choose the Distance (µm) value over which to grow
- Select Simple Region Grow if you want objects to grow into surrounding area, rather than to simply fill small gaps between neighboring objects.
- Press Preview to execute the action
- Press Slide Preview to apply this action to the complete slide. Note that this is only possible if Slide Preview has been executed on all previous Composer actions.

Undo

- Use the Undo button to revert the last create region preview

View Results

- Use the Configuration and Slide buttons to switch between views of the subsets and the complete image.

8.8 Composer: Reclassify Region

8.8.1 Overview

- Key functions: Reclassify objects of one ROI class to another ROI class, based on up to three conditions
- Portals: All
- Prerequisite actions: General Settings, Composer: Initialization and Composer: Training; for non-TMA portals also Tissue-Background Separation or Manual ROI Preselection
- Image data: All
• Supported stains: All
• Use case: Merge different ROIs into one, or subclassify a ROI into two different ROIs based on a specific condition.

8.8.2 Introduction

If you would like to reclassify some or all objects of a given class, you can do so with the Composer: Reclassify Region action. Display the action fields by selecting the action in the Analysis Builder window.

![Figure 8.10. The Composer: Reclassify Region action on a large image.](image)

8.8.3 Settings

Reclassify Settings

• Select a source ROI Class and target ROI Class for your reclassification
  – As a source class you can also choose All Composer Classes. This makes sense only when you specify a condition, as otherwise all objects will be reclassified. However, class-related features can not be used for conditions when using source class All Composer Classes
  – As a target class you can also choose Best Neighbor, meaning that candidate objects of the source class will be merged with the object that has the greatest relative border to this object, irrespective of its class.
Condition

- Select the Use Condition checkbox to enable a conditional reclassification.
- Select feature, operator and threshold for each group (use the Image Object Information (p 17) window for help)
- If you use more than one feature, only objects that meet all the conditions will be reclassified (AND operator)
- If you want to merge an object only if it is relatively small compared to neighboring target objects you can use the Area Ratio to ROI features. This feature is calculated as the area of the current object divided by the sum of the area of the current object and all neighboring objects of the specified class.

NOTE: Tissue Studio rounds the values displayed in the Image Object Information pane up or down, to two decimal places however, the underlying values remain unchanged. This could lead to anomalies, for example, if a value in a condition is specified up to two decimal places. However, it is inadvisable to apply this kind of precision to biological systems and we recommend you build in some margin on either side of a condition.

Preview Composer Reclassify

- Press Preview to execute the action
- Use the Undo button to revert the last reclassification
- Press Slide Preview to apply this action to the complete slide. Note that this is only possible if Slide Preview has been executed on all previous Composer actions.

View Results

- Use the Configuration and Slide buttons to switch between views of the subsets and the complete image.

NOTE: The Reclassify Region function is limited to ten actions. If you try to add more than ten, a warning dialog will appear and you will have to manually remove the additional actions.

8.9 Manual ROI Selection (Select Segments)

8.9.1 Overview

- Key functions: A manual selection step to allow differentiation of tissue into multiple ROIs that may be submitted to further analysis separately
- Portals: Tissue Studio, Tissue Studio IF
- Prerequisite actions: General Settings
- Image data: Tissue slides, small images
- Supported stains: All
• Use case: Image with several ROIs that are not too small or scattered, but spectrally very similar

8.9.2 Introduction

The Manual ROI Selection (Select Segments) action lets you manually select and classify up to eight different ROI classes based on an initial segmentation step. You can choose to edit the class names and colors. You will be able to determine which classes would be further submitted to a detailed cellular analysis.

Display the action fields by selecting the action in the Analysis Builder window.

![Figure 8.11. The Manual ROI Selection action (Select Segments)](image)

8.9.3 Settings

Workspace Navigation

Browse quickly through the images in the workspace without using the Load tab or opening the Workspace window by clicking the Previous Image or Next Image buttons. Go back to the top of the image list with the First Image button.
Segmentation

Set the Segmentation Scale to obtain image objects, which are created by clicking on the Segmentation button. If you are looking for a smaller ROI than the resulting segments, simply decrease this value; if you are looking for larger ROIs, increase this value. Click Segmentation until the result is satisfactory. In some images, your tissue may be wrongly classified as Background and not segmented. In this case, you can use the Reseg. Object button to segment the region.

- With the Reseg. Object button, you can apply a finer segmentation to an individual object. Choose a smaller segmentation scale than the one you used in the previous segmentation step. After clicking the button, select the object in the image you want to resegment further.
- In some cases, you may want to cut the objects created using the Segmentation button. Use the Cut Manually button by drawing a polygon directly onto the image. The context menu (right-click) also provides options to cancel or perform a split.
- When activating the Merge Classes button you automatically merge neighboring objects of the same class.

Classification

You can classify objects with up to eight different ROI classes by clicking on the respective buttons. To edit the class name or color of any of the available classes, click the Edit Class button to open the Edit Classes dialog box (figure 8.7).

- First define a brush size to select samples (the higher the size, the more objects can be selected in one go, but the less accurate your selection will be).
- To classify an object with the active class, for example ROI 1, first click on the ROI 1 button and then select an object in the image by clicking it in your image preview.
- To delete single classifications click the Erase button and click into the object you want to declassify.
- Select a class and press Classify Remains to classify all remaining unclassified objects in the image in one go.

Confirmation

- Press the button Confirm to save the current classification.
- If you would like to start the manual classification again, press the Reject button. This will delete all unconfirmed classifications.
- If you want to start from scratch press the Segmentation button again (see Segmentation above).
- Press the button Load to apply an existing manual annotation to the image.

Resolution

The background detection will be performed on an automatically downscaled copy of the original image. In rare cases you may wish to increase the resolution of the copied map if you need classify certain small structures of interest. By choosing a lower resolution you can increase the performance of your solution in case you have large ROI structures.
This parameter is only available for images that exceed 5 Mpx. We strongly recommend using the default resolution, as increased values can result in greatly increased processing times and may also cause memory issues.

Please note, that by pressing the Image Pixel/Project Pixel View button (p 10) in the toolbar above the image, you will be able to see the image appear in its original resolution, although the downscaled copy of the image is available for processing.

8.10 Manual ROI Selection (Draw Polygons)

8.10.1 Overview

- Key functions: A manual selection step to allow differentiation of tissue into multiple ROIs that may be submitted to further analysis separately
- Portals: Tissue Studio, Tissue Studio IF
- Prerequisite actions: General Settings
- Image data: Tissue slides, small images
- Supported stains: All
- Use case: Identification of regions on a whole slide scan that are spectrally similar to each other or to other non-ROI areas.

8.10.2 Introduction

The Manual ROI Selection (Draw Polygons) action allows freehand drawing of ROIs. It is independent of any spectral information and can therefore be used on any images in a very flexible way.

Display the action fields by selecting the action in the Analysis Builder window.

8.10.3 Settings

Workspace Navigation

Browse quickly through the images in the workspace without using the Load tab or opening the Workspace window by clicking the Previous Image or the Next Image button. Go back to the top of the image list with the First Image button.

Drawing Tools

You can define whether magnetic snap should be used when drawing a polygon.

- When the checkbox is active, the drawing line will automatically snap to edges inside the image with a high contrast
- The higher the Magnetic Range value (in pixels), the less accurately you need to draw, as the snapping works over a greater distance.
Link to Third-Party Annotations

- If import of third-party annotations is possible (see Aperio Integration (p 183)), a link button will appear. Clicking on it will allow you to link external annotation layers to Definiens ROI classes
- If you would like to modify those third party annotations within Tissue Studio, select the Modify 3rd Party Annotations checkbox.

Draw Polygons for Classes

You can draw polygons that will be classified with up to eight different ROI classes by clicking on the respective button. To edit the class name or color of any of the available classes, click the Edit Class button to open the Edit Classes dialog box (see Sample Selection on page 62).

- Make sure you are in the Add New Polygons mode
- Click any of the ROI buttons to activate them. This will open a Help dialog that comprises a short description of the available shortcuts
- While drawing:
  - To draw an object with one of the available classes, click on the appropriate button and then mark the area inside the image
  - To remove the last node, press the Del key. Alternatively, right-click to open the context menu and select Delete Last Point
  - To discard the current drawing, press the Esc key. Alternatively, right-click and select Cancel

---

2. You can discard the Help dialog by marking the ‘do not show again’ checkbox. If the help dialog has been deactivated, it will be reactivated automatically if the function is not used for two weeks. To manually reactivate the help dialog, edit the file UserSettings.cfg using the instructions outlined in Editing Cores (p 32).
To close the Polygon with the shortest distance between the first and last point, right-click and choose Close Polygon.

- Finished polygons:
  - To change the selected area, click one of the polygon nodes and drag it to another position. (To cancel this process, press the Esc key while dragging a node.)
  - To discard the whole polygon, move the cursor over the lines of a polygon until a blue cross appears and press the Del key. Alternatively, click on a node (the circle turns red), right-click to open the context menu and select Delete Polygon
  - To delete a selected node, press the Del key. Alternatively, right-click on the red circle and choose Delete Node
  - To add a node, move the cursor over any line of the polygon until a blue cross appears and click on the line
  - To delete a respective node and open the polygon again, right-click on the red circle and select Delete Node and Unclose Polygon.

- After confirmation:
  - To delete any of the confirmed polygons, select it and press the Del key. Alternatively, right-click inside the polygon area and choose Delete from the context menu
  - To change the selected area, click one of the polygon nodes and drag it to another position. (To cancel this process, press the Esc key while dragging a node.)
  - To add a node, move the cursor over any line of the polygon until a blue cross appears and click onto the line

- Change classification:
  - To change the classification of certain polygons select the Re-Classify Polygon mode
  - Activate the respective class button
  - Click into a polygon for reclassification.

**Confirmation**

- Press the button Confirm to save all available polygons
- If you would like to start the manual selection again, press the Reject button. This will delete all unconfirmed polygons
- If you want to delete any of the confirmed polygons, right-click inside the polygon area and choose Delete from the context menu
- Press the Reject button to undo unconfirmed deletions.

### 8.11 ROI Correction

#### 8.11.1 Overview

- Key functions: Allows to manually modify results of fully automated analysis.
- Portals: All
- Prerequisite actions: General Settings, Tissue-Background Separation and/or Composer
- Image data: All
The ROI Detection Actions

- Supported stains: All
- Use case: Perform a quality control of Composer results and modify results by drawing in the image or reclassifying individual objects

8.11.2 Introduction

The ROI Correction action lets you manually modify results of the Tissue-Background Separation or the Composer. Modifications can be done before or after preprocessing. Display the action fields by selecting the action in the Analysis Builder window.

![Figure 8.13. The ROI Correction action](image)

8.11.3 Settings

**Processing Mode**

**Modifications to Unprocessed Images** In workflows that generate different ROIs, you may use the ROI Correction action to draw specific ROIs onto the unprocessed image. This may be useful if some of your images contain artifacts you want to mark manually, or if there are a few ROIs that you know will be handled inaccurately by the automated analysis. By defining ROIs within a region of All Tissue, you in effect define a mask that will then be laid over the automatic classification.

In this workflow, you should deactivate the Interrupt on Server checkbox and the Store ROI classification checkbox. (The ‘mask’ you have drawn does not consume much disk space and will be stored for later use.)

User Guide 05 November 2015
**Modifications on Preprocessed images** You can also use this action to modify results of preprocessed images. Preprocessing may contain either only the Tissue-Background Separation or a complete Composer analysis. Preprocessing is possible directly in the client, for example by configuring the Composer and executing Slide Preview on all Composer actions, or, if this is too time consuming, by running the analysis (after Composer configuration) on the server with the Interrupt on Server setting activated.

**NOTE:** When you run a solution with Interrupt on Server activated there will be an auto-rollback of your projects, and your projects will have status ‘failed’. This does not reflect an error, but means you do not need to reset the workspace before repeating the analysis. Note that the export of your ROI analysis is deactivated when the Interrupt on Server setting is on.

There are two advantages to this workflow:

- You can see the result of the automatic classification in front of you when doing your modifications
- Once you click Confirm the overall result is saved (the combination of automatic classification by the Composer and your modifications). This allows you to use differently configured Composers on different images within the same workspace (see the Reset button below).

There is one disadvantage to this workflow, in that storing the overall classification may, when large slides are analyzed at high magnification, require a lot of disk space. To avoid this, you can deactivate the Store ROI Classification results, but you must be aware that then the same solution will behave differently on subsequent runs: the ROI classification will then reflect the currently configured Composer, and any manual corrections you may have entered will be lost.

**Workspace Navigation**

- After you have analyzed your images with Interrupt on Server activated, you can browse through the result images and perform any desired correction. Note that for TMA slides, the correction must be executed on the individual cores, not the complete TMA slide.
- Workspace navigation buttons allow you to browse through slides and cores without a need to switch to the Load tab or opening the Workspace window.

**NOTE:** If you do not want to click through the preprocessed images one by one but would like to get a quick overview over the results of your automatic analysis, you can check the folder QCScreenshot in your workspace directory.
The ROI Detection Actions

Correction

- Choose between Polygon Selection (which allows you to reclassify by drawing a polygon) or Object Selection (which allows you to reclassify an object by clicking on it)
- You can reclassify objects by selecting the appropriate ROI class and drawing or clicking in the image.

Confirmation

- Press the Confirm button to save the current classification. Note that if an image is never opened during the Correction step, an implicit confirmation is assumed
- If you are not satisfied with your manual modifications, press the Reject button. This will delete all unconfirmed classifications
- If you feel the classifications are too far off to allow a quick manual modification, you may click Reset to delete the current classification. In that case, you can try to reconfigure the Composer on this image with new samples. Note that the newly configured Composer will only take effect on those images where the Reset button was executed. Your previously confirmed images will stay as they were.

8.12 Import ROI (BF)

8.12.1 Overview

- Key functions: Enable ROI detection actions in the Tissue Studio Registration portal (p 177) to be imported into Tissue Studio, when the Import Scenes from Result Container (p 24) feature is used
- Portals: Tissue Studio
- Prerequisite actions: General Settings
- Image data: Tissue slides, small images
- Supported stains: All
- Use case: Import of annotations from DRCs created in Tissue Studio Registration portal

8.12.2 Introduction

The Tissue Studio Registration portal (p 177) lets you apply ROI detection to entire tissue blocks with multiple stains; it also automatically registers the slides.

The Import Scenes from Result Container (p 24) feature, in the File menu, lets you import individual stains in the block. However, for your regions of interest to be visible, you must include the Import ROI step in your analysis.

It cannot be used in combination with any other ROI Detection actions – Tissue-Background Separation, ROI Detection Plugin, Preselect Regions for ROI Detection, Manual ROI Selection (all others), Composer actions, ROI Correction, Manual ROI Selection (Draw Polygons).

In practice, the Import ROI tools are a subset of those in Manual ROI Selection (Draw Polygons) on page 70, where the workflow is described in more detail.
Display the action fields by selecting the action in the Analysis Builder window.

![Image](image.png)  
**Figure 8.14. The Import ROI action**

### 8.12.3 Settings

**Workspace Navigation**

Browse quickly through the images in the workspace – without switching to the Load tab or opening the Workspace window – by clicking the Previous Image or the Next Image button. Go back to the top of the image list with the First Image button.

**Correction**

**Object Selection**  To reclassify an ROI, select Object Selection in the drop-down box, select an ROI class in the pane and click on the region of interest in the Image Viewer.

**Polygon Selection**  Select Polygon Selection in the drop-down box to draw new polygons. The drawing tools are the same as those outlined in *Manual ROI Selection (Draw Polygons)* on page 70.
Confirmation

- Press the Confirm button to save all available polygons
- If you would like to start the manual selection again, press the Reject button. This will delete all unconfirmed polygons
- To rerun ROI detection, press the Reset button.
9 The Cellular Analysis Actions

Because the settings of this action depend on the image type, this chapter is separated into brightfield (BF) and immunofluorescence (IF) sections.

9.1 Initialize Cellular Analysis

9.1.1 Overview

- Key functions: Select ROI class for further analysis, define settings for systematic random sampling, set magnification and select subsets for configuration of subsequent Cellular Analysis actions
- Portals: All
- Prerequisite actions: General Settings, any ROI detection and TMA core detection
- Supported stains: Brown Chromogen, Red Chromogen, Dual Brown-Red Chromogens, H&E, Counterstain and Spot Stains (IHC), immunofluorescence
- All solutions must include the Initialize Cellular Analysis action before any cellular analysis actions can be applied

9.1.2 Introduction

This action allows you to choose a magnification for cellular analysis, and – if complete images are too large to configure on the whole image – to select up to twelve subsets on which cellular analysis will be configured. Please note that for the TMA portals, configuration is done on the TMA slide (from which subsets are drawn) and not on the individual cores.

If you do not want to analyze the complete image data, but only get a quick overview, you can activate and define settings for a random sampling process.

Display the action fields by selecting the action in the Analysis Builder window.

9.1.3 Settings

ROI Selection for Cellular Analysis

These selection rows are only available if you have generated multiple ROIs in the previous ROI Detection action, using the Manual ROI Selection action (not available for
Tissue Studio® 4.2

Figure 9.1. The Initialize Cellular Analysis action: parameters available for small images after composer workflow (left) and large images processed with Tissue-Background Separation only and activated random sampling (right)

TMA) or the Composer: Training action. You need to select all classes which you would like to be analyzed by the subsequent actions.

Magnification for Cellular Analysis

You may choose between six magnification options for the further analysis. The detection of stains and nuclei may be performed at a smaller magnification value (5x, 6.6x, 10x), whereas membrane detection will often yield better results at higher values (20x, 40x, 60x). For Vessel Detection the lowest magnification (5x) will normally suffice.

Reducing the magnification value (i.e. downsampling the image) will have an effect on the accuracy of the results but also on the analysis performance (‘the smaller, the faster, the less accurate’). Note that it is not possible to select a magnification higher than the native magnification – doing so will generate a warning message.

Subset Selection

Depending on the chosen analysis magnification you can either work on the complete image or you have to select upsubsets to configure your cellular analysis.

- If the image is small enough, you can click on the Create button to choose the entire image for the downstream configuration
- If the image is too large, as is typical for tissue slides and TMA slides:
  - Press the Select button and click into the region of the image you want to use for configuration of the downstream analysis. The system will create a square subset around the selected pixel according to the chosen resolution. You can only select a subset from the area of your selected ROIs. If you work on
multiple images (training data set) you can select subsets from all available images, which may increase the robustness of your solution.

- Press the Deselect button and click on any subset you want to remove.

![Subset selection on whole tissue slide scan image](image)

**Figure 9.2. Subset selection on whole tissue slide scan image**

**View Selection**

If you work on large images you can use the View Subsets and View Selection buttons to switch between a multi-map view of the selected subsets (figure 9.3) or a view that shows the location of the subsets on the complete images (figure 9.2).

**Random Sampling**

Systematic random sampling is available in the TMA portal and for large images in the Tissue portal.

**Activate** If you activate random sampling, Tissue Studio will not analyze the complete ROIs, but only sample subsets. Those subsets are selected in a pseudo-random manner to achieve an even distribution across the complete ROI.

**Sampling Ratio** Define the percentage of each ROI that should be analyzed.

**Sample Size** Define the sample size. Optimal speed is achieved if you choose a medium range for your samples.
Figure 9.3. Display of four subsets for the calibration of the Cellular Analysis actions selected on a whole tissue slide scan

**Min Samples per ROI** Define the minimum number of samples that should be selected per ROI, to ensure a sufficient data base for each ROI. Note that in the TMA portals, the minimum number is enforced for each core separately.

**Preview** Press to get an overview over the number, size and distribution of your samples. Note that samples will not be equivalent for different ROIs.

Figure 9.4. Example of sample selection with a sampling ratio of 20% and a sample size of 1000µm.
9.2 Nucleus Detection (BF)

9.2.1 Overview

- Key functions: Detection of nuclei and classification based on IHC-specific markers
- Portals: Tissue Studio, Tissue Studio (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis
- Supported stains: Brown chromogen, red chromogen

9.2.2 Introduction

The Nucleus Detection action detects and classifies hematoxylin and IHC-stained nuclei. Configuration of this action will be performed on the subsets created with the Initialize Cellular Analysis action.

If the IHC Marker parameter in the General Settings action is set to Nuclear, the Nucleus Detection action will detect IHC-positive and negative nuclei. If Cytoplasm, Membrane or H&E Stain are selected, the action will automatically detect only hematoxylin-stained nuclei.

Display the action fields by selecting the action in the Analysis Builder window.

![Image of Nucleus Detection action settings](image)

Figure 9.5. The Nucleus Detection action with IHC Marker in General Settings action set to Nuclear or Membrane (left) and Cytoplasm (right)

9.2.3 Settings

Stain Thresholds

The stain values are based on the conversion of the RGB space to the HSD model. In the RGB model, standardized recognition is only possible by using complex and time-
consuming algorithms. Therefore, the HSD model is superior for transmitted light microscopy images.\(^1\)

- You may modify the thresholds for hematoxylin and the specific marker stain (brown or red) and exclude regions with values below the thresholds from further analysis
- By clicking the Preview Thresholds button, you will be able to see the intermediate stain classification according to your settings
- In case of doubt, set the threshold rather too low than too high; the software will try to compensate to some degree (although it may negatively affect the result)
- If you have a membrane marker, the IHC threshold is used to ‘protect’ the IHC stain from nucleus detection. Since, in cases of over-stained tissue, dark-brown might appear blue, nuclei might be detected when none exist.

**Size Selection**

After activation of the stain threshold preview, the open project will consist of a map showing individual objects. In this status, you may manually select single nucleus candidates for an automated size calculation.

- Activate the Select Samples button and click on some representative nuclei to obtain the approximate nucleus size
- Click again on nuclei to erase the classification and exclude them from the size calculation
- You can also manually set the value for Typical Nucleus Size.

**Preview Nucleus Detection**

- Click the Preview button to execute the actual nucleus detection (including a clear separation of attached nuclei) based on the available nucleus area you have defined in *Stain Thresholds* on the preceding page.

### 9.3 Nucleus Detection (IF)

#### 9.3.1 Overview

- Key functions: Detection of nuclei based on DAPI or Hoechst stain
- Portals: Tissue Studio IF, Tissue Studio IF (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis

#### 9.3.2 Introduction

Configuration of this action will be performed on the subsets created with the Initialize Cellular Analysis action. Display the action fields by selecting the action in the Analysis Builder window.

Figure 9.6. The Nucleus Detection results in nuclear (left, Nucleus Negative in blue, Nucleus Positive in yellow), membrane (center, Nucleus in blue) and cytoplasm mode (right, Nucleus in blue).

Figure 9.7. The Nucleus Detection action (IF) with membrane mask but without screenshots (left) and without membrane mask but with screenshots(right).
9.3.3 Settings

Channel Selection

Select the nucleus layer that comprises the actual nucleus information (for example, the DAPI channel).

You can prevent nuclei from being formed where a strong membrane signal is present by choosing a membrane mask layer. This way, you can ensure that a subsequent Cell and Membrane action will not have nuclei that cross membrane signals and prevent the creation of individual cells.

Stain Threshold

Nucleus Region is a generic, non-RGB scale threshold based on the local contrast of the fluorescence stain.

- You may modify the threshold and exclude objects with values below the thresholds from further analysis
- By clicking the Preview Threshold button, you will be able to see the intermediate stain classification according to your settings
- In case of doubt, set the threshold too low rather than too high; the software will try to compensate (although it may negatively affect the result)

A membrane stain threshold must be selected if you have assigned a membrane mask layer above. At any pixel where the value of the membrane mask layer is above the threshold, no nuc stain will be detected.

The detection of the nucleus region relies on the Typical Nucleus Size (µm²) value. Therefore, the nucleus region preview may change whenever changes are made to the nucleus size. We recommended making an initial estimate, then defining the nucleus size and going back to the Nucleus Region threshold for final adjustments if required.

Size Selection

After activating the nucleus region preview, the open project will consist of a map showing individual objects. In this status, you may manually select single nucleus candidates for an automated size calculation.

- Activate the Select Samples button and click on some representative nuclei to obtain the approximate nucleus size
- Click again on nuclei to erase the classification and exclude them from the size calculation
- You can also manually set the value for Typical Nucleus Size.

Preview Nucleus Detection

- Click the Preview button to execute the actual nucleus detection (including a separation of touching nuclei) based on the available nucleus area you have defined in Stain Thresholds above.
9.4 Nucleus Morphology and Filter

9.4.1 Overview

- Key functions: Exclusion of unwanted nuclei based on nucleus morphology and other features
- Portals: All
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection
- Supported stains: Brown chromogen, red chromogen, H&E and immunofluorescence
- Use case: Eliminate fibroblasts and leukocytes to improve statistics on tumor nuclei

9.4.2 Introduction

The Nucleus Morphology and Filter action lets you remove nuclei from further analysis based on morphology and up to three other features. Prior analysis with the Nucleus Detection action is mandatory.

The filter is applied to both positive and negative nuclei.
Display the action fields by selecting the action in the Analysis Builder window.

![Filter by Sample and Feature](image)

**Figure 9.9.** The Nucleus Morphology and Filter action with and without feature filter activated.

### 9.4.3 Settings

**Filter by Sample**
- Click on Accept to activate a brush tool and mark samples of nuclei you want to analyze further (e.g. tumor nuclei).
- Click on Discard to activate a brush tool and mark samples of nuclei you want to exclude from further analysis (e.g. connective tissue nuclei).
- Click on Clear Sample to activate a brush tool and erase any incorrect sample you may have chosen.
- Click on Undo Step to remove samples set before the last learn (up to five steps can be reverted).
- Click on Undo All to erase all samples.

**Filter by Feature**
- Mark Activate
- Select feature, operator and threshold for each group (use the *Image Object Information* (p 17) window for help)
• If you use more than one feature for exclusion, nuclei that fall into any of the two or three groups will be excluded and classified according to their respective exclusion features.

**NOTE:** Tissue Studio rounds the values displayed in the Image Object Information pane up or down, to two decimal places however, the underlying values remain unchanged. This could lead to anomalies, for example, if a value in a condition is specified up to two decimal places. However, it is inadvisable to apply this kind of precision to biological systems and we recommend you build in some margin on either side of a condition.

**Preview**

• Mark the checkbox Remove Excluded Nuclei to discard nuclei in the preview that are excluded by the filter. Note that removed nuclei will always be discarded if you choose to continue with actions Cell Simulation or Membranes and Cells
• Press the Preview button to execute the nucleus morphology and filter action based on the current settings. Use Accept and Discard and press Preview until you are satisfied with the result.

**Screenshots for Export (IF portals only)**

• Activate the checkbox if you want to export two screenshots of this analysis step
• Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
• You can apply previously saved view settings by clicking the Apply Settings button
• Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – but both with the defined layer view settings.

**9.5 Marker Area Detection (BF)**

**9.5.1 Overview**

• Key functions: Detection of stained areas and basic area calculations
• Portals: Tissue Studio, Tissue Studio (TMA)
• Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis
• Supported stains: Brown Chromogen, Red Chromogen, IHC Dual Brown/Red, IHC Dual Stain
9.5.2 Introduction

The Marker Area Detection action detects and classifies the different stains. Depending on the image type and analysis resolution, the detection will be performed in the defined ROIs on single images, on tiles of slides or on TMA cores.

Configuration of this action will be done on the subsets created with the Initialize Cellular Analysis action. Display the action fields by selecting the action in the Analysis Builder window.

![Marker Area Detection Settings](image)

Figure 9.10. The Marker Area Detection with prior Nucleus Detection action and single IHC Marker (left) and without Nucleus Detection and dual IHC Marker (right)

9.5.3 Settings

**Marker Detection Settings**

The stain values are based on the conversion of the RGB space to the HSD model. In the RGB model, standardized recognition is only possible by using complex and time-consuming algorithms. Therefore, the HSD model is superior for transmitted light microscopy images.²

For single IHC stain:

- Adjust the Threshold marker to denote the threshold of the IHC stain. Objects above the threshold will be classified as Marker Stain (IHC).
- In the absence of a prior nucleus detection, a Threshold Hematoxylin slider needs to be adjusted as well. Objects above the threshold will be classified as Hematoxylin.

For dual IHC stain:

- Adjust all of Threshold Hematoxylin, Threshold Brown and Threshold Red, as well as the Minimum Area (µm²) settings. The corresponding objects will be classified as Hematoxylin, Brown Stain, and Red Stain.

For all stains:

- Objects with sizes smaller than the Minimum Area value are excluded from further analysis.

9.5.4 Preview

- Click the Preview button to display the classification result according to your settings.

9.6 Marker Area Detection (IF)

9.6.1 Overview

- Key functions: Detection of stained areas and basic area calculations
- Portals: Tissue Studio IF, Tissue Studio IF (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis
- Supported stains: All

9.6.2 Introduction

The Marker Area Detection action detects and classifies the different stains. Depending on the image type and analysis resolution, the detection will be performed in the defined ROIs on single images, on tiles of slides or TMA cores.

Configuration of this action will be done on the subsets created with the Initialize Cellular Analysis action. Display the action fields by selecting the action in the Analysis Builder window.

9.6.3 Settings

Marker Detection Settings

- You can select up to three different layers for detection and adjust their thresholds
- All marker regions with a size below the Minimum Area threshold will be excluded from the analysis.

Preview

- Choose the markers you want to see in the current preview by activating their respective checkboxes. (In the batch analysis all markers will be considered, independent of the checkbox status.)
- Click the Preview button to display the classification result according to your settings
- Use the up and down arrow buttons in the toolbar to change between the Lower MarkerLevel and the Upper NucleusLevel (the latter is only present if Nucleus Detection has been used).

Screenshots

- Activate the checkbox if you want to export two screenshots of this analysis step
Figure 9.11. The Marker Area Detection action

Figure 9.12. Classification result based on three different fluorescence markers in addition to the DAPI stain (the latter is the displayed layer): to the left the lower MarkerLevel and to the right the upper NucleusLevel
• Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
• You can apply previously saved view settings by clicking the Apply Settings button
• Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – but both with the defined layer view settings.

9.7 Vessel Detection

9.7.1 Overview

• Key functions: Detection of vessels with and without lumen
• Portals: All
• Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis
• Supported stains: Brown chromogen, red chromogen, immunofluorescence, IHC Dual Stain, IHC Dual Brown/Red

9.7.2 Introduction

The vessel detection action detects vessels with and without lumen. Prior analysis with the Nucleus Detection action is optional.

Display the action fields by selecting the action in the Analysis Builder window.

To process and quantify images that contain a vessel and another marker, you can use Vessel Detection followed by Marker Area Detection on page 89; you would then typically categorize these vessels using the Vessel Classification on page 126 action.
9.7.3 Settings

Stain Detection

- IHC Threshold: modify to determine how sensitive the action reacts to stain
- The Min Stain Area (µm²) slider allows you to exclude small stain artefacts
- The gap to close (µm) slider lets you select a distance over which openings in the vessel wall will be closed. This allows you to bridge over small gaps in the vessel stain. However, if the value is increased, gaps between neighboring (but unconnected) vessels might also get closed.
- Preview settings lets you visualize your chosen settings. Try to achieve a setting in which all lumen are shown as closed Vessel Stain but without connecting different neighboring vessels by closed Vessel Stain.

Vessel Detection

- Click the Preview button to execute the vessel detection based on current settings. On the Nucleus Level classes Vessel Wall and Vessel Lumen are generated, on the Cell Level Vessels are merged as Vessels with Lumen or Vessel without Lumen.

![Figure 9.14](image)

Figure 9.14. Original image with stained vessels (left), results of preview settings (center) showing Vessel Stain (red) and closed Vessel Stain (pink) areas, and results of preview (right) showing the Nucleus Level with classes Vessel Wall (purple) and Vessel Lumen (green).

Screenshots (only in IF portals)

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (e.g. with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply previously saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – but both with the defined layer view settings.

Stitch Vessels

As vessels are typically long, you may prefer to use the Stitch Vessels option, to create a continuous image. This option is only available for large images in the Tissue (not TMA) portals.
9.8 Cell Simulation

9.8.1 Overview

- Key functions: Simulation of a cell body around a nucleus or within a marker stain
- Portals: All
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection
- Supported stains:
  - Grow from Nuclei only: HE, Hematoxylin and Spot Stains
  - Grow from Nuclei, Simulate Inside Stain: Brown Chromogen, Red Chromogen, IHC Single Stain (Flexible Chromogen), Immunofluorescence
  - Grow from Nuclei, Simulate Inside Stain, Simulate Inside Stains Separately: IHC Brown/Red Chromogen, IHC Dual Stain (Flexible Chromogens)

9.8.2 Introduction

The Cell Simulation action simulates a cell based on the nucleus information available derived from the Nucleus Detection action. Prior analysis with the Nucleus Detection action is therefore mandatory.

The Cell Simulation action will add an additional level to the analysis subsets. You can switch between the upper Cell Level and the lower Nucleus Level with the respective arrow buttons in the display toolbar (p 10).

Display the action fields by selecting the action in the Analysis Builder window.

Figure 9.15. The Cell Simulation action with grow from nuclei setting (left, here BF) and simulate inside cytoplasmic stain (right, here IF)

3. The name of this option will vary, based on whether the selected marker is nuclear, membrane or cytoplasm – see Settings for more details
4. The name of this option will vary, based on whether the selected marker is nuclear, membrane or cytoplasm – see Settings for more details
9.8.3 Settings

Cell Simulation Settings

Depending on the stain or stain combination, between one and three simulation modes are available:

- **Grow from nuclei:**
  - Cells will grow from nuclei with by a maximum distance defined by the user. You can restrict growth to a certain size by setting a maximum cell growth threshold.

- **Simulate inside cytoplasmic stain**
  - Cells will grow inside a region where cytoplasm stain is above a user-defined marker threshold. You must additionally enter a typical cell size.

- **Simulate inside both stains**
  - This option is available when both markers are not nuclear. Use this option if you do not need values for the separate stains, for example when markers are co-localized. Enter values for both marker thresholds and the typical cell size.

- **Simulate inside stain**
  - This option is available when one marker is nuclear. Enter values for the marker threshold and the typical cell size.

- **Simulate inside stains separately**
  - This option is available when both markers are not nuclear. Use this feature when cells have distinctive markers, for example, when separating two sorts of cells. Enter values for both marker thresholds and the typical cell size.

**NOTE**: In IF portals, you must select the layers which contain the cytoplasm stain in which you want the cells to grow.

**Preview Cell Simulation**

- Click the Preview button to execute the cell simulation based on current settings.

![Classification result](image)

**Figure 9.16.** Classification result (upper Cell Level displayed) with Maximum Cell Growth (µm) at 3.5 (left) and 20 µm setting (right)
Screenshots (only in IF portals)

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (e.g. with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply already saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – but both with the defined layer view settings.

9.9 Membranes and Cells (BF)

9.9.1 Overview

- Key functions: Simulation of the cell body and its membrane
- Portals: Tissue Studio, Tissue Studio (TMA)
- Prerequisite actions: General Settings (only in Membrane mode), any ROI detection or TMA core detection, Initialize Cellular Analysis, Nucleus Detection
- Supported stains: Brown chromogen, red chromogen

9.9.2 Introduction

The Membranes and Cells action simulates a cell body depending on the brown or red IHC stain and creates a membrane around the cell border. Prior analysis with the Nucleus Detection action is mandatory.

The Membranes and Cells action will add an additional level to our analysis subsets. You can switch between the upper Cell Level and the lower Nucleus Level with the respective arrow buttons in the display toolbar (p 10).

![Figure 9.17. The Membranes and Cells action](image)

Display the action fields by selecting the action in the Analysis Builder window.
9.9.3 Settings

Stain

The IHC Threshold is based on the conversion of the RGB space to the HSD model. In the RGB model, standardized recognition is only possible by using complex and time-consuming algorithms. Therefore, the HSD model is superior for transmitted light microscopy images. 5

- Set a threshold for the IHC stain and press the Preview Threshold button to apply the setting
- Set threshold to 0 to include all regions for membrane detection.

This parameter allows you to discriminate between background (non-ROI) and ROI to be analyzed. Objects with values below the threshold will not be considered for membrane detection and cell separation. This way you can reject areas with no IHC stain (such as connective tissue) from the cell growing procedure. Remember that this will also reject ROI areas without IHC stain.

Membrane

Change the pixel width of the simulated membrane (this is of interest for further classification based on color intensities). Choose 1 pxl if you would like to use HER-2 based cell classification. Choose a width of at least 1.5 pxl to create a connected membrane.

Preview

Press the Preview button to start the membrane detection and cell separation process

![Image](image_url)

Figure 9.18. Classification result (cell level, cell in red) with optimal IHC threshold (left) and restrictive setting (right)

---

The Membranes and Cells (IF) action simulates a cell body based on a user-defined membrane marker channel and creates a membrane around the cell border. Prior analysis with the Nucleus Detection action is mandatory. The Membranes and Cells action will add an additional level to our analysis subsets. You can switch between the upper Cell Level and the lower Nucleus Level with the respective arrow buttons in the display toolbar (p 10). Display the action fields by selecting the action in the Analysis Builder window.

9.10.3 Settings

Stain

Choose the layer that contains the membrane stain information.

Membrane

You can change the pixel width of the simulated membrane. This is of interest for further classification based on color intensities. Choose a width of at least 1.5 pxl to create a connected membrane.
Figure 9.20. The Membranes and Cells action

**Preview**

Press the Preview button to start the membrane detection and cell separation process.

Figure 9.21. Classification result (NucleusLevel) in swipe view displaying membrane (red), cytoplasm (green) and nucleus (blue) in outline view

**Screenshots**

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply already saved view settings by clicking the Apply Settings button
• Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – but both with the defined layer view settings.

### 9.11 Marker Area Classification (BF)

#### 9.11.1 Overview

- **Key functions:** Classification of marker into intensity dependent subclasses and exclusion of unwanted structures
- **Portals:** Tissue Studio, Tissue Studio (TMA)
- **Prerequisite actions:** General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Marker Area Detection
- **Supported stains:** Brown chromogen, red chromogen

#### 9.11.2 Introduction

The Marker Area Classification action allows a sub-classification of the detected marker area and exclusion of marker area objects based on up to three features. Subclassification can be based on the IHC Marker Intensity, the optical density, or none (if the action is only used to exclude objects). This is achieved by segmenting the detected marker further into regions of Marker High, Marker Medium and Marker Low. Prior analysis with the Marker Area Detection action is mandatory. Display the action fields by selecting the action in the Analysis Builder window.

#### 9.11.3 Settings

**Intensity Measure**

You can choose to base the marker area classification on the intensity of the IHC Marker, the overall density of the marked region or none (if you want to use only the exclusion).

**Thresh Low/Medium**

Select an intensity/density threshold to separate the classes Marker Low and Marker Medium.

**Thresh Medium/High**

Select an intensity/density threshold to separate the classes Marker Medium and Marker High.
Figure 9.22. The Marker Area Classification action with marker intensity classification mode and exclusion

Exclusion

The exclusion criteria are applied before the segmentation of the Marker Area into subclasses takes place.

- Mark the checkbox Use Exclusion to activate three features for exclusion of nuclei
- Select feature, operator and threshold for each group (use the Image Object Information (p 17) window for help)
- If you use more than one feature for exclusion, marker areas that fall into any of the two or three groups will be excluded and classified according to the respective exclusion feature
- Mark the checkbox Remove Excluded Areas to discard marker area objects in the preview that fall under the exclusion criteria.
Preview

Press the Preview button to execute classification and exclusion according to your settings.

![Classification result of marker area classification showing Marker High (red), Marker Medium (orange) and Marker Low (yellow).](image)

**Figure 9.23.** Classification result of the marker area classification showing Marker High (red), Marker Medium (orange) and Marker Low (yellow).

**Marker Intensity and Optical Density:** In Tissue Studio, marker intensity – the amount of stain – is mapped on a linear (0–3) scale. Optical density, on the other hand, corresponds to the sum of all stain and counterstain values and is measured on an exponential scale – the colour deconvolution technique used includes a correction for the absorbance of the stain, and this correction is exponential.

### 9.12 Spot Detection (BF)

#### 9.12.1 Overview

- Key functions: Detection of spots in up to two different stains
- Portals: Tissue Studio, Tissue Studio (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis
- Supported stains: Counterstain and Spot Stains (IHC)

#### 9.12.2 Introduction

The Spot Detection action allows the detection of spots, stained with up to two different chromogens, defined under general settings. Prior analysis with Nucleus Detection, Nucleus Morphology and Filter, and Cell Simulation is optional. In this case, spots are only detected within nuclei or cells. If only one chromogen is selected, the action will create
If two spot stains are selected in General Settings, the action will create the classes Spot Stain A, Spot Stain B, and Spot Stain A and B Overlap. Display the action fields by selecting the action in the Analysis Builder window.

![Figure 9.24. The Spot Detection action with two spot stains.](image)

### 9.12.3 Settings

**Threshold A/Threshold B**

One or two threshold sliders are available depending on the number of spot stains you have defined in General Settings.

**Preview Threshold(s)**

Press the Preview Threshold(s) button to evaluate your settings. Note that this preview is also affected by the Spot Size (µm²) setting below.

**Size Selection**

As soon as you have executed the preview, you may manually select single spot candidates for an automated size estimation.

- Activate the Select Samples button and click on some representative spots to obtain the approximate spot size
- Click again on spots to erase the classification and exclude them from the size calculation
- You can also manually set the value for the Spot Size (µm²).
Remove Spots at Border

If activated, spots that are at the border of different compartments (and cannot be securely allocated to one of the two) will be removed. This option is only available if a nucleus or cell detection action is configured.

Preview

Press Preview to execute the spot detection action based on the current settings.

Figure 9.25. Classification result of the marker area with Spot Stain A (Red Chromogen; classified in cyan) and Spot Stain B (Silver, classified in red).

9.13 Spot Detection (IF)

9.13.1 Overview

- Key functions: Detection of spots in up to two channels
- Portals: Tissue Studio IF, Tissue Studio IF (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis,

9.13.2 Introduction

The Spot Detection action allows a detection of spots in one or two image channels. Prior analysis with Nucleus Detection, Nucleus Morphology and Filter, and Cell Simulation is optional. Display the action fields by selecting the action in the Analysis Builder window.
9.13.3 Settings

Spot A

Select the channel in which you want to find spots. The spots in this channel will be classified as Spot Stain A.

Spot B

Select a second channel if you want to find spots in two different channels. The resulting spots will be classified as Spot Stain B.

Threshold A/Threshold B

One or two threshold sliders are available when the respective channels are selected.

Preview Threshold(s)

Press the Preview Threshold(s) button to evaluate your settings. Note that this preview is also affected by the Spot Size (µm²) setting below.
Size Selection

As soon as you have executed the preview, you may manually select single spot candidates for an automated size estimation.

- Activate the Select Samples button and click on some representative spots to obtain the approximate spot size
- Click again on spots to erase the classification and exclude them from the size calculation
- You can also manually set the value for the Spot Size (µm²).

Remove Spots at Border

If activated, spots that are at the border of different compartments (and cannot be securely allocated to one of the two) will be removed (unclassified).

Preview

Press Preview to execute the spot detection action based on the current settings.

![Figure 9.27. Classification result of the spot detection in the red and the green channel](image_url)

Screenshots for Export

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply previously saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.
Two screenshots are exported – one with and one without classification overlay – but both with the defined layer view settings.

### 9.14 Spot Classification

#### 9.14.1 Overview

- Key functions: Classification of spots into area dependent subclasses and exclusion of unwanted structures
- Portals: All
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Spot Detection
- Supported stains: Counterstain and Spot Stains (IHC), immunofluorescence

#### 9.14.2 Introduction

The Spot Classification action allows a sub-classification of the detected spots and exclusion of spots based on up to three features. Prior analysis with the Spot Detection action is mandatory. Classification is based on area. Subclassification can be suppressed by choosing the feature none if only an exclusion is desired.

Display the action fields by selecting the action in the Analysis Builder window.

![Figure 9.28. The Spot Classification action](image)
9.14.3 Settings

Classification Based on Area

Select Feature Choose Area (µm$^2$) from the drop-down list. Spots (classes Spot Stain A, Spot Stain B, and Spot Stain A and B Overlap) will each be subclassified as Large, Medium and Small.

Thresh Small/Medium (µm$^2$) Set the minimum threshold to distinguish small and medium-sized spots.

Thresh Medium/Large (µm$^2$) Set the minimum threshold to distinguish medium-sized from large spots. You can also set the thresholds to the same value, to classify the spots into two classes only (Small and Large).

Exclusion

The exclusion criteria are applied to all spots independent of their sub-classification.

- Mark the checkbox Use Exclusion to activate three features for exclusion of spots
- Select feature, operator and threshold for each group (use the Image Object Information (p 17) window for help)
- If you use more than one feature for exclusion, spots that fall into any of the groups will be excluded and classified according to the respective exclusion feature
- Mark the checkbox Remove Excluded Spots to discard spots in the preview that fall under the exclusion criteria.

Preview

Press the Preview button to execute classification and exclusion according to your settings.

Screenshots (only IF portals)

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply already saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – with the layer view settings that have been defined.
9.15 Nucleus Classification (BF)

9.15.1 Overview

- Key functions: Classification of nuclei into subclasses (intensity or area dependent)
- Portals: Tissue Studio, Tissue Studio (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection
- Supported stains: Brown chromogen, red chromogen, H&E

9.15.2 Introduction

The Nucleus Classification action allows a sub-classification of the detected nuclei. Prior analysis with the Nucleus Detection action is mandatory.

With the IHC Marker in the General Settings action set to Nuclear, the classification can be based on either the density, the IHC marker intensity or the area and will only be applied to IHC-positive nuclei. The settings Membrane and Cytoplasm in the General Settings action only allow for sub-classification based on the area of each nucleus. For H&E stain, you can only classify by area. Display the action fields by selecting the action in the Analysis Builder window.

![Image of Nucleus Classification action]

Figure 9.29. The Nucleus Classification action with marker intensity classification mode

9.15.3 Settings

Classification Based on Area

Select Feature  Choose Area (µm²) from the drop-down list. Positive nuclei will be sub-classified as Nucleus Small, Nucleus Medium and Nucleus Large objects.

Thresh Small/Medium (µm²) Set the minimum threshold to distinguish small and medium-sized nuclei.
**Thresh Medium/Large (µm²)** Set the minimum threshold to distinguish medium-sized from large nuclei. You can also set the thresholds to the same value, to classify the nuclei into two classes (Nucleus Small and Nucleus Large).

**Classification Based on Optical Density or IHC Marker Intensity**

**Select Feature** Choose density or IHC Marker Intensity from the drop-down list. (Density is a measure of combined Hematoxylin and IHC Marker Intensity.) Positive nuclei will be sub-classified as Nucleus Low, Nucleus Medium and Nucleus High objects. The stain values are based on the conversion of the RGB space to the HSD model. In the RGB model, standardized recognition is only possible by using complex and time-consuming algorithms. Therefore, the HSD model is superior for transmitted light microscopy images.³⁶

**Thresh Low/Medium** Set the minimum threshold to distinguish low-intensity from medium-intensity nuclei.

**Thresh Medium/High** Set the minimum threshold to distinguish medium-intensity from high-intensity nuclei. You can also set the thresholds to the same value, to classify the nuclei into two classes (Nucleus Low and Nucleus High).

![Classification results after Nucleus Detection](image)

Figure 9.30. Classification results after Nucleus Detection (left, Nucleus Negative in blue, Nucleus Positive in yellow) and after classification based on area (center, Nucleus Negative in blue, Nucleus Small in yellow, Nucleus Medium in red, Nucleus Large in dark red) or intensity (right, Nucleus Negative in blue, Nucleus Low in light red, Nucleus Medium in red, Nucleus High in dark red)

**Classification based on Spots**

**Feature** For spot-based classification a list of features is available from the drop-down menu. For example, you can base your classification on the number of Spot Stain A sub-objects (# Spot Stain A), or, if you have selected two spot stains, on the Area Percentage Spot A to all Spots.

**Thresh None/Low**  Set the minimum threshold to distinguish between Nucleus Negative and Nucleus Low.

**Thresh Low/Medium**  Set the minimum threshold to distinguish between Nucleus Low and Nucleus Medium.

**Thresh Medium/High**  Set the minimum threshold to distinguish between Nucleus Medium and Nucleus High.

**Preview**

Press the Preview button to execute the classification according to your settings.

### 9.16 Nucleus Classification (IF)

#### 9.16.1 Overview

- Key functions: Classification of nuclei into subclasses (based on intensity, area, or co-localization)
- Portals: Tissue Studio IF, Tissue Studio IF (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection
- Supported stains: All

#### 9.16.2 Introduction

The Nucleus Classification action allows a sub-classification of the detected nuclei. The prior analysis with the Nucleus Detection action is mandatory.

Display the action fields by selecting the action in the Analysis Builder window.

#### 9.16.3 Settings

**Classification Based on Area**

- **Select Feature**  Choose Area (µm²) from the drop-down list. Nuclei will be sub-classified as Nucleus Small, Nucleus Medium and Nucleus Large objects.

- **Thresh Small/Medium (µm²)**  Set the minimum threshold to distinguish small and medium-sized nuclei.

- **Thresh Medium/Large(µm²)**  Set the minimum threshold to distinguish medium-sized from large nuclei. You can also set the thresholds to the same value, to classify the nuclei into two classes (Nucleus Small and Nucleus Large).
Figure 9.31. The Nucleus Classification action with marker intensity classification mode and screenshot export (left) and with classification based on co-localization (right)

Figure 9.32. Classification results based on area (Nucleus Small in light red, Nucleus Medium in red, Nucleus Large in dark red)

Classification Based on Marker Intensity

Select Feature

- Choose Marker Intensity from the drop-down list. Nuclei will be sub-classified as Nucleus None, Nucleus Low, Nucleus Medium and Nucleus High objects.

Thresh None/Low  Set the minimum threshold to distinguish negative from low-intensity nuclei.

Thresh Low/Medium  Set the minimum threshold to distinguish low-intensity from medium-intensity nuclei.
**Thresh Medium/High**  Set the minimum threshold to distinguish medium-intensity from high-intensity nuclei. You can also set the thresholds to the same value, to classify the nuclei only into two classes.

**Classification Based on Co-Localization**

The algorithm will subclassify nuclei into Nucleus Marker 1 and 2 coexpressed, Nucleus Marker 1 and 3 coexpressed, Nucleus Marker 2 and 3 coexpressed, Nucleus Marker 1, 2 and 3 coexpressed. In addition, Manders and Pearson’s correlation coefficients are calculated and exported.

**Marker**  Choose the layers that contain the markers of which co-localization is to be estimated.

**Threshold**  Choose a threshold for the intensity that will cause a nucleus to be considered marked by this marker.

**Classification Based on Spots**

**Feature**  For spot-based classification a list of features is available from the drop-down menu. For example, you can base your classification on the number of Spot Stain A sub-objects (# Spot Stain A), or, if you have selected two spot stains, on the Area Percentage Spot A to all Spots.

**Thresh None/Low**  Set the minimum threshold to distinguish between Nucleus Negative and Nucleus Low.

**Thresh Low/Medium**  Set the minimum threshold to distinguish between Nucleus Low and Nucleus Medium.

**Thresh Medium/High**  Set the minimum threshold to distinguish between Nucleus Medium and Nucleus High.

**Preview**

Click Preview to execute the classification according to your settings.

**Screenshots**

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply previously saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.

*05 November 2015  User Guide*
The Cellular Analysis Actions

Two screenshots are exported – one with and one without classification overlay, but both with the layer view settings that have been defined.

9.17 Membrane Classification (BF)

9.17.1 Overview

- Key functions: Classification of membrane into intensity dependent subclasses
- Portals: Tissue Studio, Tissue Studio (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection, Membranes and Cells
- Supported stains: Brown chromogen, red chromogen

9.17.2 Introduction

The Membrane Classification action allows a sub-classification of the detected membrane based on the IHC marker intensity or the optical density. This is achieved by segmenting the detected membrane further into regions of Membrane None, Membrane Weak, Membrane Strong. Prior analysis with the Membranes and Cells action with the membrane width set to one pixel is mandatory.

Display the action fields by selecting the action in the Analysis Builder window.

![Figure 9.33. The Membrane Classification action with IHC Marker Intensity classification mode](image)

9.17.3 Settings

Criterion

You can choose to base the membrane classification on the IHC marker intensity or on the overall optical density. The latter is recommended only if the staining density of nuclei is very weak compared to the staining density of membranes.
Thresh None/Weak

Select a threshold to separate the classes Membrane None and Membrane Weak. A value of around 0.15 for the IHC Marker Intensity is a good starting point.

Thresh Weak/Strong

Select an intensity or density threshold to separate the classes Membrane Weak and Membrane Strong. A value of around 0.7 for the IHC marker intensity is a good starting point.

Preview

Press the Preview button to execute classification and view the results according to your settings.

Figure 9.34. Original image (left) and results of the membrane classification with Membrane Strong (red), Membrane Weak (yellow) and Membrane None (white).

9.18 Cell Classification (BF)

9.18.1 Overview

- Key functions: Classification of cells into subclasses (based on intensity, area, or HER-2 scoring criteria) and exclusion of unwanted structures
- Portals: Tissue Studio, Tissue Studio (TMA)
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection, Cell Simulation or Membrane and Cells
- Supported stains: Brown chromogen, red chromogen
9.18.2 Introduction

The Cell Classification action allows a sub-classification of each cell based on either marker intensity (four subclasses), density (four subclasses), or area (three subclasses). Prior analysis with the Nucleus Detection action and the Cell Simulation or Membrane and Cells actions are mandatory. When IHC Marker Intensity or Density are selected the measurement can be performed in the whole cell or in one of its three compartments (nucleus, membrane and cytoplasm).

When measurement in membrane is selected and the action Membrane Classification is present, you can choose HER-2 as an evaluation criterion, leading to a cell subclassification into Cell HER2 0, Cell HER2 1+, Cell HER2 2+, and Cell HER2 3+.

Finally you can set the Select Feature field to ‘none’ to use this action solely for cell exclusion.

Display the action fields by selecting the action in the Analysis Builder window.

![Image](image_url)
9.18.3 Settings

Classification Based on Area

Select Feature Choose Area ($\mu m^2$) from the drop-down list. Cells will be sub-classified as Cell Small, Cell Medium or Cell Large objects.

Thresh Small/Medium Set the minimum threshold to distinguish small and medium-sized cells.

Thresh Medium/Large Set the minimum threshold to distinguish medium-sized and large cells.

Classification Based on IHC Marker Intensity or Optical Density

Select Feature Choose Marker Intensity or Density from the drop-down list. (Density is a measure of combined Hematoxylin and IHC Marker Intensity.) Cells will be sub-classified as Cell Negative, Cell Low, Cell Medium and Cell High. The stain values are based on the conversion of the RGB space to the HSD model. In the RGB model, standardized recognition is only possible by using complex and time-consuming algorithms. Therefore, the HSD model is superior for transmitted light microscopy images.  

Measurement In You can calculate intensities within the complete cell or restrict measurements to the cytoplasm, nucleus or membrane compartment, respectively.

Thresh None/Low Set the minimum threshold to distinguish negative and low-intensity cells.

Thresh Low/Medium Set the minimum threshold to distinguish low-intensity and medium-intensity cells.

Thresh Medium/High Set the minimum threshold to distinguish medium-intensity and high-intensity cells.

HER 2-Based Cell Classification

If the action Membrane Classification has been configured, it is possible to subclassify your cells into Cell HER2 0, Cell HER2 1+, Cell HER2 2+, and Cell HER2 3+. To achieve this, you must choose an intensity based cell classification with a measurement in membrane, then choose HER-2 as evaluation criterion.

A cell whose complete membrane is classified as strong is classified as Cell HER2 3+. A cell whose complete membrane is classified as weak or strong is classified as Cell HER2.

2+. A cell whose membrane is only partly stained is classified as Cell HER2 1+, and a cell with a completely non-stained membrane is classified as Cell HER2 0.

**Complete Staining**  This slider allows you to adjust a tolerance level for what is considered complete staining. If you choose 90, for example, a cell will be classified as Cell HER2 3+ if only 90% of the membrane belongs to the class Membrane Strong.

**Exclude Cells at Border**  Select this option if you do not want to include cells at the scene border and ROI border into the scoring algorithm.

**Intensity Contrast**  Select this option if you want to ensure that cells with a Membrane/Cell Intensity Ratio below the slider value are classified as Cell HER2 0.

**Classification Based on Spots**

To carry out a cell classification based on spots, you can select the features Spots – Same Compartment or Spots – Different Compartment. (See Settings Compartment 1 and 2 for an explanation of what this means.)

**Spots – Same Compartment**  Choose the compartment (nucleus, cytoplasm or cell) in which the selected feature is evaluated. For example, if ‘# Spot A’ in compartment ‘nucleus’ is selected, the cells are classified according to their number of spots inside their nucleus. If two spot stains are selected, various ratios of Spot Stain A to Spot Stain B are selectable for the cell classification.

**Spots – Different Compartment**  Cells can also be classified according to the ratio of spots in different compartments of the cell. The different compartments are selectable by the selection widgets Compartment 1/2. If two spot stains are chosen in General Settings,
the number or area ratio of Spot A in compartment 1 to Spot B in compartment 2 are available as classification features.

**Select Feature**  Select from a list of predefined features. If you select a ratio feature, and if the denominator in the ratio is zero, the ratio is given a value of −1 and the cells are classified as Cell Undefined.

**NOTE**: If you are analyzing results from an amplification FISH, use Spot A for your gene of interest and Spot B for your housekeeping gene.

**Thresh None/Low**  Set the minimum threshold to distinguish between Cell Negative and Cell Low.

**Thresh Low/Medium**  Set the minimum threshold to distinguish between Cell Low and Cell Medium.

**Thresh Medium/High**  Set the minimum threshold to distinguish between Cell Medium and Cell High.

**Exclusion**

The exclusion criteria are applied to all cells independent of their sub-classification.

- Mark the checkbox Use Exclusion to activate three features for exclusion of cells
- Select feature, operator and threshold for each group – use the *Image Object Information window* (p 17) for help
• If you use more than one feature for exclusion, cells that fall into any of the groups will be excluded and classified according to the respective exclusion feature
• Mark the checkbox Remove Excluded Cells to discard cells in the preview that fall under the exclusion criteria.

Figure 9.38. Exclusion result of simulated cells based on two features (dark and bright gray class color) without (left pane) and with (right pane) checkbox Remove Excluded Cells marked

Preview

Press the Preview button to execute classification and exclusion according to your settings.

9.19 Cell Classification (IF)

9.19.1 Overview

• Key functions: Classification of cells into subclasses (intensity or area dependent) and exclusion of unwanted structures
• Portals: Tissue Studio IF, Tissue Studio IF (TMA)
• Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Nucleus Detection, Cell Simulation or Membrane and Cells
• Supported stains: All

9.19.2 Introduction

The Cell Classification action allows a sub-classification of each cell based on either marker intensity (four subclasses), area (three subclasses) or co-localization (up to five subclasses). Prior analysis with the Nucleus Detection action and the Cell Simulation or Membrane and Cells action are mandatory. When Marker Intensity or Co-Localization are selected, the measurement can be performed in the whole cell or in one of its three compartments (nucleus, membrane and cytoplasm). You can also set the Select Feature field to None to use this action solely for cell exclusion.
Display the action fields by selecting the action in the Analysis Builder window.

Figure 9.39. The Cell Classification action with Marker Intensity classification mode and exclusion (left) and with classification based on co-localization and screenshot export.

### 9.19.3 Settings

**Classification Based on Area**

**Select Feature** Choose Area (µm$^2$) from the drop-down list. Cells will be sub-classified as Cell Small, Cell Medium or Cell Large objects.

**Thresh Small/Medium** Set the minimum threshold to distinguish small from medium-sized cells.

**Thresh Medium/Large** Set the minimum threshold to distinguish medium-sized from large cells.
Classification Based on Marker Intensity

**Select Feature**  Choose marker intensity from the drop-down list. Cells will be subclassified as Cell Negative, Cell Low, Cell Medium and Cell High objects.

**In Channel**  Select the channel that contains the membrane stain information.

**Measurement In**  You can calculate intensities within the complete cell or restrict measurements to the cytoplasm, nucleus or membrane compartment, respectively.

**Thresh None/Low**  Set the minimum threshold to distinguish negative from low-intensity cells.

**Thresh Low/Medium**  Set the minimum threshold to distinguish low-intensity from medium-intensity cells.

**Thresh Medium/High**  Set the minimum threshold to distinguish medium-intensity from high-intensity cells.

![Classification results based on Marker Intensity in Layer 2 (Cell Negative in blue, Cell Low in light red, Cell Medium in red, Cell High in dark red)](image)

**Figure 9.40.** Classification results based on Marker Intensity in Layer 2 (Cell Negative in blue, Cell Low in light red, Cell Medium in red, Cell High in dark red)

Classification Based on Co-Localization

The algorithm will subclassify cells into Cell Marker 1 and 2 Coexpressed, Cell Marker 1 and 3 Coexpressed, Cell Marker 2 and 3 Coexpressed, Cell Marker 1, 2 and 3 Coexpressed. In addition, Manders and Pearson’s correlation coefficients are calculated and exported if the same compartment is measured.

**Marker**  Choose the layers which contain the markers of which co-localization is to be estimated.
Class  Choose the cell compartment in which marker levels should be estimated.

Threshold  Choose a threshold for the intensity that will cause a cell to be considered marked by this marker.

Figure 9.41. Results of a classification based on co-localization. The top panels show the original image with Nucleus and Membrane Layer (left), Marker Layer 1 (center) and Marker Layer 2 (right). The lower panels show the classifications on the Nucleus Level (left) and Cell Level (center). In this example, a cell was counted as coexpressed if Marker Layer 1 crossed the user-defined threshold in the Nucleus, and Marker Layer 2 crossed the user-defined threshold in the cytoplasm.

Classification Based on Spots

Feature  To carry out a cell classification based on spots, you can select the features Spots – Same Compartment or, in case you have selected two different spot channels, Spots – Different Compartment. (See Compartment 1 and 2 for an explanation of what this means.)

Compartment 1  Choose the compartment, in which the feature for Spot Stain A should be evaluated. E.g. if you choose cytoplasm, and choose feature Rel. Area Spot A, the relative area of Spot Stain A within Cytoplasm is evaluated.

Compartment 2  If you have chosen two spot channels and have selected the feature Spots – Different Compartment above, you can select here the compartment in which the feature for Spot Stain B will be evaluated. E.g. if you choose “Cell” and feature #Spot B, the number of Spot Stain B within the cell is evaluated.

If you have selected the setting Spots – Same Compartment, Spot Stain B features will automatically be evaluated in the same compartment as Spot Stain A.
Select Feature  Select from a list of predefined features. If you select a ratio feature, and if the denominator in the ratio is zero, the ratio is given a value of −1 and the cells are classified as Cell Undefined.

**NOTE**: If you are analyzing results from an amplification FISH, use Spot A for your gene of interest and Spot B for your housekeeping gene.

**Thresh None/Low**  Set the minimum threshold to distinguish between Cell Negative and Cell Low.

**Thresh Low/Medium**  Set the minimum threshold to distinguish between Cell Low and Cell Medium.

**Thresh Medium/High**  Set the minimum threshold to distinguish between Cell Medium and Cell High.

**Exclusion**

The exclusion criteria are applied to all cells, independent of their sub-classification.

- Mark the checkbox Use Exclusion to activate three features for exclusion of cells
- Select feature, operator and threshold for each group (use the Image Object Information (p 17) window for help)
- If you use more than one feature for exclusion, cells that fall into any of the groups will be excluded and classified according to the respective exclusion feature
- Mark the checkbox Remove Excluded Cells to discard cells in the preview that fall under the exclusion criteria.

*Figure 9.42. Exclusion result of simulated cells based on one feature (dark gray class color) without (left pane) and with (right pane) checkbox Remove Excluded Cells marked*
Press the Preview button to execute classification and exclusion according to your settings.

**Screenshots**
- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply previously saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – with the layer view settings that have been defined.

### 9.20 Vessel Classification

#### 9.20.1 Overview
- Key functions: Classification of vessels into subclasses (intensity or area dependent) and exclusion of unwanted structures
- Portals: All
- Prerequisite actions: General Settings, any ROI detection and TMA core detection, Initialize Cellular Analysis, Vessel Detection
- Supported stains: Brown chromogen, red chromogen, immunofluorescence

#### 9.20.2 Introduction

The Vessel Classification action allows a sub-classification of the detected vessels and exclusion of vessels based on up to three features. Prior analysis with the Vessel Detection action is mandatory.

In the BF portals, the classification can be based on either the density, the IHC marker intensity or the area. In IF portals, classification can be based on either area or intensity. In all portals, subclassification can be suppressed by choosing the feature none if only a exclusion is desired.

Display the action fields by selecting the action in the Analysis Builder window.

#### 9.20.3 Settings

**Classification Based on Area**

**Select Feature** Choose Area ($\mu m^2$) from the drop-down list. Vessels will be subclassified into Vessels Small, Vessels Medium, and Vessels Large. Note that the prior subclassification of vessels into Vessels with Lumen and Vessels without Lumen is overwritten by this action.
**Classification Based on Optical Density or IHC Marker Intensity (BF only)**

**Select Feature**  Choose density or IHC Marker Intensity from the drop-down list. Vessels will be sub-classified as Vessel Low, Vessel Medium and Vessel High objects. Note that the prior subclassification of vessels into Vessels with Lumen and Vessels without Lumen is overwritten by this action. The stain values are based on the conversion of the RGB space to the HSD model. In the RGB model, standardized recognition is only possible by using complex and time-consuming algorithms. Therefore, the HSD model is superior for transmitted light microscopy images.  

**Thresh Low/Medium**  Set the minimum threshold to distinguish low-intensity from medium-intensity vessels.

**Thresh Medium/High**  Set the minimum threshold to distinguish medium-intensity from high-intensity vessels. You can also set the thresholds to the same value, to classify the vessels into two classes (Vessel Low and Vessel High).

---

subclassification of vessels into Vessels with Lumen and Vessels without Lumen is overwritten by this action.

In Channel

- Choose the channel on which intensity measurements are based from the drop-down list.

**Thresh None/Low** Set the minimum threshold to distinguish negative from low-intensity vessels.

**Thresh Low/Medium** Set the minimum threshold to distinguish low-intensity from medium-intensity vessels.

**Thresh Medium/High** Set the minimum threshold to distinguish medium-intensity from high-intensity vessels. You can also set the thresholds to the same value, to classify the vessels only into two or three classes.

Exclusion

The exclusion criteria are applied to all vessels independent of their sub-classification.

- Mark the checkbox Use Exclusion to activate three features for exclusion of vessels
- Select feature, operator and threshold for each group (use the Image Object Information (p 17) window for help)
- If you use more than one feature for exclusion, vessels that fall into any of the groups will be excluded and classified according to the respective exclusion feature
- Mark the checkbox Remove Excluded Vessels to discard vessels in the preview that fall under the exclusion criteria.
Preview

Press the Preview button to execute classification and exclusion according to your settings.

Screenshots (only IF portals)

- Activate the checkbox if you want to export two screenshots of this analysis step
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay, with or without changed image layer mixing settings) and click the Save Settings button to store these settings for export
- You can apply already saved view settings by clicking the Apply Settings button
- Go back to the default settings by pressing the Default Settings button.

Two screenshots are exported – one with and one without classification overlay – with the layer view settings that have been defined.
10 The Export Actions

10.1 Heatmap

10.1.1 Overview

- Key functions: Export of a heat map, based on defined classes, features and operators.
- Portals: Tissue Studio BF, Tissue Studio IF
- Prerequisite actions: General Settings, any ROI detection, any Cellular Analysis action
- Supported stains: All

10.1.2 Introduction

The Heatmap action lets you export a high-resolution heat map, allowing you to quickly evaluate analysis results. You can select the classes for export, which statistical operations to perform and the feature to be exported.

Two files per scene and per heat map action are generated:

1. A basic grayscale heat map
2. A color image with a heat map overlay. The alpha value entered in the action will be respected in the exported file. An export of the original scene image is also created.

Files are saved in the Results/heatmaps folder, with the structure

{Scene_Name}_Heatmap-{Heatmap Action number}_{Simple/Overlay}_{Analysis version number}.jpg

This action can be placed before or after the other Export actions. Up to ten instances can be added.

10.1.3 Settings

Heatmap Parameters

Heatmap Type  Select Single Feature or one of the following arithmetic operators:

- Features: +
Figure 10.1. The Heatmap action
The Export Actions

- Features: -
- Features: /
- Features: *

Smoothing Grade  Use the slider to select the degree of smoothing – in other words, the granularity of your analysis – between 1.0 and 3.0.

Feature Settings

Selecting Single Feature as Heatmap Type displays options for a single feature; selecting a Heatmap Type other than Density will reveal a third field, which lets you specify a feature.

Any features used are automatically exported to a Definiens Result Container for use in the Review Heat Map (p 163).

Object Class  Select the object class from your analysis to display.

Statistical Operation  Choose from Density, Mean, Min, Max, Median, Std Dev, or Sum.

Heatmap Feature  Choose an optional feature to display. The available features are the same as those available in the Custom Exports (Cellular Analysis) action.

Preview Settings

Preview Heatmap  Press the Preview button to view the heat map.

Display Buttons

- Press Original to display the original image
- Press Overlay to display the image plus a color heat map overlay. Use the Transparency slider to change the opacity of the overlay
- Press Only Heatmap to display the heat map only as a grayscale image.

An original image and heatmap is shown in figure 10.2 on the following page.

10.2 Default Export (BF)

10.2.1 Overview

- Key functions: Export of standard features for both ROI detection and cellular analysis results. The results are exported per ROI as well as per image.
- Portals: Tissue Studio, Tissue Studio (TMA)
10.2.2 Introduction

The Default Export action allows you to create .csv files that contain several project-specific statistics (the Statistics export folder) and screenshots of the corresponding ROIs and detailed analyses (the Screenshots folder). There is also an option to display a scale bar.

10.2.3 Screenshots Folder

Screenshots belonging to a scene are exported into the Screenshots folder.

- In the subfolder “ROIDetection”, files with the structure [SceneName]_[Level][Style].v[n].jpg for each available level and selected style are generated
- In the subfolder “CellularAnalysis”, files with the structure [SceneName]_[Level][Style].v[n].jpg for each available level and selected style are generated.

10.2.4 Statistics Folder

AnalysisReport

A report file AnalysisReport.csv located in the Statistics folder is created during any analysis. It contains the following information for each slide or TMA slide (depending
on workflow):
- The name of the solution used for the analysis
- Magnifications for ROI detection, cellular analysis and the original scene
- Pixel resolution of the original image

**Config**

The folder Config in the statistics folder contains a file for each processed scene detailing which actions were used and the values of relevant configuration parameters. The file Config.csv combines the information for all scenes in one file.

**ROI Detection**

When you check the ROI Detection Statistics checkbox in Default Export, the results of the ROI Detection are exported to the Statistics folder.

The file ROI_Detection_DefaultExport_per_Slide.csv (in the subfolder ROI_Detection_DefaultExport_per_Slide) contains the default ROI exports per ROI object in every row.
The following statistical results are exported for each relevant ROI:

- <Name of ROI> Relative Area (%)  
- <Name of ROI> Area (µm²)  
- Layer mean of <Stain Name><Name of ROI>  
- # <Name of ROI>

In BF portals, optical density values are calculated as \( OD = \frac{-\ln(R/Ro)-\ln(G/Go)-\ln(B/Bo)}{3} \), with \( R, G, \) and \( B \) referring to the RGB value of the image, and \( Ro, Go, \) and \( Bo \) referring to the typical RGB value of the white background.

**Cellular Analysis**

When you check the Cellular Analysis Statistics checkbox in Default Export, the results of the cellular analysis are exported to the CellularAnalysis_DefaultExport.report sub-folder.

Which files are generated depends on the workflow:

- For TMA slides it is called CellularAnalysis_DefaultExport_per_Core.csv (in the subfolder ROIDetection_DefaultExport_per_Core)  
- For tissue slides with random sampling, the following files are exported:  
  - CellularAnalysis_DefaultExport_per_Sample.csv  
  - CellularAnalysis_DefaultExport_per_ROI_per_Sample.csv  
  - CellularAnalysis_DefaultExport_per_Slide.csv  
- For tissue slides without random sampling, the following files are exported:  
  - CellularAnalysis_DefaultExport_per_ROI.csv  
  - CellularAnalysis_DefaultExport_per_Slide.csv.

There are two checkboxes in the Cellular Analysis pane – activating these will cause the export of the following statistics:

- Statistics per Slide  
  - CellularAnalysis_DefaultExport_per_Slide.csv  
  
  When active, exports are generated based on class, with one ROI class per row. If random sampling is active, CellularAnalysis_DefaultExport_per_Sample.csv exports are generated containing exports per class within each sample

- Statistics per ROI Object  
  - CellularAnalysis_DefaultExport_per_ROI.csv  

  When active, exports are generated based on the ROI objects, with one row per ROI object. If random sampling is active, CellularAnalysis_DefaultExport_per_ROI_per_Sample.csv exports are generated containing summary statistics inside each object of each ROI class, including positions of object on the slide

The following statistical results are included (depending on the actions that were present in the solution):

1. This file is only generated when Statistics per ROI Export is checked in Default Export. Data is generated per ROI object.  
2. Data is generated per class for this file type.

05 November 2015 User Guide
Nucleus Detection

- # All Nucleus

If there is a nuclear marker:

- Average <Name of IHC Marker Layer> Intensity (Nucleus), where:
  - Channel = Brown Chromogen for IHC dual Brown/Red Chromogen if the Brown marker is nuclear
- # Nucleus Negative, # Nucleus Positive
- Positive Index

(If no nuclear marker is present, this value is not exported.)

Marker Area Detection

- No Stain Area (µm²)
- Area Hematoxylin Stain (µm²) (if applicable, i.e. if there is no nucleus detection)

IHC single stain:

- Average «Name of IHC Marker Layer» Intensity (IHC Marker Stain)
- Area IHC Marker Stain (µm²)
- % Area IHC Marker Stain
- # Marker Areas

IHC dual stain:

- Area Red Stain Only (µm²), Area Brown Stain Only (µm²), Area Red and Brown Colocalized (µm²)
- % Area Red Stain, % Area Brown Stain, % Area Red and Brown Colocalized
- Average Red Chromogen Intensity (Red Stain-Only Area), Average Red Chromogen Intensity (Colocalized Area)
- Average Brown Chromogen Intensity (Brown-Only Area), Average Brown Chromogen Intensity (Colocalized Area)
- Percental Score
- % Area Marker A, % Area Marker B, % Area Marker A and Marker B
- Area Marker A (µm²), Area Marker B (µm²), Area Marker A and Marker B Colocalized (µm²)
- Area Hematoxylin Stain (µm²) (if no nucleus detection action is present)
- No Stain Area (µm²)
- # Marker Areas

Vessel Detection

- Vessel Density (1/mm²), Vessel with Lumen Density (1/mm²)
- # Vessel, # Vessel with Lumen, # Vessel without Lumen
- Average Vessel Size (µm²)
- Average Vessel with Lumen Size (µm²)
- Average Vessel without Lumen Size (µm²)
- Average Vessel Wall Thickness (µm)
• Median Vessel Size (µm²), Median Vessel with Lumen Size (µm²), Median Vessel without Lumen Size (µm²), Median Vessel Wall Thickness (µm) (if evaluate stats from image)

Cell Simulation
• # All Cells, # Cells with Cytoplasm, # Cells with Nucleus
• Average Cell Area(µm²)
• Average <Name of IHC Marker Layer> Intensity (Cytoplasm)
• Average <Name of IHC Marker Layer> Intensity (Cell)
• Ratio of Average Nucleus and Average Cytoplasm IHC Intensity
• Mean Area Ratio Nucleus to Cell (if stain combination is HE)

Membranes and Cells
• # All Cells, # Cells with Cytoplasm, # Cells with Nucleus
• Average Cell Area (µm²)
• Average <name of IHC Marker Layer> Intensity (Cytoplasm)
• Average <name of IHC Marker Layer> Intensity (Cell)
• Average <name of IHC Marker Layer> Intensity (Membrane)
• Average Membrane-Cytoplasm Contrast IHC Marker <Name of IHC Marker Layer>

Spot Detection
• If no nucleus actions:
  – # Spot Stain A, # Spot Stain B (if available)
• If there is a nucleus action:
  – Average # Spot Stain A (Nucleus), Average # Spot Stain B (Nucleus), Average Area Spot Stain A (Nucleus), Average Area Spot Stain B (Nucleus), Ratio Spot Stain A/B (Nucleus)
• If there is a cell action:
  – Average # Spot Stain A (Cell), Average # Spot Stain B (Cell), Average Area Spot Stain A (Cell), Average Area Spot Stain B (Cell), Ratio Spot Stain A/B (Cell)
  – Average # Spot Stain A (Cytoplasm), Average # Spot Stain B (Cytoplasm), Average Area Spot Stain A (Cytoplasm), Average Area Spot Stain B (Cytoplasm), Ratio Spot Stain A/B (Cytoplasm)

Spot Classification
If classified by size:
• If no nucleus actions:
  – # Spot Stain A Large, # Spot Stain A Medium, # Spot Stain A Small, # Spot Stain B Large, # Spot Stain B Medium, # Spot Stain B Small
• If there is a nucleus action:
  – Average # Spot Stain A Large (Nucleus), Average # Spot Stain A Medium (Nucleus), Average # Spot Stain A Small (Nucleus), Average # Spot Stain B Large (Nucleus), Average # Spot Stain B Medium (Nucleus), Average # Spot Stain B Small (Nucleus)
– Average Area Spot Stain A Large (Nucleus), Average Area Spot Stain A Medium (Nucleus), Average Area Spot Stain A Small (Nucleus), Average Area Spot Stain B Large (Nucleus), Average Area Spot Stain B Medium (Nucleus), Average Area Spot Stain B Small (Nucleus)

• If there is a cell action:
  – Average # Spot Stain A Large (Cell), Average # Spot Stain A Medium (Cell), Average # Spot Stain A Small (Cell), Average # Spot Stain B Medium (Cell), Average # Spot Stain B Small (Cell)
  – Average Area Spot Stain A Large (Cell), Average Area Spot Stain A Medium (Cell), Average Area Spot Stain A Small (Cell), Average Area Spot Stain B Large (Cell), Average Area Spot Stain B Medium (Cell), Average Area Spot Stain B Small (Cell)
  – Average # Spot Stain A Large (Cytoplasm), Average # Spot Stain A Medium (Cytoplasm), Average # Spot Stain A Small (Cytoplasm), Average # Spot Stain B Large (Cytoplasm), Average # Spot Stain B Medium (Cytoplasm), Average # Spot Stain B Small (Cytoplasm)
  – Average Area Spot Stain A Large (Cytoplasm), Average Area Spot Stain A Medium (Cytoplasm), Average Area Spot Stain A Small (Cytoplasm), Average Area Spot Stain B Large (Cytoplasm), Average Area Spot Stain B Medium (Cytoplasm), Average Area Spot Stain B Small (Cytoplasm)

Marker Area Classification  If classified by intensity:
• Average Intensity Marker Area Low, Average Intensity Marker Area Medium, Average Intensity Marker Area High
• % Area Marker Low, % Area Marker Medium, % Area Marker High
• Marker Area Low (µm²), Marker Area Medium (µm²), Marker Area High (µm²)

If classified by optical density:
• Average Optical Density Marker Area Low, Average Optical Density Marker Area Medium, Average Optical Density Marker Area High
• % Area Marker Low, % Area Marker Medium, % Area Marker High
• Area Marker Low (µm²), Area Marker Medium (µm²), Area Marker High (µm²)

Nucleus Classification If classified by intensity or optical density:
• # Nucleus Low, # Nucleus Medium, # Nucleus High
• % Nucleus Low, % Nucleus Medium, % Nucleus High
• All Red Score, All Red Intensity Score, All Red Proportion Score (if All Red is activated in default exports)
• Histological Score Nuclei (1x %Small/Low+2x %Medium+3x %Large/High)
• Average <stain channel / optical density> Intensity (Nucleus Positive). For example:
  – Average Brown Chromogen Intensity (Nucleus Positive) (if stain combination is IHC Brown Chromogen and the IHC Marker Intensity is used)
  – Average Red Chromogen Intensity (Nucleus Positive) (if stain combination is IHC Red Chromogen and the IHC Marker Intensity is used for the classification)
– Average Optical Density Intensity (Nucleus Positive) (if stain combination is IHC Red Chromogen or Brown Chromogen and the Optical Density is used for the classification)

If classified by area:

• # Nucleus Small, # Nucleus Medium, # Nucleus Large (if classified by area)
• % Nucleus Small, % Nucleus Medium, % Nucleus Large (if classified by area)
• Histological Score Nuclei (1x %Small/Low+2x %Medium+3x %Large/High)

**Cell Classification.** If classified by dual stain and stain combination is IHC dual stain (flexible chromogens):

• # Cell Negative, # Cell Marker A, # Cell Marker B, # Cell Markers A and B
• % Cell Negative, % Cell Marker A, % Cell Marker B, % Cell Markers A and B

If classified by dual stain and stain combination is IHC dual Brown/Red chromogens:

• # Cell Negative, # Cell Brown Stain, # Cell Red Stain, # Cell Red and Brown Stains
• % Cell Negative, % Cell Brown Stain, % Cell Red Stain, % Cell Red and Brown

If classified by Her-2:

• ASCO HER-2 Score, DAKO HER-2 Score
• # Cell HER2 0, # Cell HER2 1+, # Cell HER2 2+, # Cell HER2 3+
• % Cell HER2 0, % Cell HER2 1+, % Cell HER2 2+, % Cell HER2 3+

If classified by intensity:

• # Cell Negative, # Cell Low, # Cell Medium, # Cell High
• % Cell Negative, % Cell Low, % Cell Medium, % Cell High
• Histological Score Cells (1x %Small/Low+2x %Medium+3x %Large/High)

If classified by area:

• # Cell Small, # Cell Medium, # Cell Large
• % Cell Small, % Cell Medium, % Cell Large
• Histological Score Cells (1x %Small/Low+2x %Medium+3x %Large/High)

If classified according to spots:

• # Cell Negative, # Cell Low, # Cell Medium, # Cell High
• % Cell Negative, % Cell Low, % Cell Medium, % Cell High

**Vessel Classification.** If classified by size:

• % Vessel Small, % Vessel Medium, % Vessel Large
• # Vessel Small, # Vessel Medium, # Vessel Large

If classified by intensity:

• % Vessel None, % Vessel Low, % Vessel Medium, % Vessel High
• # Vessel None, # Vessel Low, # Vessel Medium, # Vessel High

05 November 2015 User Guide
Positional Information

If TMA:

- x core center position on slide (mm), y core center position on slide (mm)

If random sampling:

- x sample position on slide (mm), y sample position on slide (mm)
- x sample length (mm), y sample length (mm)
- Sample area (mm²)

10.3 Default Export (IF)

10.3.1 Overview

- Key functions: Export of standard features for both ROI Detection and Cellular Analysis results. The results are exported per ROI as well as per image
- Portals: Tissue Studio IF, Tissue Studio IF (TMA)

![Figure 10.4. The Default Export action](image)

10.3.2 Introduction

The Default Export action allows you to create .csv files that contain several project-specific statistics (the Statistics export folder) and screenshots of the corresponding ROIs and detailed analyses (the Screenshots export folder). The screenshots for the ROI detection are exported when the checkbox is active, one of the original image and one with the configured settings, all other screenshots are to be configured for the respective actions individually.
10.3.3 Screenshots

- Activate the check-box if you want to export two screenshots of this analysis step.
- Adjust the classification view of the image (for example, with or without outlines, with or without classification overlay) and click the Save Settings button to store these settings for export.
- In addition to the manually configured screenshot, the original image view will be exported.
- You can apply already saved view settings by clicking the Apply Settings button.
- Apply the default settings by pressing the Default Settings button. If you would like to save the default settings, press the Save Settings button afterwards.

10.3.4 Statistics

Screenshots Folder

Screenshots belonging to a scene are exported into the Screenshots folder.

- In the subfolder “ROIDetection”, files with the following structures are generated:
  - [SceneName].v[n].jpg
  - [SceneName]_ROI.v[n].jpg
- In the subfolder “CellularAnalysis”, files with the following structures are generated:
  - [SceneName]_[ActionName]_org.v[n].jpg
  - [SceneName]_[ActionName].v[n].jpg

Analysis Report

A report file AnalysisReport.csv located in the Statistics folder is created during any analysis. It contains the following information for each slide or TMA slide (depending on workflow):

- The name of the solution used for the analysis.
- Magnifications for ROI detection and cellular analysis and the original scene.
- Pixel resolution of the original image.

Config

A folder Config in the statistics folder contains a file for each processed scene detailing which actions were used and the values of relevant configuration parameters. The file Config.csv combines the information for all scenes in one file.

ROI Detection

When you check the ROI Detection Statistics checkbox in Default Export the results of the ROI Detection are exported to the Statistics folder. Depending on the workflow, the file is called ROIDetection_DefaultExport_per_Slide.csv (for slides) or ROIDetection_DefaultExport_per_Core.csv (for TMA workflow).
The following statistical results are exported for each relevant ROI:

- <Name of ROI> Relative Area (%)
- <Name of ROI> Area (µm²)
- Layer mean of <Stain Name><Name of ROI>
- # <Name of ROI>

**Cellular Analysis**

When you check the Cellular Analysis Statistics checkbox in Default Export, the results of the cellular analysis are exported to the Statistics folder.

Which files are generated depends on the workflow:

- For TMA slides the following file is generated:
  - CellularAnalysis_DefaultExport_per_Core.csv
- For tissue slides with random sampling, the following files are exported:
  - CellularAnalysis_DefaultExport_per_Sample.csv
  - CellularAnalysis_DefaultExport_per_ROI_per_Sample.csv
- For tissue slides without random sampling, the following file is produced:
  - CellularAnalysis_DefaultExport_per_ROI.csv

There are two checkboxes in the Cellular Analysis pane – activating these will cause the export of the following statistics:

- Statistics per Slide
  - CellularAnalysis_DefaultExport_per_Slide.csv
  
  When active, exports are generated based on class, with one ROI class per row. If random sampling is active, CellularAnalysis_DefaultExport_per_Sample.csv exports are generated containing exports per class within each sample

- Statistics per ROI Object
  - CellularAnalysis_DefaultExport_per_ROI.csv
  
  When active, exports are generated based on ROI objects, with one row per ROI object. If random sampling is active, CellularAnalysis_DefaultExport_per_ROI_per_Sample.csv exports are generated containing summary statistics inside each object of each ROI class, including positions of object on the slide

The following statistical results are included (depending on the actions that were present in the solution):

**Nucleus Detection**

- # All Nucleus
- Average <Nucleus Detection Channel> Intensity (Nucleus)
Vessel Detection

- Vessel Density (1/mm²), Vessel with Lumen Density (1/mm²)
- # Vessel, # Vessel with Lumen, # Vessel without Lumen
- Average Vessel Size (µm²)
- Average Vessel with Lumen Size (µm²)
- Average Vessel without Lumen Size (µm²)
- Average Vessel Wall Thickness (µm)
- Median Vessel Size (µm²), Median Vessel Wall Thickness (µm)
- Median Vessel with Lumen Size (µm²), Median Vessel without Lumen Size (µm²)
  (if no vessel classification action)

Cell Simulation

- # All Cells, # Cells with Cytoplasm, # Cells with Nucleus
- Average Cell Area(µm²)
- Average <Cytoplasm Channel> Intensity (Cytoplasm) (if mode is Simulate Inside Stains)

Membranes and Cells

- # All Cells, # Cells with Cytoplasm, # Cells with Nucleus
- Average Cell Area (µm²)
- Average <Membrane Channel> Intensity (Cytoplasm)
- Average <Membrane Channel> Intensity (Membrane)
- Average Membrane-Cytoplasm Contrast <Membrane Channel>

Spot Detection

- If no nucleus actions:
  - # Spot Stain A, # Spot Stain B (if available)
- If there is a nucleus action:
  - Average # Spot Stain A (Nucleus), Average # Spot Stain B (Nucleus), Average Area Spot Stain A (Nucleus), Average Area Spot Stain B (Nucleus), Ratio Spot Stain A/B (Nucleus)
- If there is a cell action:
  - Average # Spot Stain A (Cell), Average # Spot Stain B (Cell), Average Area Spot Stain A (Cell), Average Area Spot Stain B (Cell), Ratio Spot Stain A/B (Cell)
  - Average # Spot Stain A (Cytoplasm), Average # Spot Stain B (Cytoplasm), Average Area Spot Stain A (Cytoplasm), Average Area Spot Stain B (Cytoplasm)
  - Ratio Spot Stain A/B (Cytoplasm)

Spot Classification

If classified by size:

- If no nucleus actions:
  - # Spot Stain A Large, # Spot Stain A Medium, # Spot Stain A Small, # Spot Stain B Large, # Spot Stain B Medium, # Spot Stain B Small
- If there is a nucleus action:
  - Average # Spot Stain A Large (Nucleus), Average # Spot Stain A Medium (Nucleus), Average # Spot Stain A Small (Nucleus), Average # Spot Stain B...
Large (Nucleus), Average # Spot Stain B Medium (Nucleus), Average # Spot Stain B Small (Nucleus)
- Average Area Spot Stain A Large (Nucleus), Average Area Spot Stain A Medium (Nucleus), Average Area Spot Stain A Small (Nucleus), Average Area Spot Stain B Large (Nucleus), Average Area Spot Stain B Medium (Nucleus), Average Area Spot Stain B Small (Nucleus)
- If there is a cell action:
  - Average # Spot Stain A Large (Cell), Average # Spot Stain A Medium (Cell), Average # Spot Stain A Small (Cell), Average # Spot Stain B Large (Cell), Average # Spot Stain B Medium (Cell), Average # Spot Stain B Small (Cell)
  - Average Area Spot Stain A Large (Cell), Average Area Spot Stain A Medium (Cell), Average Area Spot Stain A Small (Cell), Average Area Spot Stain B Large (Cell), Average Area Spot Stain B Medium (Cell), Average Area Spot Stain B Small (Cell)
  - Average # Spot Stain A Large (Cytoplasm), Average # Spot Stain A Medium (Cytoplasm), Average # Spot Stain A Small (Cytoplasm), Average # Spot Stain B Large (Cytoplasm), Average # Spot Stain B Medium (Cytoplasm), Average # Spot Stain B Small (Cytoplasm)
  - Average Area Spot Stain A Large (Cytoplasm), Average Area Spot Stain A Medium (Cytoplasm), Average Area Spot Stain A Small (Cytoplasm), Average Area Spot Stain B Large (Cytoplasm), Average Area Spot Stain B Medium (Cytoplasm), Average Area Spot Stain B Small (Cytoplasm)

**Nucleus Classification**

If classified by marker intensity:

- # Nucleus Low, # Nucleus Medium, # Nucleus High
- % Nucleus Low, % Nucleus Medium, % Nucleus High
- All Red Score, All Red Intensity Score, All Red Proportion Score (if All Red is activated in default exports)
- Histological Score Nuclei (1x %Small/Low+2x %Medium+3x %Large/High)
- Average <Nucleus Classification Channel> Intensity (Nucleus Positive)
- Average <Nucleus Classification Channel> Intensity (Nucleus)

If classified by area:

- # Nucleus Small, # Nucleus Medium, # Nucleus Large (if classified by area)
- % Nucleus Small, % Nucleus Medium, % Nucleus Large (if classified by area)
- Histological Score Nuclei (1x %Small/Low+2x %Medium+3x %Large/High)

If classified by colocalization:

- Number of coexpressed nuclei. For example:
  - # Nucleus Marker 1 and 2 and 3 coexpressed (if the layers for Markers 1, 2 and 3 are assigned in the classification)
  - # Nucleus Marker 1 and 2 coexpressed (if the layers for Markers 1 and 2 are assigned in the classification)
- Number of single markers. For example:
  - # Nucleus Marker 1 (only) (if the layer for Marker 1 is assigned in the classification)
  - # Nucleus Marker 2 (only) (if the layer for Marker 2 is assigned in the classification)
• # Nucleus Marker 3 (only) (if the layer for Marker 3 is assigned in the classification)
• # Nucleus without coexpression
• Average intensity for each marker channel inside the nucleus. For example:
  – Average <Marker 1 Channel> Intensity (Nucleus)
• Pearson and Manders coefficients

Cell Classification

• Average <Cell Classification Channel> Intensity (Membrane) (if action is Membrane & Cells)
• Average Membrane-Cytoplasm Contrast <Cell Classification Channel> (if action is Membrane & Cells)

If classified by marker intensity:

• # Cell Negative, # Cell Low, # Cell Medium, # Cell High
• % Cell Negative, % Cell Low, % Cell Medium, % Cell High
• Histological Score Cells (1x %Small/Low+2x %Medium+3x %Large/High)
• Average <Cell Classification Channel> Intensity (Cytoplasm)

If classified by area:

• # Cell Small, # Cell Medium, # Cell Large
• % Cell Small, % Cell Medium, % Cell Large
• Histological Score Cells (1x %Small/Low+2x %Medium+3x %Large/High)

If classified according to spots:

• # Cell Negative, # Cell Low, # Cell Medium, # Cell High
• % Cell Negative, % Cell Low, % Cell Medium, % Cell High

If classified by colocalization:

• Number of Colocalized Cells. For example:
  – # Cell Markers 1 and 2 and 3 coexpressed (if the layers for Markers 1, 2 and 3 are assigned in the classification)
  – # Cell Markers 1 and 2 coexpressed (if the layers for Markers 1 and 2 are assigned in the classification)
• Number of Single Markers. For example:
  – # Cell Marker 1 (only) (if the layer for Marker 1 is assigned in the classification)
  – # Cell Marker 2 (only) (if the layer for Marker 2 is assigned in the classification)
  – # Cell Marker 3 (only) (if the layer for Marker 3 is assigned in the classification)
• Manders and Pearson coefficients
• # Cell Without Coexpression
• Average intensity per compartment per Marker per Layer. For example, if Marker 1 and Marker 2 layers are assigned and the coexpression is measured in the cytoplasm:
  – Average <Marker 1 Channel> Intensity (Cytoplasm compartment per cell)
  – Average <Marker 2 Channel> Intensity (Cytoplasm compartment per cell)
Vessel Classification  If classified by size:
- % Vessel Small, % Vessel Medium, % Vessel Large
- # Vessel Small, # Vessel Medium, # Vessel Large

If classified by intensity:
- % Vessel None, % Vessel Low, % Vessel Medium, % Vessel High
- # Vessel None, # Vessel Low, # Vessel Medium, # Vessel High

Marker Area Detection  If classified by colocalization:
- Pearson and Manders Coefficients Marker Area
- Marker Area Overlap in IF. For example:
  - Average <Marker 1 Channel> Intensity (Markers 1 and 2 Overlap)
  - Average <Marker 2 Channel> Intensity (Markers 1 and 2 Overlap)
- Total Area of each marker

Position Information

If TMA:
- x core center position on slide (mm), y core center position on slide (mm)

If random sampling:
- x sample position on slide (mm), y sample position on slide (mm)
- x sample length (mm), y sample length (mm)
- Sample area (mm²)

10.4 Custom Export (Cellular Analysis)

10.4.1 Overview
- Portals: All
- Key functions: Export of customized features in addition to the standard export. These results can be exported per object and/or per domain, using an operation such as SUM or MEAN
- This action can be appended up to ten times.

10.4.2 Introduction

The Custom Export action allows you to export a range of statistics per object (for example, the mean stain intensity per cell) and object group (for instance mean stain intensity for all cells).

- You can access all classes of the Cellular Analysis actions in the drop-down menu. If you want to export results for more than one class, you have to append the action multiple times
10.5 Custom Export (Regions of Interest)

10.5.1 Overview

- Portals: All
- Key functions: Export of customized features of ROI objects in addition to the

Fig. 10.5. The Custom Export (Cellular Analysis) action

- When clicking on the Select Features button the Select Features dialog box opens. Here you can choose among several predefined features to be exported, such as Mean Stain, Area or Distance to Scene Border, or Position on Slide, or create your own customized arithmetic or relational feature(s) for export.

NOTE: For further information on how to create and apply customized features please address this topic during a training session or contact our support team at support@definiens.com.

The statistics are exported to the folder Statistics/Custom.

Files for summary project statistics are named “Custom<Number>_<ClassName>_<SummaryType>”, with “per_Core” for TMA workflows, and the appropriate suffix for the slide workflow.

Statistics of single objects are summarized in the folder CellularAnalysisObjects.report. The file names contain the class name and the number of the customized export that led to its creation. If Per Single Object is checked, then the data for all objects will be included.
standard export. These results can be exported per object, per domain or both, using an operation such as SUM or MEAN.

• This action can be appended up to eight times.

Figure 10.6. The Select Features dialog box

Figure 10.7. The Custom Export (Regions of Interest) action
10.5.2 Introduction

The Custom Export (Regions of Interest) action allows you to export a range of statistics per object (for example, the perimeter of ROI 1 objects) and object group (for instance the mean perimeter of all ROI 1 objects).

- You can access all relevant ROI classes in the drop-down menu. If you want to export results for more than one class, you have to append the action multiple times.
- When clicking on the Select Features button the Select Features dialog box opens. Here you can choose among several predefined features to be exported or create your own customized arithmetic or relational feature(s) for export.

NOTE: Your customized features for Custom Export (Regions of Interest) should not refer to subclasses generated during cellular analysis.

The statistics are exported to the folder Statistics/Custom.
Files for summary project statistics are named “Custom<Number>_<ROI Name>_<SummaryType>”, with “per_Core” for TMA workflow, and “per_Slide” for the slide workflow.
Statistics of single objects are summarized in the folder ROIDetectionObjects.report. The file names contain the class name and the number of the customized export that led to its creation.

10.6 About Calculations

10.6.1 All Red Score

The All Red score is the sum of the proportion score and the average intensity scores of positively stained nuclei. It ranges from 2–8, but is zero if there is no positive.

The intensity score is calculated as the average intensity over all positively stained nuclei. The resulting value gives a score of 1–3 depending on the user-defined thresholds. This score is zero if no positive nuclei are found. The intensity score ranges from 0–3.

The proportion score is based on the proliferation index (PI), with PI being the proportion of positive nuclei in the region of interest: \( PI = \frac{\# \text{ Positive Nuclei}}{\# \text{Nuclei}} \). The proportion score is calculated in the following way:
Expression Score

<table>
<thead>
<tr>
<th>Expression</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI = 0</td>
<td>0</td>
</tr>
<tr>
<td>0 &lt; PI &lt;= 0.01</td>
<td>1</td>
</tr>
<tr>
<td>0.01 &lt; PI &lt;= 0.1</td>
<td>2</td>
</tr>
<tr>
<td>0.1 &lt; PI &lt;= 1/3</td>
<td>3</td>
</tr>
<tr>
<td>1/3 &lt; PI &lt;= 2/3</td>
<td>4</td>
</tr>
<tr>
<td>PI &gt; 2/3</td>
<td>5</td>
</tr>
</tbody>
</table>

10.6.2 Average <name of layer> Intensity (<Class name>)

- **Nuclei**
  - The sum of the mean intensity of the layer (over all nuclei) / the number of nuclei
- **Cells**
  - The sum of the mean intensity of the layer (over all cells) / the number of cells
- **Cytoplasm**
  - The sum of the mean intensity of the layer (over all cytoplasm) / the number of cells with cytoplasm

10.6.3 Average <name of layer> Intensity (<marker>)

The sum over all the marker area objects of the product of the area and mean intensity of the layer / total marker area

10.6.4 Average Membrane Cytoplasm Contrast <name of IHC Marker Layer>

- The sum of the membrane contrast minus the sum of the cytoplasm contrast (over all cells) divided by the number of cells with cytoplasm
  - Membrane minus cytoplasm contrast is (Mean IHC Marker Intensity in the membrane – Mean IHC Marker Intensity in the cytoplasm) / (Mean IHC Marker Intensity in the membrane + Mean IHC Marker Intensity in the cytoplasm)

10.6.5 Histological Score

**Histological Score Cells**

- When cells are classified with respect to area:
  - 1x %Cells Small + 2x %Cells Medium + 3x %Cells Large
- When cells are classified with respect to intensity:
  - 1x %Cells Low + 2x %Cells Medium + 3x %Cells High
Histological Score Nuclei

- When nuclei are classified with respect to area:
  - \(1 \times \% \text{Nuclei Small} + 2 \times \% \text{Nuclei Medium} + 3 \times \% \text{Nuclei Large}\)

- When cells are classified with respect to intensity:
  - \(1 \times \% \text{Nuclei Low} + 2 \times \% \text{Nuclei Medium} + 3 \times \% \text{Nuclei High}\)

10.6.6 Positive Index

- \(# \text{Positive Nuclei} / \# \text{Nuclei}\)

10.6.7 Percental Score

- When marker areas are classified with respect to intensity:
  - \(1 \times \% \text{Marker Area Low} + 2 \times \% \text{Marker Area Medium} + 3 \times \% \text{Marker Area High}\)

10.6.8 Pearson’s and Mander’s Coefficients

The Mander’s and Pearson’s correlation coefficients in default exports measure the correlations of two channels in the classified object. For an object-based export of each cell or nucleus, select the appropriate feature in a customized export.

**Pearson’s Coefficient**

\[
 r_p = \frac{\langle I_1I_2 \rangle_{I_1(x,y)>T_1,I_2(x,y)>T_2} - \langle I_1 \rangle_{I_1(x,y)>T_1} \langle I_2 \rangle_{I_2(x,y)>T_2}}{\sqrt{\left(\langle I_1^2 \rangle_{I_1(x,y)>T_1} - \langle I_1 \rangle_{I_1(x,y)>T_1}^2\right)\left(\langle I_2^2 \rangle_{I_2(x,y)>T_2} - \langle I_2 \rangle_{I_2(x,y)>T_2}^2\right)}}
\]

**Mander’s Coefficient**

\[
 M_1 = \frac{\sum_{(x,y)} I_1(x,y) \text{ with } I_1(x,y)>T_1+I_2(x,y)>T_2}{\sum_{(x,y)>T_1} I_1(x,y)}
\]

\[
 M_1 = \frac{\sum_{(x,y)} I_2(x,y) \text{ with } I_1(x,y)>T_1+I_2(x,y)>T_2}{\sum_{(x,y)>T_2} I_2(x,y)}
\]
11 Object-Specific Features

This chapter contains explanations of geometric object-specific features.

11.1 Area

The number of pixels forming an image object. If unit information is available, the number of pixels can be converted into a measurement. In scenes that provide no unit information, the area of a single pixel is 1 and the area is simply the number of pixels that form it. If the image data provides unit information, the area can be multiplied using the appropriate factor.

11.2 Border Index

The Border Index feature describes how jagged an image object is; the more jagged, the higher its border index. This feature is similar to the Shape Index feature, but the Border Index feature uses a rectangular approximation instead of a square. The smallest rectangle enclosing the image object is created and the border index is calculated as the ratio between the border lengths of the image object and the smallest enclosing rectangle.

11.3 Circularity

11.3.1 Expression

\[
\text{Radius of Largest Enclosed Ellipse} \times 10 = \frac{\text{Border Length}}{\text{Area}^{0.5}}
\]

11.3.2 Parameters

Shape Index

The Shape index describes the smoothness of an image object border. The smoother the border of an image object is, the lower its shape index. It is calculated from the Border Length feature of the image object divided by four times the square root of its area.
Parameters

- $b_v$ is the image object border length
- $4\sqrt{\text{Area}_v}$ is the border of square with area $\text{Area}_v$

Expression

$$\frac{b_v}{4\sqrt{\text{Area}_v}}$$

![Diagram](image)

Figure 11.1. Shape index of an image object $v$

### 11.3.3 Radius of Largest Enclosed Ellipse

The Radius of Largest Enclosed Ellipse feature describes how similar an image object is to an ellipse. The calculation uses an ellipse with the same area as the object and based on the covariance matrix. This ellipse is scaled down until it is totally enclosed by the image object. The ratio of the radius of this largest enclosed ellipse to the radius of the original ellipse is returned as feature value.

Parameters

- $\varepsilon_v(x,y)$ is the elliptic distance at a pixel $(x,y)$

Expression

$$\varepsilon_v(x_0,y_0), \text{ where } (x_0,y_0) = \min \varepsilon_v(x,y), (x,y) \notin P_v$$

### 11.4 Circularity Ratio

The Circularity Ratio is another measure of the circularity of an object. A value equal to one is perfectly circular. Use this feature rather than creating a customized feature.

#### 11.4.1 Expression

$$\frac{\text{Perimeter}^2}{4\pi \times \text{Area}}$$
11.5 Compactness

The Compactness feature describes how compact an image object is. It is similar to Border Index, but is based on area. However, the more compact an image object is, the smaller its border appears. The compactness of an image object is the product of the length and the width, divided by the number of pixels.

11.6 Density

The Density feature describes the distribution in space of the pixels of an image object. In Definiens software, the most “dense” shape is a square; the more an object is shaped like a filament, the lower its density. The density is calculated by the number of pixels forming the image object divided by its approximated radius, based on the covariance matrix.

11.7 Elliptic Fit

The Elliptic Fit feature describes how well an image object fits into an ellipse of similar size and proportions. While 0 indicates no fit, 1 indicates a perfect fit.

The calculation is based on an ellipse with the same area as the selected image object. The proportions of the ellipse are equal to the length to the width of the image object. The area of the image object outside the ellipse is compared with the area inside the ellipse that is not filled by the image object.

11.8 Ellipticity

11.8.1 Expression

\[
\frac{\text{Radius of Largest Enclosed Ellipse}}{\text{Radius of Smallest Enclosed Ellipse}}
\]
11.8.3 Radius of Largest Enclosed Ellipse

The Radius of Largest Enclosed Ellipse feature describes how similar an image object is to an ellipse. The calculation uses an ellipse with the same area as the object and based on the covariance matrix. This ellipse is scaled down until it is totally enclosed by the image object. The ratio of the radius of this largest enclosed ellipse to the radius of the original ellipse is returned as feature value.

Parameters

- $\varepsilon_v(x,y)$ is the elliptic distance at a pixel $(x,y)$

Expression

$\varepsilon_v(x_0, y_0)$, where $(x_0, y_0) = \min_{(x,y) \in P_v} \varepsilon_v(x,y)$, $(x,y) \notin P_v$

![Figure 11.3. Radius of the largest enclosed ellipse of in image object $v$, for a 2D image object](image)

11.8.4 Radius of Smallest Enclosing Ellipse

The Radius of Smallest Enclosing Ellipse feature describes how much the shape of an image object is similar to an ellipse.

The calculation is based on an ellipse with the same area as the image object and based on the covariance matrix. This ellipse is enlarged until it encloses the image object in total. The ratio of the radius of this smallest enclosing ellipse to the radius of the original ellipse is returned as feature value.

Parameters

- $\varepsilon_v(x,y)$ is the elliptic distance at a pixel $(x,y)$

Expression

$\varepsilon_v(x_0, y_0)$, where $(x_0, y_0) = \max_{(x,y) \in P_v} \varepsilon_v(x,y)$, $(x,y) \notin P_v$
11.9 **Length**

Length of an object.

11.10 **Length/Width**

The length-to-width ratio of the main line of an object.

11.11 **Number of Pixels**

The number of pixels forming an image object. Unit information is not taken into account.

11.12 **Perimeter**

The sum of the lengths of all the edges of a polygon.

This polygon has the same granularity as the pixel grid of the image. For example, for a 20x image analyzed in 10x, the perimeter calculated for export is 10x. If you were to stitch results together, or if your image is small, then objects will be synchronized back to the 20x image and the perimeter value calculated in Normal mode will differ from the ones in the DRC – this is to be expected because the polygon describing the object in the higher magnification is different to the one in the lower magnification.

11.13 **Rel. Border to Image Border**

The feature Rel. Border To Image Border determines the relative border length an object shares with the image border. It describes the ratio of the shared border length of an image object (with a neighboring image object assigned to a defined class) to the total border length. If the relative border of an image object to image objects of a certain class is 1, the image object is totally embedded in them.
If the relative border is 0.5 then the image object is surrounded by half of its border. The relative border length can only be expressed in pixels.

### 11.14 Roundness

The Roundness feature describes how similar an image object is to an ellipse. It is calculated by the difference of the enclosing ellipse and the enclosed ellipse. The radius of the largest enclosed ellipse is subtracted from the radius of the smallest enclosing ellipse.

### 11.15 Shape Index

The Shape Index describes the smoothness of an image object border. The smoother the border of an image object is, the lower its shape index. It is calculated from the Border Length feature of the image object divided by four times the square root of its area.

### 11.16 Width

The width of an image object is calculated using the length-to-width ratio.
12 Running Image Analysis in Batch Mode

After you have configured a solution, you can start processing your image data to generate image analysis results by activating the Run Workflow tab.

12.1 Analyze

You have two options for processing your data:

• Run the loaded solution over a selection of images by choosing a folder or several images in the workspace then pressing the Analyze Selected Images button
• Run the loaded solution on the whole workspace by pressing the Analyze All Images button

To run a previously saved solution, you must first load it into the Analysis Builder window.

12.2 Cancel

You can cancel the current analysis at any time with the Cancel Processing button.

12.3 Reset

Press the Reset Workspace button to reset all images to their original state and delete all created results data and solutions in the workspace folder.

12.4 View Processed Projects

You can view and compare the results among processed projects already during batch processing.

1. Go to the right-hand pane of the workspace window
2. The state of the projects you want to compare must display ‘processed’. The Time column shows the processing time for each project. Exported numerical values are listed in their respective columns. The Remarks column denotes processing information or error messages.

3. You can limit the data displayed by clicking the Filters button at the bottom of the right-hand pane.

4. By default, exported numerical result values are saved as comma-separated values (extension .csv) into a results folder in the same directory as the workspace .dpj file. You can open .csv files with a spreadsheet such as Microsoft Excel.

12.5 Storage

We recommend saving images, solutions and workspace files in separate directories. In most cases the images are located on a separate server and can be accessed directly from there. Solutions and Workspaces should be stored under the respective default paths on the same workstation as the Definiens Tissue Studio® software as described earlier in this chapter (see Load Images (p 22)).

12.6 External Engines

If you want to use any additional engines on an external grid for batch processing, the workspace has to be made accessible, for instance by storing it on the same server as the images, although in a different directory. The solutions can remain on the local workstation.
13 Performance

How long a workspace analysis will take, and how much hard disk space it will consume, will depend on your images, hardware and the type of analysis you perform. However, this section will give you some general guidelines and provide tips for optimizing performance.

13.1 Images

Processing times will obviously depend on image size and the amount of tissue on a slide. In addition, the nature of the tissue on a given image – for example, one with densely packed nuclei – will affect algorithm processing times.

Therefore you can expect processing times to increase with the number of objects, but you should not necessarily assume a linear relationship.

13.2 Solution

13.2.1 ROI Detection

Tissue-background separation and actions that rely on manual annotations usually take a negligible amount of processing time compared with cellular analysis.

The most time-consuming ROI detection is the Composer, especially with high-resolution images. Therefore, we strongly recommend testing, when you configure Tissue Studio, whether increasing the Composer resolution really has a beneficial effect on the classification quality; in our experience, low resolutions may even give better results, especially if images are markedly different.

Each additional Composer action will prolong the analysis; the exact time depends on the settings but, as a rule of thumb, these actions typically take about one-third of the time of the Composer training actions.

Example

A sample tissue slide analyzed using an Intel® Xeon® CPU X5690 3.47GHz system with tissue-background separation followed by a Composer analysis (initialization and initial
training) at different resolutions. In this test, the tissue area was 2.4 cm² at a resolution of 0.23 µm/px (40x).

<table>
<thead>
<tr>
<th>Composer magnification</th>
<th>Processing time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1x</td>
<td>1 min</td>
</tr>
<tr>
<td>2x</td>
<td>2 min</td>
</tr>
<tr>
<td>3x</td>
<td>5 min</td>
</tr>
<tr>
<td>4x</td>
<td>8 min</td>
</tr>
<tr>
<td>6x</td>
<td>21 min</td>
</tr>
<tr>
<td>8x</td>
<td>46 min</td>
</tr>
<tr>
<td>10x</td>
<td>98 min</td>
</tr>
</tbody>
</table>

13.2.2 Cellular Analysis

The time and hard disk requirements of the cellular analysis depend on the actions performed, and the size and resolution of the image.

Cellular analysis can become very slow if you use a composer that creates many ROI objects while using the “process regions individually” setting in the General Settings action. This setting causes Tissue Studio to create an individual subset for each ROI object, leading to an enormous processing overhead. Note that processing time and hard disk space are also affected by the number of different ROIs you analyze.

For example, you might expect that cellular analysis takes the same amount of time irrespective of whether you divide the tissue in two or eight distinct ROIs, but in reality the analysis may take four times as long (and occupy more disk space).

To optimize hard-disk space, we recommend using the production mode whenever you have no need to access the processed projects and to only export screenshots that you really need for quality control.
14 Reviewing Results

When you go to the Review Workflow tab, the Heat Map display will be open by default. In the Display dropdown list you can choose the exported result you want to display. You can either display all projects or all tiles of a given project. The Heat Map view can be manually exported with the Export button in the lower left-hand corner. Furthermore, you can adjust the lower and upper thresholds for the heat map color code.

Click on the Open Results folder button to open the results folder that was created in the workspace folder during the analysis. You will find raster files, with screenshots of the segmentation and classification results, and .csv files comprising the exported statistics.

14.1 Open a Project and View the Classification

Open a project by double-clicking on it to view the classification of image objects.

Use the buttons in the Display toolbar (p 10) to investigate the analysis result visually. The Legend window displays all classes of the currently displayed map and their respective colors (View > Legend).

![Legend window listing available classes](image)

The button not only allows you to view several images at a time, but also shows the original image data with the classification result side-by-side or in swipe view.

14.2 The Review Heat Map

The Review Heat Map provides a standard heat-map function. A DRC container is necessary for it to display – these are generated automatically in Tissue Studio (but must be specified in Developer XD).
Results are only visible in the Review Heat Map if corresponding levels of existing classes contain features; if not the Review Heat Map is grayed out.

- By default, the Thumbnails view is selected and displays a single image – all options are inactive. When the DRC is active, you can select the following options:
  - Level
  - Classes
  - Feature
  - Statistical Features (choose from Min, Max, Mean, Median, Count, Sum, Std-Dev, 1st Quartile or 3rd Quartile)

Alternatively you can select the name of the result container from the same drop-down box.

- The drop-down box below lets you change the size of the tile grid – small, medium or large squares
- There are two export options, which let you to save heat-map images to a variety of raster formats:
  - The Export button lets you save the currently selected image
  - The Bulk Export button launches the Bulk Export dialog – this lets you save all the images in your workspace:
    * Designate a specified folder defined in the Folder Path field
    * The Image Size drop-down list lets you define their size – small (512 px), medium (1024 px) or large (2048 px)
    * The Mode Min/Max drop-down lets you use the Heat Map color ranges you have defined (Current) or minimum and maximum values calculated
over all projects (Global)

- The text field at the bottom-left displays the project name. It will also display the status of any calculations you perform.
- Use the blue up/down arrows to navigate between workspace projects.
- Use the Expression button below to create your own calculations.
- Move the slider on the right-hand side to adjust thumbnail transparency.
- The Auto checkbox is active by default and the maximum and minimum values for the Heat Map are calculated automatically. To change the range of values for the Heat Map, uncheck this box and adjust the values for minimum or maximum at either side of the scale. Select another result and the Heat Map will update automatically.

**14.2.1 Creating a Custom Feature**

It is also possible to create your own feature calculations for visualization in the Review Heat Map.

Press the Expression button to launch the Feature Expressions dialog, which manages all your custom calculations. Pressing Add launches the Feature Expression Editor dialog (see figure 14.3).

Assign a name to your expression in the Expression Name field. To create your expression, double-click on features in the Features pane to move them to the Expression pane.

Use the calculator keys to insert arithmetic expressions and mathematical functions. You can switch between degrees (Deg) and radians (Rad), as well as inverting the expression with the Inv feature. Use the Test button to test the syntax of your expression.

By default, all features relevant to your selected Level will be available. Selecting the Show All Features in Result Container checkbox will display all available features in the container.

To edit an expression, select it in the Feature Expressions dialog and press the Edit button. Likewise you can duplicate and remove expressions from the list with the Copy and Delete buttons.

Any expression you create will be available in other workspaces in the Feature drop-down list when it is relevant. If it is not relevant, it will still be listed in the Feature Expressions dialog.

**14.2.2 Opening Solutions From Previous Versions**

If you open a solution from a previous Tissue Studio version without upgrading, you will see the old Heat Map – this is a deprecated feature but is still included for legacy workspaces; it is available in View > Heat Map. Upgrading the solution displays the Review Heat Map.

The legacy Heat Map will only work with projects prior to version 4.0.

---

1. The Global option utilizes your designated temp folder to temporarily store images, avoiding unnecessary processor cycles. Depending on the number of projects, the image resolution and the tile size, this could require a significant amount of disk space.
14.3 View the Results Folder

During the analysis a results folder will be created inside the workspace folder. If you click on the Open Results Folder button in the workflow bar, a windows explorer will open that displays this folder.

- You can ignore all results in the Internal folder as they contain only data that needed to be stored temporarily during the analysis
- The Statistics folder contains .csv files that were created during default export and customized exports
- The Screenshots folder harbors the screenshots exported after ROI detection and after the cellular analysis.
Figure 14.4. Heat Map window displaying tiles

Figure 14.5. Example of a results folder coming from a slide analysis
15 DRC Exports

*DRC files* (p 24) contain export information per segmented object. There are two ways to visualize DRC exports:

1. Opening the workspace in Definiens Image Miner
2. Reviewing the image in Whole Slide Review mode in Tissue Studio. When an object is clicked in the image, its corresponding DRC-exported features are displayed in the Image Object Information pane.

15.1 DRC Exports for ROI Objects

15.1.1 Tissue Portal (Brightfield)

- Area
- Hematoxylin Intensity (for workflows without a flexible chromogen stain combination)
- Counter Stain Intensity (for workflows with a flexible chromogen stain combination)
- <Stain A Layer> Intensity
- Optical Density (for workflows with a single IHC stain combination)
- <Stain B Layer> Intensity (only for dual IHC workflows)
- Mean Layer 1
- Mean Layer 2
- Mean Layer 3
- Features selected in ROI custom exports
  - The custom exports are only available for the classes selected in the Custom ROI action
- Summary statistics
  - These are written in the DRC file only when the user checks the option “Statistics per ROI Object” in the Default Export action
  - These are written with the prefix “Summary_statistics”
  - These are the same statistics exported into “CellularAnalysis_DefaultExport_perROI”. The statistics depend on the action combination. The summary statistics of each action appear in the Default Exports of each action definition
- Position on Slide x(mm), Position on Slide y(mm)
  - These are written in the DRC file only when the user checks the option “Statistics per ROI Object” in the Default Export action
These have the same value as the one shown in the “CellularAnalysis_DefaultExport_perROI.csv” file.

15.1.2 TMA Portal (Brightfield)

- Area
- Hematoxylin Intensity (for workflows without a flexible chromogen stain combination)
- Counter Stain Intensity (for workflows with a flexible chromogen stain combination)
- <Stain A Layer> Intensity
- Optical Density (for workflows with a single IHC stain combination)
- <Stain B Layer> Intensity (only for dual IHC workflows)
- Mean Layer 1
- Mean Layer 2
- Mean Layer 3
- Features selected in ROI custom exports
  - The custom exports are only available for the classes selected in the Custom ROI action.

15.1.3 Tissue Portal (IF)

- Area
- Mean of available layers
- Features selected in ROI custom exports
  - The custom exports are only available for the classes selected in the Custom ROI action
- Summary statistics
  - These are written in the DRC file only when the user checks the option “Statistics per ROI Object” in the Default Export action.
  - These are written with the prefix “Summary_statistics”
  - These are the same statistics exported into “CellularAnalysis_DefaultExport_perROI”. The statistics depend on the action combination. The summary statistics of each action appear in the Default Exports of each action definition
- Position on Slide x(mm), Position on Slide y(mm)
  - These are written in the DRC file only when the user checks the option “Statistics per ROI Object” in the Default Export action
  - These have the same value as the one shown in the “CellularAnalysis_DefaultExport_perROI” file.

15.1.4 TMA Portal (IF)

- Area
- Mean of available layers
- Features selected in ROI custom exports
  - The custom exports are only available for the classes selected in the Custom ROI action.
15.2 DRC Exports for Cellular Analysis Objects

15.2.1 Tissue Portal (Brightfield)

- Area
- Hematoxylin Intensity (for workflows without a flexible chromogen stain combination)
- Counter Stain Intensity (for workflows with a flexible chromogen stain combination)
- <Stain A Layer> Intensity
- Optical Density (for workflows with a single IHC stain combination)
- <Stain B Layer> Intensity (only for dual IHC workflows)
- Mean Layer 1
- Mean Layer 2
- Mean Layer 3
- Features selected in Cellular Analysis custom exports
  - The custom exports are only available for the classes selected in the Custom Cellular Analysis action
- Additional features needed to create the statistics – these depend on the actions present in the solution.

15.2.2 TMA Portal (Brightfield)

- Area
- Hematoxylin Intensity (for workflows without a flexible chromogen stain combination)
- Counter Stain Intensity (for workflows with a flexible chromogen stain combination)
- <Stain A Layer> Intensity
- Optical Density (for workflows with a single IHC stain combination)
- <Stain B Layer> Intensity (only for dual IHC workflows)
- Mean Layer 1
- Mean Layer 2
- Mean Layer 3
- Features selected in Cellular Analysis custom exports
  - The custom exports are only available for the classes selected in the Custom Cellular Analysis action
- Additional features needed to create the statistics – these depend on the actions present in the solution.

15.2.3 Tissue Portal (IF)

- Area
- Mean of available layers
- Features selected in Cellular Analysis custom exports
  - The custom exports are only available for the classes selected in the Custom Cellular Analysis action
- Additional features needed to create the statistics – these depend on the actions present in the solution.
15.2.4 TMA Portal (IF)

- Area
- Mean of available layers
- Features selected in Cellular Analysis custom exports
  - The custom exports are only available for the classes selected in the Custom Cellular Analysis action
- Additional features needed to create the statistics – these depend on the actions present in the solution.
16 The Whole Slide Review Viewer

16.1 Introduction

The Whole Slide Review (WSR) Viewer lets you view Tissue Studio workspaces¹ with a restricted set of functions. This has the advantage of faster access and navigation, as well as providing additional desktop viewing options. When a workspace is open, you can switch between this review mode and the standard view at any time when the Load and Review tabs are active; it is not available in the Configure and Run tabs.

To enable or disable review mode, go to the bottom-right of the taskbar and select the checkbox (see figure 16.1).

![Figure 16.1. Taskbar buttons for standard and review modes](image)

16.2 Navigation and Context Menu Options

Review mode lets you drag an image in the image pane by holding down the mouse – in addition you can zoom in and out with the mouse wheel. Right-clicking on the menu displays the following context options:

- **Overview** – a small image of the whole slide at the top-right of the pane
- **Zoom Indicator** – the current magnification based on metadata, at the top-right of the pane
- **Magnifier** – an enlarged view based on the current position of the mouse pointer, at the bottom-right
- **Scale Bar** – at the top-left

¹ Processed images in multimaps containing training datasets are not supported
• **Legend** – displays classifications for the currently active level. This is displayed by default
• **Copy to Clipboard** – copies the image only.

A Workspace view with all elements is shown in **figure 16.2** on this page.

![Figure 16.2. Whole Slide Review Viewer with Image Object Information window visible](image)

### 16.3 Characteristics of WSR View

- In WSR view, classification outlines are black
- It is not possible to change the window layout in review mode
- When you zoom in and out using the mouse wheel, the enlargement (or reduction) will center around the area around the mouse pointer.
- The following buttons on the horizontal toolbar are not available:
  - Zoom
  - Show Previous/Next Image Layer buttons
  - Navigate Maps buttons

### 16.3.1 Switching Between Levels

If two projects have been processed with the same rule set, the same level will be displayed when you switch between them.

If different rule sets were used and contain but a corresponding level names is the same, this level will be displayed; otherwise the first level will be shown.
16.3.2 Image Layer Mixing

Most features of the Edit Image Layer Mixing (p 16) dialog are available in review mode. The exceptions are:

- No Equalization mode is available for 8-bit images only
- Predefined layer mixing is not supported
- Layer weights are not supported

16.3.3 Viewing Sub-Projects

In projects that contain sub-projects in review mode, the bounding box will be visible in the viewer when the corresponding selection – such as a project, heat map thumbnail or TMA grid – is selected (see figure 16.3).
17 The Tissue Studio Registration Portal

The Tissue Studio Registration portal lets you import tissue blocks, and carry out ROI detection and annotation across the entire block, rather than annotating multiple stains individually.

The workflow uses the following steps, which are described in this chapter:

- Select the Tissue Studio Registration portal upon launching the client
- Import tissue blocks using the Block Import feature
- Perform any annotation steps and ROI detection (p 51) in the Analysis Builder. Training Data Sets (p 23) are also supported.
- Include the ROI Transfer action to migrate the annotations
- Run the analysis – you can then open the whole workspace in Tissue Studio, or open individual stains using Result Containers.

17.1 Block Import

The Block Import feature (Import Block in the Load tab) launches a wizard that lets you import blocks – multiple stains per patient from the same tissue block – contained in folders. (Import Files and Import Folders are not available in this portal.)

- The first dialog lets you add and remove multiple folders for import
- You are then given the option to select the scanner type from a drop-down list
- Finally there are options to create a new workspace or add the files to an existing one. Here you can also change the workspace name and the file location

When you press Finish, the New Workspace dialog appears, which lists the image paths, project names and stains in sortable columns (see figure 17.1).

- Double-click on Project Name fields to edit them
- Double-click on Stain fields to activate a drop-down box, where you can pick from predefined stains
  - Available stains are HE, ER, PR, Ki67, Her2, CD3, CD8, CD31, CD45 and p63. If you need to add additional stains, please contact Definiens Support
- Entering the name of a project or stain in the field at the bottom of the dialog will reassign projects (using Set as Project) or stains (using Set as Stains) to their pre-assigned values
Use the Reset Projects and Reset Stains buttons to clear all project and stain names.

- Activate the Show New Items checkbox to only display images added to the workspace (existing images are displayed in green).
- Activate the Show Existing Items checkbox to display only existing images.
- Use Add Row to add an additional image to the import.
- Use Delete Row to delete images from the list (multiple selections are supported).
- Master Stain defines which stain you will annotate or apply ROI detection activities – these actions will be applied to the other stains when you run the analysis. You can create a training set from master stain maps of different projects, to configure ROI detection actions.

When you press Import, the images will be organized by project in the Workspace, and you can switch between stains using the Image Layer buttons in the toolbar (if there are more than four slides). You can also view slides in Whole Slide Review (p 173) mode.

17.2 The Analysis Builder

In Registration mode, a small subset of actions is available in the Analysis Builder.

17.2.1 General Settings

As well as the standard Image Information fields in General Settings, the following stain combinations are available under Staining Information:

- IHC Brown Chromogen (e.g. DAB)
- IHC Red Chromogen (e.g. AEC or Fast Red)
- HE
- Other Stains (Composer only)
- IHC Single Stain (flexible chromogen)
- IHC Dual Stain (flexible chromogen)
17.2.2 ROI Actions

Although we expect this function will mainly be used for the Manual ROI Selection actions (p 67), it is possible to use any ROI Detection action. Training Data Sets (p 23) are also supported.

17.2.3 ROI Transfer

The ROI Transfer action is only available in this portal. Ensure this action is in your analysis, so ROIs are exported.

17.3 Opening Your Registered Slides

There are three options after processing in Tissue Studio Registration:

1. Open the Workspace as normal in Tissue Studio
2. Open the Workspace in Whole Slide Review (p 173) mode
3. Open individual slides in the workspace using File > Import Scenes from Result Containers – you will need to navigate to the Results folder within the workspace to locate the relevant folder. For more information on result containers, see Loading and Managing Data (p 24).

Although Tissue Studio Registration co-registers the slides and highlights corresponding regions of interest, the stains are not re-orientated in the client (see figure 17.2).

Figure 17.2. Annotation applied to master stain (HE, left), transferred to the corresponding region of a second stain (p63, right)
18 Managing the Server Environment

Installing Definiens Tissue Studio® also installs a number of internal servers that are available for batch processing (the numbers depend on the software bundle you purchased). An organizational unit, the Job Scheduler communicates between the workspace and the processors that do the analysis. In addition, to enhance the loading and viewing of projects, you can make use of the Image Proxy Server.

18.1 Manage Local Servers

![Manage Local Servers dialog box]

Open the Manage Local Servers dialog box under File in the main menu to do one of the following:
• Start, Stop or Restart the Job Scheduler (for instance to abort an analysis)
• Change the Startup type to manual (not recommended)
• Enable local Definiens Life Servers and select the number of engines to be used for
  batch processing
• Restart the engines after a given period
• Define whether you want to use the Image Proxy Server (by default the checkbox
  is activated; for some image formats it might be better to un-check the box)
• Change the IPS location of the Image Proxy Server (not recommended).

18.2 Select Job Scheduler

The Configure Analysis context menu option opens the Select Job Scheduler dialog. By
default it is set to http://localhost:8185, thereby referring the batch analysis to the
locally installed job scheduler. In case you have more engines installed on another server
grid you can send the analysis via port 8184 to the cluster http://yourserver:8184.

18.3 View Analysis in Internet Explorer

To check the status of your analysis, you can open the job scheduler in a browser window.
Here you can cancel any jobs at any time or have a closer look at the current analysis
status. Furthermore, it gives you information about the two engines and their usage over
the last 24 hours.

![Job Scheduler opened in an Internet Explorer window](image)

Figure 18.2. Job Scheduler opened in an Internet Explorer window
19 Aperio Integration

This utility allows Definiens software to be registered by the Aperio eSlide Manager database as the image analysis provider. It provides functions for creating Definiens workspaces directly from the Aperio web interface.\(^1\) Registration is carried out automatically by the program setup.

19.1 Database Access

User access to the database follows the permissions set by Aperio database administrators. Users are able to perform the following tasks:

- Log in with an encrypted password\(^2\)
- Choose the type of database connection
- Enter database-specific connection strings.

19.2 Installing the Import Utility

The Definiens Spectrum Import Utility is available from the downloads area of the Definiens website.\(^3\)

19.3 Creating a Definiens Workspace from the Aperio Database

You can launch a Definiens client directly from an Aperio database if you follow these simple steps:

1. Connect to the Aperio database
2. In your web browser,\(^4\) select the Aperio image files in the database that you wish to open in a Definiens product by selecting their checkboxes

---

1. Several users have reported problems with eSlide Manager and IE 11. Therefore we recommend Mozilla Firefox as an alternative.
2. Authentication is via base-64 encoding. This is secure over a local area network (LAN), but not through an internet (WLAN) connection. If security is an issue, we recommend using wired connections only
4. Only the 64-bit version of Internet Explorer supports this function.
3. Click Analyze (figure 19.1), select the analysis type (figure 19.2) in the Select Analysis Macro field and click the Analyze button.

4. In the dialog, select Open to open the created file with the Definiens Import Utility (figure 19.3), specify the name and location of the workspace (.dpj file) and select the Definiens product to launch.
   • Selecting Use Direct File Paths prevents annotations and statistical data being written back to the Aperio database.

5. Pressing Import will create the new workspace and projects, and launch the Definiens client.

---

**Figure 19.1. Select image files and press Analyze**

Working with the open workspace requires an active database connection.

Database connections can be managed by going to File > Connection Manager to display the Connections dialog box (figure 19.4).

Press New to configure a new connection, or Edit to amend an existing one; either step will display the Edit Connection dialog:

1. Enter a name for the new connection
2. Choose Aperio (Launch from Spectrum) as template
3. Enter your login and password details

---

5. If the Definiens Analysis is not available in the drop-down menu, you may need to lower your browser’s security settings to allow the display of Active-X controls.

---

05 November 2015  User Guide
**Figure 19.2.** Select the type of analysis to perform

**Figure 19.3.** The Definiens Import Utility
4. In the parameters field, enter the IP addresses of the Aperio Webserver. If the Aperio database is running on a specified domain, this domain must be specified in the server parameters.

19.4 About Annotation Import

While Definiens software will import Aperio annotations, please ensure your polygons are closed. Imported polygons and polylines (polygons that are not fully closed) will be treated in the following way:

- Closed polygons will be imported normally
- If the gap between the start and endpoint of a polyline is less than 0.05% of the length of the line, the line will be closed automatically
- If the gap is more than 0.05%, the annotation will be treated as a line.

19.5 Working with Aperio Annotations

Tissue Studio can import and export annotations to an Aperio database. An image imported from an Aperio database with annotations is shown in figure 19.6 on page 188. Importing an Aperio image into Tissue Studio will also bring in the image layer containing Aperio annotations.
19.5.1 Linking Aperio Annotations to Definiens’ Regions of Interest

Use the Link button to link your Aperio annotation layers to Tissue Studio ROIs. This button is only visible for two ROI actions: Manual ROI Selection (Draw Polygons) and Preselect Region for ROI Detection. If you load an Aperio file without any annotation layers, the button will not appear.

Clicking the Link button will launch the Aperio Annotation Link Manager (see figure 19.6). With the Link By Name tab active, choose an Aperio annotation from the drop-down list, then the corresponding Definiens ROI you wish to link it with. When you press OK, the Definiens ROIs will inherit the Aperio names and colors (see figure 19.5). You may wish to rename these layers in Tissue Studio.

Aperio layers can only be linked by name if they do not have the default layer names – therefore they must be renamed in ScanScope.

The second option is the Link By Position tab – this lets you link ROIs based on the the hierarchy of the annotations as defined in the Aperio database.

---

6. As with many Tissue Studio functions, it may be necessary to first define the magnification and resolution in General Settings.
Please note that Tissue Studio does not recognize overlapping objects – when two objects overlap, preference is given to the object that is higher in the order of priority in the Link Manager. In the Aperio database, however, the overlapping properties are still recognized.

If the checkbox Modify 3rd Party Annotations is checked you may, of course, use all the Tissue Studio options to draw and edit polygons listed in The ROI Detection Actions (p 51). On clicking Confirm, your modified annotations will be written to the database and appear as additional layers ROI1_Definiens, . . ., ROI8_Definiens. If Aperio images with annotations are loaded from the file system, the modified annotations will only be stored in the workspace folder and the original Aperio annotation layers are left unchanged.

19.5.2 Disabling Writing to Aperio

Select the No Spectrum Annot Writing checkbox to disable writing back to the Aperio Spectrum database.
19.5.3 Tissue Studio Export to Aperio Spectrum

Tissue Studio’s default exports for slides will be exported not only to the result folder, but also to the Aperio Spectrum Database. Each result file corresponds thereby to a distinct annotation layer.

19.5.4 The Annotation XML File

Annotation data is saved in an XML file in the project folder. Tissue Studio annotations are stored as shape files in the project folder if Aperio annotations are modified.

By default, Scanscope will create an Aperio annotation XML file with the same name as the image file – this file must be in the same folder as the image file to be visible to Tissue Studio.

19.5.5 Polygon Import

While Definiens software will import Aperio annotations, please ensure your polygons are closed. Imported polygons and polylines (polygons that are not fully closed) will be treated in the following way:

- Closed polygons will be imported normally
- If the gap between the start and endpoint of a polyline is less than 0.05% of the length of the line, the line will be closed automatically
- If the gap is more than 0.05%, the annotation will be treated as a line.
20 Metadata

The following connectors and drivers support additional user metadata, which must be present in a user-created file called Metadata.csv. The location and content of this file differs between formats, as listed in this chapter.

You may add any metadata columns you like – in general, the only stipulation is that the image filenames should be in the first column with a header called ‘Image’.

Metadata import is designed to work with predefined imports – simple image loading will in many cases not import the corresponding metadata.

20.1 One Scene Per File

For this group, Metadata.csv must be in the same folder as the individual image files. The name of the file must be in a column called ‘Image’ and must match the image filename but omit the file extension.

<table>
<thead>
<tr>
<th>Connector / Driver</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze AVW</td>
<td>.avw</td>
</tr>
<tr>
<td>Analyze 7.5</td>
<td>.img</td>
</tr>
<tr>
<td>Aperio</td>
<td>.svs</td>
</tr>
<tr>
<td>Generic one file per scene</td>
<td>-</td>
</tr>
<tr>
<td>Hamamatsu</td>
<td>.ndpi</td>
</tr>
<tr>
<td>Olympus</td>
<td>.ets</td>
</tr>
<tr>
<td>Tissue Gnostics (individual regions)</td>
<td>.tgnf</td>
</tr>
<tr>
<td>UNIC</td>
<td>.tmap</td>
</tr>
<tr>
<td>Zeiss ZVI</td>
<td>.zvi</td>
</tr>
</tbody>
</table>
20.1.1 Notes

1. For Olympus, Metadata.csv must be on the same level as the .vsi file, which allows one metadata file for multiple files

20.2 Multi-Image Files

For this group, Metadata.csv must be in the same folder as the individual image files. The name of the file must be in a column called ‘Image’ and must match the image filename but omit the file extension.

All images belonging to the same file will have the same metadata.

<table>
<thead>
<tr>
<th>Connector / Driver</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ariol</td>
<td>.xml</td>
</tr>
<tr>
<td>Leica</td>
<td>.lif</td>
</tr>
<tr>
<td>Leica SCN 400</td>
<td>.scn</td>
</tr>
<tr>
<td>Tissue Gnostics (all regions per slide)</td>
<td>.tgnf</td>
</tr>
</tbody>
</table>

20.2.1 Notes

1. For Ariol, Metadata.csv must be on the same level as the Ariol Export.xml file. The image column must contain the XD scene name (from the workspace window)
2. For Tissue Gnostics, Metadata.csv must be in the same folder as the .xml file; the ‘image’ column must contain the name of this file

20.3 One Scene Per Folder / Multi-File Images

For this group, Metadata.csv must be in the same folder as the image root folder. The name of the file must be in a column called ‘Image’ and must match the image filename but omit the file extension.

<table>
<thead>
<tr>
<th>Connector / Driver</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze VOL</td>
<td>.vol</td>
</tr>
<tr>
<td>Bacus</td>
<td>.ini</td>
</tr>
<tr>
<td>Generic one scene per folder</td>
<td>-</td>
</tr>
<tr>
<td>Mirax</td>
<td>.ini</td>
</tr>
</tbody>
</table>
20.3.1 Notes

1. A second type of Analyze VOL format contains a file acting as a wrapper with a filename ending in `_vol`. These files organize lists of 2D files for use in 3D applications. In this case, Metadata.csv should be in the same place has this file and the ‘Image’ column must contain the corresponding filename without the `_vol`. 
21 Audit Trail Report

21.1 Introduction

The Audit Trail Report is a standalone application that runs alongside Definiens Tissue Studio® and Definiens Developer XD. Authorized users can use the application to generate audit trails, to support good laboratory practice (GLP) guidelines.

System access is managed by the Windows system login, which ensures it is only available to authorized users.

The application generates a report based on internal data saved within Definiens workspaces.

21.2 The Audit Trail Report dialog box

The Audit Trail Report application is a standalone application that must be copied to the bin folder of the client program. For example, if you followed the default installation of Definiens Developer, you must copy the AuditTrailReport.exe file to C:/Program Files/Definiens Tissue Studio® 4.2/bin.

For convenience, we recommend you create a shortcut on your desktop or taskbar. Opening the application displays the Audit Trail Report dialog box (figure 21.1).

Audit trails are generated from Definiens Workspace (.dpj) files. You can either directly enter a file path or navigate to one by clicking on the ellipsis. Reports are generated as html files: pressing Save lets you save the report to your machine, while pressing Display will open the report in your default web browser.
21.3 The HTML Report

A sample report is shown in figure 21.2 on this page.

![HTML report generated by the Audit Trail Report function](image)

21.3.1 Fields

Information is listed by project and the following fields are displayed:

- **ID** – the ID field is a unique identifier within the workspace, which is not visible in the client
- **Version**
- **Status**
- **Operation**
- **User** – the name of the user logged into Windows

1. A new version will be created on every operation on the workspace

05 November 2015  User Guide
21.3.2 User Modifications

The second row displays information when a user performs the following actions:

- Changing a project name
- Adding or removing layers
- Using a rule set
- Server-side version used for processing

21.3.3 The Roll Back All function

When a user reverts the workspace back using the Roll Back All function with ‘destroy the history’, a new version is created and ‘Roll Back’ is displayed in the Operation field (see figure 21.3). The destroyed history is shown in the report without a version number.

![Figure 21.3. An HTML report when the Roll Back function has been used](image)

21.4 Command Line Options

The Audit Trail Report is fully scriptable for batch processing. Scripts must call upon audittrailreport.exe; the parameters are the source .dpj file and the exported html file. For example, AuditTrailReport.exe C:\your_workspace_file.dpj C:\your_report_file.html
Acknowledgments

Portions of this product are based in part on the third-party software components. Definiens is required to include the following text, with software and distributions.

The Visualization Toolkit (VTK) Copyright

This is an open-source copyright as follows:

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither name of Ken Martin, Will Schroeder, or Bill Lorensen nor the names of any contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ITK Copyright

Copyright © 1999–2003 Insight Software Consortium
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of the Insight Software Consortium nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.